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Preface
This section provides information about this guide, details on the intended audience, 
revision history, and related documentation for this guide.

Revision history
Revision date Description

October 2024 Initial publication 

About this guide
This guide explains creating and designing communication templates using a low-
code method. It also explains how to use the Communication Designer and its 
supported features with meaningful business use cases. This guide provides step-by-
step procedures for creating different types of templates in the designer. Furthermore, 
this guide also contains the configuration details of each control you can add to each 
template. 

To ensure you are referring to the latest and most recent revision of this guide, download it from one of the 
following locations:

Intended audience
This guide is intended for system administrators, developers, and all other users who 
seek information on the functioning of the various features of OmniOMS 
Communication Designer and aid them in configuration, maintenance, and 
development. The reader must be comfortable in understanding the computer 
terminology.

Newgen Internal Doc Portal, if you are a Newgen employee.●

Newgen Partner Portal, if you are a Newgen partner.●

https://newgenindia.sharepoint.com/sites/NewgenProductDocumentation
https://partners.newgensoft.com/
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Related documents
Following documents provide additional information about OmniOMS Communication 
Designer:

Documentation feedback
To provide feedback or any improvement suggestions on technical documentation, 
you can write an email to docs.feedback@newgen.co.in.
To help capture your feedback effectively, it is requested to share the following 
information in your email:

NewgenONE OmniOMS Installation and Configuration Guide●

NewgenONE OmniOMS Admin Workspace User Guide●

NewgenONE OmniOMS Interactive Editor Integration User Guide●

NewgenONE OmniOMS Developer Guide●

Document name●

Version●

Chapter, topic, or section●

Feedback or suggestions●

mailto:docs.feedback@newgen.co.in
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Introduction
OmniOMS Communication Designer is a user-friendly tool that empowers 
organizations to design and publish professional communications quickly and 
effortlessly, without requiring any coding skills. With its intuitive drag-and-drop 
interface, users can create visually appealing and responsive emails and attachments 
(PDF and Word format), SMS, WhatsApp messages, and social communications with 
ease. 

Communication Designer's extensive toolbar provides a wide range of options to 
enhance communication designs. Users can easily incorporate images, text, bar and QR 
codes, shapes, digital signatures, watermarks, tables, buttons, videos, password 
configurations, annexures, and more. It supports the integration of customer data in 
JSON and XML formats, enabling seamless mapping to the templates. Additionally, 
version management ensures efficient management of templates throughout the 
design process.

Following are the main steps involved in creating and publishing a communication 
template in the OmniOMS Communication Designer.

Related topic(s)
Getting started●

OmniOMS Communication Designer elements ●

Tutorials●
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1.
2.

3.

Getting started
This chapter gives you an overview of getting started with OmniOMS Communication 
Designer. It includes the following topics:

Signing in to OmniOMS 
Communication Designer
To sign in to OmniOMS Communication Designer, follow the below steps:

Open a web browser.
In the browser address bar, enter the OmniOMS Communication Designer URL in 
the following format:
http://<ip_address>:<port_number>/omniomscommdesigner/#/login
Where, <ip_address> signifies the Internet Protocol (IP) address of the machine 
where the OmniOMS server is running, and <port_number> signifies the port 
number of the OmniOMS server. 
For example, http://127.0.0.1:6060/omniomscommdesigner/#/login
The OmniOMS sign-in page appears.

Enter the following details in the corresponding fields:

Signing in to OmniOMS Communication Designer●

Exploring OmniOMS Communication Designer interface●

OmniOMS Communication Designer elements●

In case Single Sign-On authentication is enabled, then use the following Communication 
Designer URL:
https://<ip_address>:<port_number>/newgensso/omniomscommdesigner 

●

In case multitenancy functionality is enabled, then use the following Communication Designer
URL:
https://<ip_address>:<port_number>/omniomscommdesigner/#/login?
cabinetname=<cabinetname>
For detailed access-related information, refer to the Accessing Admin Workspace section in 
the NewgenONE Admin Workspace User Guide.

●
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4.
5.

Field Description
Name Enter your username.

Password Enter the password associated with your username.

Cabinet

Select a suitable cabinet from the dropdown list. A cabinet within OmniOMS 
is a centralized unit of data storage that encompasses tables crucial for the 
functioning of the system within the database. Multiple cabinets can coexist 
within a single database server. Conceptually, a cabinet parallels a database 
within the database server, encapsulating essential tables and data structures 
specific to OmniOMS.

This field does not appear in case the multi-tenancy functionality is enabled.  

Remember 
me

Select to preserve your sign-in details. 

Click Login to proceed further.
(Optional) Enter the one-time password (OTP) received on your registered email 
or mobile, and then click Verify.  The Communication Designer home page 
appears.

Related topic(s)

You are prompted to enter the OTP only if Two Factor Authentication is enabled in the Admin 
Workspace. For more information, see NewgenONE OmniOMS Admin Workspace User Guide. In 
case you received no OTP, then click Resend OTP.

●

If the used volume exceeds double the total allocated volume, a popup message appears indicating 
that the license has expired.

●

Exploring OmniOMS Communication Designer interface●

OmniOMS Communication Designer elements●
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Exploring OmniOMS Communication 
Designer interface
On successful sign-in, the Communication Designer home page appears. On the home 
page, you can see Categories and Dataset panes on the left. While, the pane on the 
right gives you options to connect the communication group or template with a 
dataset, view the version history of a template, and add static images and texts to the 
template. 

The home page of the Communication Designer includes the following user interface 
(UI) elements:

UI element Description

Category and 
Dataset pane

Menu bar It consists of Home, Insert, and Align menus.

Toolbar
It contains tools for creating templates such as tables,  images, texts, 
buttons, hyperlinks, and others. 

The Category pane displays the different categories created in the 
selected cabinet. You can expand the category to view its 
corresponding communication groups, templates, and jobs.

●

The Dataset pane shows the different datasets created in the selected 
cabinet. You can expand the dataset to view its corresponding fields. 

●
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UI element Description

Design canvas It is the area where you can design templates for communication.

Reset template It allows you to clear the existing content from the template.

Preview template It allows you to preview the template. 

Save template It allows to save the changes made to a template.

Dataset gallery
It lists the different datasets created in the selected cabinet. Using the 
dataset gallery, you can link a communication group or template with the 
required dataset.

Version history
It lets you view the version history of the template that indicates the 
number of changes made to it. 

Object gallery
It is a collection of static objects that allows you to insert static images and 
text across the templates. You can simply drag and drop the object into the 
design canvas.

Master layout 
gallery

The master layout gallery is a collection of local and enterprise (or global) 
master layouts in the currently signed-in cabinet.

Component gallery
The component gallery is a collection of local and enterprise (or global) 
components in the currently signed-in cabinet.

Ask Marvin

It allows you to generate creative content using generative AI (Artificial 
Intelligence) based on your requirements. For more information, 
see Generating content with NewgenONE Marvin.

The NewgenONE Marvin logo and Ask Marvin icon only appear if it is registered and 
configured in the Others and Marvin tab of Admin Workspace. For more information, 
refer to NewgenONE OmniOMS Admin Workspace User Guide. 

Rights 
management

It allows you to assign rights to users or user groups and then view those 
rights. These access rights include permissions to view, create, edit, and 
enable the maker checker for categories, enterprise master templates, and 
enterprise components. For more information, see Managing user rights.

Maker checker

It allows you to accept or reject the approval requests received for 
baselining the templates and components (both local and global). 
Additionally, you can view your sent approval requests. For more 
information, see Managing approval requests.

User profile
It allows you to view your sign-in details such as name, cabinet, last login 
details, and failed attempts.
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On the interface, you can also see the Undo or Redo icons for reversing or repeating the 
actions in a template.

The Undo or Redo icons are not available for email templates. 

 

Related topic(s)

OmniOMS Communication 
Designer elements
These are the basic elements of the OmniOMS Communication Designer arranged in a 
hierarchical order:

Adding a category●

Adding a dataset●

Adding controls ●

Working with object gallery●

Working with master layout gallery●

Category — It acts as folder segregation to organize similar types of 
communications. For example, you can add different categories to manage 
mutual funds and loan communications.    
When you add a category, an Output Formats folder is created by default. 
Furthermore, there can be multiple communication groups within a category. 
For more information on categories, see Adding a category.

●

Communication Group — It acts as a package for communications. In 
OmniOMS Communication Designer, you can add two types of communication 
groups:  For more information on communication types, see Adding a  
communication group.
It is within a communication group where you can define templates and jobs. 

●

Common dataset communication groupo

Mixed dataset communication groupo

Template — It is the template that outlines the design of your communication. 
In OmniOMS Communication Designer, you can create email, message, and 
WhatsApp templates. 

●
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Related topic(s)

Job — It is a set of configuration settings that instructs the production server for 
generation purposes. OmniOMS Communication Designer allows you to create 
the following on-demand jobs: 

For more information, see Working with jobs.

●

On-demand message/WhatsApp jobo

On-demand mail/archival jobo

Output Formats — It denotes the output format for the email attachment. The 
supported output formats are PDF or DOC/DOCX.

●

Adding a category●

Adding a communication group●

Working with templates●

Working with jobs●

Defining an output format●
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1.
2.

3.

4.
5.

Adding a dataset
A dataset is a set of related data nodes (tables or tags) that contains dynamic 
information for creating personalized templates. Before mapping the data in the 
communication template, you must first connect the communication group or 
template with the dataset.

OmniOMS Communication Designer allows you to connect with an XML dataset (XSD) 
or JSON dataset, and support various dataset operations like check in, check out, undo 
check out, update, rename, delete, and others.  

Related topic(s)

Adding a JSON dataset
To add a JSON dataset, follow the below steps:

On the home page, navigate to the Dataset pane on the left.
Click + New Dataset, and then select JSON Dataset. 
The New JSON Dataset dialog appears.
Click the horizontal ellipsis icon  to browse a JSON file on your local system.
The Open dialog appears.
Navigate to the required folder on your system, and choose the required JSON file.
Click Open, and then click Add.
The JSON dataset gets added and appears under the Dataset list.

It is important to check in the dataset to link it with the required communication group or template. For 
procedural details, see Checking in a dataset.

Adding a JSON dataset●

Adding an XSD dataset●
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1.
2.

3.

4.
5.

1.
2.
3.

Adding an XSD dataset
To add an XSD dataset, follow the below steps:

On the home page, navigate to the Dataset pane on the left.
Click + New Dataset, and then select XSD Dataset. 
The New XSD Dataset dialog appears.
Click the horizontal ellipsis icon  to browse an XSD file on your local system.
The Open dialog appears.
Navigate to the required folder on your system, and choose the required XSD file.
Click Open, and then click Add.
The XSD dataset gets added and appears under the Dataset list.

It is important to check in the dataset to link it with the required communication group or template. For 
procedural details, see Checking in a dataset.  

Related topic(s)

Checking in a template

Creating a custom dataset
Communication Designer allows you to create a dataset schema that you can link with 
the template or communication group. JSON and XSD are the different schemas you 
can create in the Communication Designer. A schema defines the structure of the 
JSON or XSD dataset. It describes the different types of fields in the dataset with their 
data types.

To create a custom dataset, follow the below steps:

On the home page, navigate to the Dataset pane on the left.
Click + New Dataset, and then select Custom Dataset from the list.
Select the required dataset type from the list. The dataset can either be XSD or 
JSON. 
The Create New Dataset dialog appears. Here you can define the data fields and 
their data types, add sample data for the fields, and set the fields as arrays.  
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4.
5.

6.

7.

8.
9.

10.

By default, a root node is already added in the dataset with the variable name 
RootNode and type as Object. Here, the data type Object means that the variable 
can contain child variables. However, you can modify the variable name of the root 
node.

By default, the Type, Sample Data, and Array fields are disabled for the root node.  

Enter the name of the variable.
Set the data type of the variable. It can be an object, integer, long, double, float, 
string, Boolean, and date. 
Enter the sample data for the data field. 

You can enter the sample data based on the chosen data type. 

Select the Array checkbox to set the variable as an array. It means the variable can 
contain multiple values. For example, an Employee_Phone variable can be set to 
an array variable. This is because an employee can have more than one phone 
number. 
Click Add to add the variable. 
To add more variables, repeat steps from 4 to 8. You can perform the following 
operations on the added variables:

Click Create.
The custom dataset gets created and appears in the Dataset pane.

To delete the added variable, hover over the variable and then click Delete 
.

●

To change the sequence of the added variables, drag and drop the required 
variable to the desired location. 

●

It is necessary to check in the dataset to link it with the required communication group or 
template. For procedural details, see Checking in dataset.

●

 You can download a custom dataset file to preview a template with sample dataset values. For 
more information, see Downloading a custom dataset file.

●
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1.
2.

1.
2.

3.
4.

Checking out a dataset
Check out a dataset to make changes to it.

To check out a dataset, follow the below steps:

On the Dataset pane, select the required dataset from the list.
Click More Options  and then select Check Out from the list.
The dataset gets checked out.

In case you want to undo a checkout, then click More Options  and select Undo Check out option 
from the list.

Related topic(s)

Checking in a dataset
When you first add a dataset, you must check in to link it with the required 
communication group or template. Also, when you make changes to the dataset, you 
need to check in the process to save the changes.

To check in a dataset, follow the below steps:

On the Dataset pane, select the required dataset from the list.
Click More Options  and then select Check in from the list.
The Dataset Checkin dialog appears.

If you are checking in the document for the first time, the Check in Version is set to 1. 

Enter the comment in the space provided.
Click OK to confirm.

Related topic(s)

Setting dataset field type ●

Setting display name●

Securing fields●

Linking communication group with a dataset●

Linking template with a dataset●
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1.
2.
3.

1.
2.

3.

4.
5.

Renaming a dataset
To rename a dataset, follow the below steps:

On the Dataset pane, select the required dataset from the list.
Click More Options  and then select Rename.
Input the new name for the dataset, and then hit the Enter key. 
The dataset gets renamed.

Updating a dataset
To update a dataset, follow the below steps:

On the Dataset pane, select the required dataset from the list.
Click More Options  and then select Update.
The Update dialog appears.
Click the horizontal ellipsis icon  to browse the required JSON or XSD file on your 
local system.
The Open dialog appears.
Navigate to the required folder on your system, and select the required file.
Click Open, and then click Add.
The dataset gets updated.

Setting dataset field type
OmniOMS Communication Designer allows you to change the data type for the fields 
that reflect in the interactive editor used for the production server. 

These are the different types of dataset fields supported in the Communication 
Designer:

Read-only — It grants view rights on the dataset field. ●

Date-picker — It adds a date-picker for the dataset field from where you can 
select a date from the calendar.
This is applicable only to the date-type dataset fields.

●
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1.
2.

3.

To set the dataset field type, follow the below steps:

From the Dataset pane, select the required dataset.
Click More Options  and then select Dataset Field Properties from the list.
The Set Field Type dialog appears. It contains an Available Fields section that 
shows the selected dataset. You can expand the dataset to view its corresponding 
fields.

Hover over the dataset field and click any of the following options:

Drop-down — It adds a dropdown list for the dataset field from where you can 
select the required option. In this case, you also need to define the options.

●

Add to Read Only Fields   — Click to add the dataset field to read-only 
fields.
The dataset field now appears under the Read Only Fields section. 

●

Add to Date Picker Fields   — Click to add the dataset field to the date 
picker fields.
The dataset field now appears under the Date Picker Fields section. 

Only the date type field can be added to the Date Picker Field. 

●

i.

Add to Dropdown Fields   — Click to add the dataset field to dropdown 
fields.
The dataset field now appears under the Dropdown Fields section. You can 
now define the options to show in the dropdown list.
To add options to the dropdown list, follow the below steps:

Under the Dropdowns Fields section, click the Menu items icon 
 next to the required dataset field. A Menu Items pop-up appears.

●
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4.

1.
2.

3.

4.
5.

1.
2.

3.

Click Save to confirm.

Setting display name
OmniOMS Communication Designer allows you to set the display names for the 
dataset fields in the Interactive Editor. 

To set the display name for the dataset field, follow the below steps:

On the Dataset pane, select the required dataset from the list.
Click More Options  and then select Set Display Name. 
The Set Display Name dialog appears. It contains a Select Table section that shows 
the selected dataset. You can expand the dataset to view its corresponding tables.
Select the required table in the dataset.
Based on the selected table, its associated dataset fields are shown on the right of 
the dialog.
Enter the display name for the required field in the space provided.
Click Save to confirm.

Viewing linked assets
When you connect a communication group or template to a dataset, it gets linked with 
the dataset. 

To view the linked assets, follow the below steps:

On the Dataset pane, select the required dataset from the list.
Click More Options  and then select View linked assets.
The View Linked Assets dialog appears. It displays the dataset name.
Select the type of linked asset. It can either be a communication group or a 
template.

ii.

iii.

Enter the name of the item, and then click Add. 
The added item now appears under the list.
(Optional) To add more items to the dropdown list, repeat the above 
steps. 
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4.

1.
2.

If the dataset is not associated with any communication group or template, the list of linked assets 
appears blank.  

Click Close.

Downloading a custom dataset file
Communication Designer allows you to download a custom dataset file to view its 
structure. Additionally, you can download a custom dataset file to preview the template 
with sample dataset values. This is useful in scenarios when you do not have the 
required dataset file on your system to preview the template. The sample values are 
defined while creating a custom dataset. 
For more information, see Creating a custom dataset.

To download a custom dataset file, follow the below steps:

On the Dataset pane, select the required custom dataset from the list.
Click More Options  and then select Download from the list.
The custom dataset gets downloaded to your local system.   

The Download option appears only for the checked-in custom datasets.

When you preview a template linked with a custom dataset, you can click the Preview 
with Sample Values button to view the template with sample dataset values. 

Securing fields
OmniOMS Communication Designer allows organizations to secure their confidential 
information from unauthorized access, threats, and vulnerabilities. This can be achieved 
using the masking feature in Communication Designer that helps to create and 
maintain a secure workplace environment. 

If you select the communication group option, a list of linked 
communication groups appears. The list displays the dataset version, 
communication group, and category.

●

If you select the template option, a list of linked templates appears. The list 
displays the dataset version, template name, communication group, and 
category.

●
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1.
2.

3.

4.

The masking feature is available only in the PCI-DSS cabinets.   

For example, it is necessary for companies that process, store, or transmit credit card 
information to ensure data security and compliance.

To secure dataset fields, follow the below steps:

On the Dataset pane, select the required dataset from the list.
Click More Options  and then select Secure Fields from the list.
The Secure Fields dialog appears. 
Under the Data Fields section, expand the linked dataset and select the required 
dataset field you want to mask. 
The selected field automatically appears in the Field Name under the Masking 
Pattern section.
Enter the following information in the Masking Pattern section:

Property Description

Character
Denotes a single character value that can be an alphanumeric or a 
special character. This character masks the required actual characters 
of the data field value. 

Placeholder
Denotes a single character value that can be an alphanumeric or a 
special character. This character acts as a placeholder and its value 
does not get changed while masking.  

Masking Pattern
Specify the masking pattern. It is a combination of entered characters 
and placeholders.

Variable Length 
Data

Select this option to enable the variable length data. This is useful in 
situations where the length of data field input exceeds the masking 
pattern length.

Apply Pattern

Select any of the following option:

Replace Others
Determines whether to keep the remaining data the same as that of 
the input value or replace it with the masking characters. 

Sample Input Specify the sample data input value you want to mask.

Start from left — Select this option to apply the masking 
pattern from left to right.

●

End to Right — Select this option to apply the masking pattern 
from right to left.

●
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5.

1.
2.

3.

Property Description

Preview Click to view the data input value in the Sample Output.

Apply Pattern Click to apply masking on the entered sample input value.

Sample Output The resultant value appears here.

Click Save.

Deleting a dataset
To delete a dataset, you need to ensure that the dataset is in the checked-out state and 
all the linked assets are deleted.

You cannot roll back the delete action.   

To delete a dataset, follow the below steps:

On the Dataset pane, select the required dataset from the list.
Click More Options  and then select Delete.
The Delete Dataset dialog appears.
Click Delete to confirm. 
The dataset no longer appears in the Dataset pane.
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1.
2.

1.
2.
3.

Adding a category
The purpose of creating a category is to group similar types of communications for easy 
access. 

To add a category, follow the below steps:

On the Home page, go to the Category pane.
Click + New Category.
The category gets added and appears in the Categories list. 
By default, the created category contains an Output Formats folder.  

Related topic(s)

Renaming a category
To rename a category, follow the below steps:

On the Category pane, select the required category from the list.
Click More Options  and then select Rename.
Input the new name for the category, and then hit the Enter key. 
The category gets renamed.

Deleting a category
To delete a category, you need to ensure it does not contain any communication 
groups, templates, or jobs.

You cannot roll back the delete action.  

Renaming a category●

Deleting a category ●
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1.
2.

3.

To delete a category, follow the basic steps:

On the Category pane, select the required category from the list.
Click More Options  and then select Delete.
The Delete Dataset dialog appears.
Click Delete to confirm. 
The category no longer appears in the Category tab.
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1.
2.
3.

Adding a communication 
group
There are two types of communication groups you can create in the Communication 
Designer:

A category can contain both types of communication groups. 

To create a communication group, follow the below steps: 

On the Category pane, select the required category from the list.
Click the New Communication Group icon.
Select any of the following options:

The communication group gets added. A common dataset communication group 
is represented by  icon while a mixed dataset communication group is 
represented by  icon.  You can further link the common dataset communication 
group with a dataset. However, in the case of a mixed dataset communication 
group, you need to add templates first and then bind them with the required 
datasets.

Common Dataset Communication Group — In this type, the communication 
group uses a common dataset for designing and previewing templates. It 
means, all the templates within the specified communication group use the 
same dataset. Here, you need to link the communication group with a dataset. 
For more information, see Linking communication group with a dataset.

●

Mixed Dataset Communication Group — In this type, each template within the 
communication group uses its own dataset. It means you need to link each 
template with the required dataset in this type of communication group. For 
more information, see Linking template with a dataset.

●

Select the Common Dataset CG option to create a common dataset 
communication group.

●

Select the Mixed Dataset CG option to create a mixed dataset 
communication group.

●
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1.
2.

3.
4.

1.

2.

 

Related topic(s)

Linking communication group with 
a dataset
To add data to your template, you need to link the communication group with a 
dataset.  

This is applicable only in the case of a common dataset communication group. This is 
because all the templates within this communication group share a common dataset.

To link the communication group with a dataset, follow the below steps:

From the Categories pane, select the required communication group.
On the right, select the Datasets Gallery. It lists all the datasets added in the 
selected cabinet. 
Select the required dataset from the list.
Click Link with Communication Group.
The communication group gets now linked with the dataset.

Related topic(s)
Adding a template 

Renaming a communication group
To rename a communication group, follow the below steps:

On the Category pane, expand the required category from the list and select the 
communication group.
Click More Options  and then select Rename.

Linking communication group with a dataset ●

Linking template with a dataset●

Deleting a communication group●
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3.

1.

2.

3.

Input the new name for the communication group, and then hit the Enter key. 
The communication group gets renamed.

Deleting a communication group
To delete a communication group, you need to ensure it does not contain templates or 
jobs.

You cannot roll back the delete action.  

To delete a category, follow the basic steps:

On the Category pane, expand the required category from the list and then select 
the communication group.
Click More Options   and then select Delete.
The Delete Dataset dialog appears.
Click Delete to confirm. 
The communication group no longer appears under the respective category.
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Working with templates
In OmniOMS Communication Designer, you have access to a variety of templates for 
designing email, message, and WhatsApp communications. Furthermore, you can 
create custom templates for PDF or Word documents and include them as 
attachments in your email communications. The intuitive design process involves easily 
dragging and dropping controls from the Controls toolbar to create your desired 
communication layout.  

OmniOMS Communication Designer provides support for creating and associating 
rules with specific controls. It also allows you to copy the template to a different 
communication group, view the version history of the template, view and set its 
configuration settings, and others.

Related topic(s)

Adding a template
This chapter describes the basics of adding templates in the OmniOMS 
Communication Designer. It consists of the following topics:

Adding a template●

Linking template with a dataset●

Creating an email template●

Creating a message template●

Creating a WhatsApp template●

Creating a letter template●

Creating a design on pdf template●

Creating a Word template●

Creating a fillable PDF template●

Creating an X template●

Creating a Facebook template●
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Adding an email template

Use the email template to design an email communication. You can send email 
communications to share quick messages with customers, employees, and coworkers. 
These messages can contain text, images, videos, buttons, and thumbnail icons.  

For example, Insurance companies can send reminders about policy renewal to their 
customers.

To add an email template, select Templates under the required communication group 
from the Categories pane. Click the New Template icon  and then select Email 
Template from the list.

The menu bar of the email template contains the following menu options:

Home menu●

Insert menu●
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Home menu

The File menu consists of a formatting toolbar that provides various formatting options 
to modify the font size and color, alignment, and formatting style. 

The below table describes the different formatting options available in the formatting 
toolbar.

Icon Icon Name Description

 Font style Change the font style of the selected text.

Font Size Change the font size of the selected text.

Bold Bold the selected text.

Italics Make the selected text italics.

Underline Underline the selected text.

Strikethrough Strikethrough the selected text.

Fore Color Change the font color of the selected text.

Back Color Change the background color of the selected text.

Align Align the selected text to left, right, justify, or center.

Body Properties

Change the body properties:

Body Back Color — Change the background color of the 
template using the color palette and color names with 
RGB or hexadecimal values.

●

Content Area Back Color — Change the background color 
for the content area in the template using the color palette 
and color names with RGB or hexadecimal values.

●

Link Color — Change the color of the hyperlink using the 
color palette and color names with RGB or hexadecimal 
values.

●

Content Area Width — Change the width of the design 
canvas. The dimensions must be in the range of 400 to 700 
pixels.

●

Font — Change the default font style for the text in the 
template.

●
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Icon Icon Name Description

Rule Library
Select this option to create and add rules. For more information, 
see Defining and managing rules

Insert menu

The Insert menu provides the Controls toolbar that allows you to insert text, images, 
links, buttons, components, and others into the template.

The below table describes the different controls available in the toolbar.

Icon Icon Name Description

Add Section It acts as a placeholder for the other controls. 

Rich Text It allows to insert text in the template.

Image It allows to insert images in the template.

Table It allows to insert tables in the template.

Button It allows to insert buttons in the template.

Video It allows to insert videos in the template.

Divider It is a horizontal line for separating controls within the template.

Spacer It inserts spaces between the controls.

Icons
It enables you to add thumbnail icons in the template. 
Furthermore, you can control the style of the text displayed 
along the thumbnail icon.

Make Component
It allows you to reuse a piece of content from your template 
across multiple templates. 

Related topic(s)
Linking template with a dataset●

Adding controls●

Creating an email template●

Managing templates and jobs●

Creating an on-demand mail/archival job●
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Adding a message template

Use the message template to design a message (SMS) communication. You can send 
text messages to share short and precise information. Furthermore, a text message 
contains only plain text.

For example, banks can send text messages to customers for sharing credit card offers. 

To add a message template, select Templates under the required communication 
group from the Categories pane. Click the New Template icon   and then select 
Message Template from the list.

Related topic(s)
Linking template with a dataset●

Managing templates and jobs ●

Creating an on-demand social job●
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Adding a WhatsApp template

Use the WhatsApp template to design a Whatsapp communication. You can send 
WhatsApp messages to share business notifications or updates. Furthermore, a 
WhatsApp message can contain text, an image, or an attachment.

For example, a company can send WhatsApp messages to share promotional 
discounts to eligible customers.

 

 

To add a WhatsApp template, select Templates under the required communication 
group from the Categories pane. Click the New Template icon  and then select 
WhatsApp Template from the list.

The WhatsApp template gets added. In this template, you can do the following:

Adding an image or attachment●

Adding a text message●
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1.

2.

Adding an image or attachment

To add an image to the WhatsApp template, follow the below steps:

On the design canvas, click Add Image. 
The Add Image/File dialog appears.
Enter the following details into the corresponding fields:

Field Type: Select any of the following options:●

Image —  Select this option to add an image using a URL.o

Image URL — Enter the URL of the image. The supported image 
formats are .jpeg and .jpg.

In case, a macro field contains a segment of the image URLs, then 
click Add Macro. In the Dataset Field dialog that appears, select 
the required table name and column from the respective 
dropdown lists. Then, click Add to save. In this way, you can 
generate images specific to users. By default, the Add Macro 
button is disabled.

 

–

The image URL must be accessible to the application server.  ●

The image URL must end with a "." followed by its file extension.    ●

To enable the Add Macro button, you need to configure the dataset fields in 
the template properties.  

●

You cannot add captions to images. So, in this case, the Caption field is 
disabled by default.

●

File — Select this option to add a document or attachment using a 
URL. It also provides a download icon that allows users to save the 
attached document in the WhatsApp message on their devices.

o

File URL — Enter the URL of the document or attachment. 

In case, a macro field contains a segment of the file URLs, then 
click Add Macro. In the Dataset Field dialog that appears, select 
the required table name and column from the respective 
dropdown lists. Then, click Add to save. In this way, you can 
generate images specific to users. By default, the Add Macro 
button is disabled.  

–
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3. Click Add to save the changes.

Adding a text message

To add a message to your WhatsApp template, simply type the message in the space 
provided. You can further select the required text and apply the following text 
formatting:

Related topic(s)

To enable the Add Macro button, you need to configure the dataset fields in the 
template properties. 

Caption — Enter the caption of the document or attachment.

In case, a macro field contains the image captions, then click Add 
Macro. In the Dataset Field dialog that appears, select the 
required table name and column from the respective dropdown 
lists. Then, click Add to save. In this way, you can generate image 
captions specific to users. By default, the Add Macro button is 
disabled.
To enable the Add Macro button, you need to configure the 
dataset fields in the template properties.

–

Enable proxy — Use to enable or disable the proxy server. On enabling this 
option, the following fields appear:

●

Server IP — Enter the proxy server IP address.o

Server Port — Enter the port of the proxy server IP address.o

Click   to bold the selected text.●

Click   to make the selected text italics.●

Click  to underline the selected text.●

Linking template with a dataset●

Managing templates and jobs ●

Creating an on-demand social job●
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Adding a letter template

Use the letter template to design a PDF attachment for email communication. The 
letter template can be added as an attachment for email communications or simply for 
generation or archival use cases. In a letter template, there can be multiple PDF pages 
where you can insert text, images, tables, barcodes, digital signatures, and much more. 
The letter template also provides you the option to secure email attachments using a 
password. Apart from this, you also use arithmetic expressions in the template for 
complex calculations. 

The letter template is useful for designing welcome letters, or generic letters addressed 
to a company or individual comprising editable clauses and data fields. The output for 
the letter template is rendered in PDF format and allows you to perform controlled 
editing operations before sending it to the concerned stakeholder. The paragraphs, 
images, and tables are auto-relative in the letter template.

For example, Insurance companies can send policy letters to the new on-boarded 
customers with the policy details. 

To add a letter template, select Templates under the required communication group 
from the Categories pane. Click the New Template icon  and then select Letter 
Template from the list.
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You can also add a PDF page in the template by clicking the Add Page icon  next to 
the template name in the Categories pane.

The menu bar of the letter template contains the following menu options:

Home menu

The File menu consists of a formatting toolbar that provides various formatting options 
to modify the font size, color, alignment, and style. 

The below table describes the different formatting options available in the formatting 
toolbar.

Icon Icon Name Description

 Font style Change the font style of the selected text.

Font Size Change the font size of the selected text.

Bold Bold the selected text.

Italics Make the selected text italics.

Underline Underline the selected text.

Strikethrough Strikethrough the selected text.

Fore Color
Change the font color of the selected text using the color palette 
and color names with RGB or hexadecimal values.

Back Color
Change the background color of the selected text using the color 
palette and color names with RGB or hexadecimal values.

Fill Color
Fill tables, rectangles, and circles with colors using the color 
palette and color names with RGB or hexadecimal values.

Align Align the selected text to left, right, justify, or center.

Align vertically
Align the selected text at the top, middle, or bottom of the table 
cell.

Home menu●

Insert menu●

Align menu●
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Icon Icon Name Description

Superscript/
Subscript

Align the selected text above or below the normal line.

Design 
background 
grid

Click to display gridlines on the design canvas.

Fit to canvas 
width

Reset the control dimensions to fit the design canvas width.

This option is only applicable to tables, rectangles, text, and images. 

Auto Relativity

Use this option to maintain spacing between the controls in the 
template.  

Header and 
footer

Allow you to insert header and footer sections into the template. 
You can add text and images to the header and footer sections. 
You can also increase or reduce the size of these sections as per 
your requirements.

The header and footer sections are applicable to all the pages in the 
letter template.  

Increase/
Decrease page

Increases or decreases the size of the page. 

More options

Select any of the following options:

The auto relativity feature does not impact the controls if you 
resize a table control. 

●

The auto relativity does not have any impact on the line control. ●

On increasing the page size, the design page gets increased 
by one page.

You can only increase the page size by a maximum of four pages.  

●

On decreasing the page size, the design page gets reduced 
by one page.

●

Rule Library — Select this option to create and add rules. 
For more information, see Defining and managing rules.

●

Number Sequence Library — Select this option to create 
and add sequence lists. For more information, see Creating a 
multilevel numbering.

●
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Insert menu

The Insert menu provides a Controls toolbar that allows you to insert text, images, links, 
buttons, and others into the template.

The below table describes the different controls available in the toolbar.

Icon Icon Name Description

Rich Text It allows to insert text in the template.

Table It allows to insert tables in the template.

Image It allows to insert images in the template.

Shape
It allows to insert shapes in the template such as 
rectangles, lines, and circles.

Arithmetic 
Expression

It enables you to add arithmetic expressions in the 
template.

Barcode It allows to add 1-D and 2-D barcodes to the template. 

Password
It allows to protect the document using passwords. You 
can also control the user rights on the template.

Watermark 
configuration

It allows to add watermark in the template.

Digital signature It allows to insert digital signatures in the template.

Annexure 
configuration

It allows to add annexures to the template. You can also 
define rules for the annexures. 

Add paragraph
It adds paragraph to the template. This paragraph can be 
made editable, removable, and skip-numbering by 
configuring its properties.

Add page break It inserts page breaks to the template.

Component
It allows you to mark a section from your template to 
create a reusable component. You can use this component 
across multiple templates.
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Align Menu

The Align menu provides various options to align controls, set paragraph spacing, and 
reset the control size within a template.   

These alignment options are only applicable to rich text, images, rectangles, lines, and paragraphs. 

Option Description

Align Vertical Start Aligns the controls vertically to the top edge of the last selected control.

Align Vertical 
Center

Aligns the controls vertically to the center of the last selected control.

Align Vertical End Aligns the controls vertically to the bottom edge of the last selected control.

Align Horizontal 
Start

Aligns the controls horizontally to the left edge of the last selected control.

Align Horizontal 
Center

Aligns the controls horizontally to the center of the last selected control.

Align Horizontal 
End

Aligns the controls horizontally to the right edge of the last selected control.

Equal Height Resets the height of the controls as that of the last selected control. 

Equal Width Resets the width of the controls as that of the last selected control.

Same Size Resets the size of the controls as that of the last selected control.

Para spacing
Sets the spacing between the Paragraph controls (in pixels). The spacing 
value ranges from 4 to 50 pixels.

Merge

Merges the text within the selected Rich Text controls. 

Ensure the selected Rich Text controls are either aligned vertically or horizontally on 
the same line. 

By default, the text is appended in the same line. 
However, in case, the left edges of the rich text controls are in the same line, 
then you get an option to merge the text as a paragraph. This means the 
text of merged controls starts from a new paragraph.

Related topic(s)
Linking template with a dataset●

Adding controls●
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Adding a design on PDF template

OmniOMS Communication Designer allows you to use an existing PDF as a template. 
You can import a PDF file and add text, images, and other PDF controls on top of the 
underlying PDF. Furthermore, you can apply a password to the PDF for encryption 
purposes. This is useful for designing forms to render as PDF.

For example, a bank loan application gets automated by mapping the applicant details 
on top of a loan application PDF form.

To add a Design on PDF template, select Templates under the required 
communication group from the Categories pane. Click the New Template icon  and 
then select Design on PDF from the list.

An Open dialog appears. Select the required PDF from your local system and then click 
Open. It takes a few seconds to load the PDF in the communication designer based on 
the file size. Once the PDF gets successfully loaded, it appears under the Categories 
pane. You can see the PDF is divided based on its pages.

For example, if the uploaded PDF contains 2 pages, then two-page items appear – 
Page 1 and Page 2 representing the different pages in the PDF. You can also update the 
version of PDF file by clicking the More Options   next to the template and then 
selecting the Update PDF option from the list. 

The new version of the PDF file must have the same number of pages and dimensions as the old version. 

The menu bar of the Design on PDF template contains the following menu options:

Managing templates and jobs●

Defining and managing rules ●

Creating a multilevel numbering●

Creating an on-demand mail/archival job●

Home menu●

Insert menu●

Align menu●
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Home menu

The File menu consists of a formatting toolbar that provides various formatting options 
to modify the font size and color, alignment, and formatting style. 

The below table describes the different formatting options available in the formatting 
toolbar.

Icon Icon Name Description

 Font style Change the font style of the selected text.

Font size Change the font size of the selected text.

Bold Bold the selected text.

Italics Make the selected text italics.

Underline Underline the selected text.

Strikethrough Strikethrough the selected text.

Fore color Change the font color of the selected text.

Back color Change the background color of the selected text.

Align Align the selected text to left, right, justify, or center.

Superscript/Subscript Align the selected text above or below the normal line.

Rule library Define rules to apply on the template controls.

Insert menu

The Insert menu provides a Controls toolbar that allows you to insert text, and images, 
and also provides an option to apply password protection on the PDF.

Icon Icon Name Description

Rich Text It allows to insert text in the template.

Image It allows to insert images in the template.

Password
It allows to protect the document using passwords. You can also 
control the user rights on the template.
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Align menu

The Align menu provides various options to align controls, set paragraph spacing, and 
reset the control size within a template.   

Option Description

Align Vertical Start Aligns the controls vertically to the top edge of the last selected control.

Align Vertical Center Aligns the controls vertically to the center of the last selected control.

Align Vertical End
Aligns the controls vertically to the bottom edge of the last selected 
control.

Align Horizontal 
Start

Aligns the controls horizontally to the left edge of the last selected control.

Align Horizontal 
Center

Aligns the controls horizontally to the center of the last selected control.

Align Horizontal End
Aligns the controls horizontally to the right edge of the last selected 
control.

Equal Height Resets the height of the controls as that of the last selected control. 

Equal Width Resets the width of the controls as that of the last selected control.

Same Size Resets the size of the controls as that of the last selected control.

Merge

Merges the text within the selected Rich Text controls. 

Ensure the selected Rich Text controls are either aligned vertically or horizontally 
on the same line. 

By default, the text is appended in the same line. However, in case, the left 
edges of the rich text controls are in the same line, then you get an option 
to merge the text as a paragraph. This means the text of merged controls 
starts from a new paragraph.

Related topic(s)
Linking template with a dataset●

Adding controls●

Working with jobs●
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Adding a Word template

OmniOMS Communication Designer allows you to use an existing Word document as a 
template. The uploaded Word document can contain text, dynamic elements, designs, 
shapes, and other additional content. This template is useful for designing letters, 
contracts, and agreements that already exist in Word format. Also, once a Word 
document gets uploaded successfully, it becomes a native template. You can add this 
template as an email attachment in PDF or DOC/DOCX format. For more information, 
see Defining an output format.

For example, policy schedules of an insurance policy can be personalized with 
customer data by simply placing the macros in the Word file.

To preview the Word template, you need to start the Office server. The related configuration details for the 
Office server must be added in the OMSAdminConfig.ini configuration file. For more information, see 
NewgenONE OmniOMS Administration Guide. 

To add a Word template, select Templates under the required communication group 
from the Categories pane. Click the New Template icon  and then select Word 
Template from the list.

An Open dialog appears. Select the required Word document from your local system 
and then click Open. It takes a few seconds to load the Word document in the 
communication designer based on the file size. Once the Word document gets 
successfully loaded, it appears under the Categories pane. 

The supported formats for Word documents are DOC and DOCX. 

After uploading, you get three buttons that allow you to upload, preview, and download 
the Word document.

Click the Upload button to replace the existing Word document.●

Click the Preview button to view the uploaded content of the Word document. 
An open dialog appears where you can select the required XML or JSON dataset 
to view the data. 

●

Click the Download button to save the uploaded document on your local 
system.

●
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Related topic(s)

Adding a fillable PDF template

The fillable PDF template allows you to create interactive PDF forms that can be sent to 
end users for various business use cases, such as application forms, changes in 
nominations, and updates to policy details. This feature enables bi-directional 
communication, allowing businesses to collect data seamlessly from their customers.

To add an email template, select Templates under the required communication group 
from the Categories pane. Click the New Template icon  and then select Fillable 
Template from the list.

The menu bar of the fillable template contains the following options:

Linking template with a dataset●

Managing templates and jobs●

Defining an output format ●

Creating an on-demand mail/archival job●

Home●

Insert menu●

Align●
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Home

The File menu consists of a formatting toolbar that provides various formatting options 
to modify the font size, color, alignment, and style. 

The below table describes the different formatting options available in the formatting 
toolbar.

Icon Icon Name Description

Font style Change the font style of the selected text.

Font Size Change the font size of the selected text.

Bold Bold the selected text.

Italics Make the selected text italics.

Underline Underline the selected text.

Strikethrough Strikethrough the selected text.

Fore Color
Change the font color of the selected text using the color palette 
and color names with RGB or hexadecimal values.

Back Color
Change the background color of the selected text using the color 
palette and color names with RGB or hexadecimal values.

Fill Color
Fill tables, rectangles, and circles with colors using the color 
palette and color names with RGB or hexadecimal values.

Align Align the selected text to left, right, justify, or center.

Align vertically
Align the selected text at the top, middle, or bottom of the table 
cell.

Superscript/
Subscript

Align the selected text above or below the normal line.

Design 
background 
grid

Click to display gridlines on the design canvas.

Fit to canvas 
width

Reset the control dimensions to fit the design canvas width.

This option applies only to tables, rectangles, text, and images. 
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Icon Icon Name Description

Auto Relativity

Use this option to maintain spacing between the controls in the 
template.  

Header and 
footer

Allows you to insert header and footer sections into the template. 
You can add text and images to the header and footer sections. 
You can also increase or reduce the size of these sections based 
on your requirements.

The header and footer sections apply to all the pages in the template.  

Increase/
Decrease page

Increases or decreases the size of the page. 

Rule Library
Select this option to create and add rules. For more information, 
see Defining and managing rules

The auto relativity feature does not impact the controls if you 
resize a table control. 

●

The auto relativity does not have any impact on the line control. ●

On increasing the page size, the design page gets increased 
by one page.

You can only increase the page size by a maximum of four pages.  

●

On decreasing the page size, the design page gets reduced 
by one page.

●
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Insert menu

The Insert menu provides a Controls toolbar that allows you to insert text, images, links, 
buttons, and others into the template.

The below table describes the different controls available in the toolbar.

Icon Icon Name Description

Rich Text It allows to insert text in the template.

Table It allows to insert tables in the template.

Image It allows to insert images in the template.

Shape
It allows to insert shapes in the template such as 
rectangles, lines, and circles.

Arithmetic 
Expression

It enables you to add arithmetic expressions in the 
template.

Barcode It allows to add 1-D and 2-D barcodes to the template. 

Password
It allows to protect the document using passwords. You 
can also control the user rights on the template.

Watermark 
configuration

It allows to add watermark in the template.

Annexure 
configuration

It allows to add annexures to the template. You can also 
define rules for the annexures. 

Fillable form 
fields 

It allows to insert form fields such as Textbox, Checkbox, 
Date Picker, List Box, and Radio Button into the template.

Align menu

The Align menu provides various options to align controls, set paragraph spacing, and 
reset the control size within a template.   

These alignment options apply only to rich text, images, rectangles, lines, and paragraphs. 

Option Description

Align Vertical Start Aligns the controls vertically to the top edge of the last selected control.
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Option Description

Align Vertical 
Center

Aligns the controls vertically to the center of the last selected control.

Align Vertical End Aligns the controls vertically to the bottom edge of the last selected control.

Align Horizontal 
Start

Aligns the controls horizontally to the left edge of the last selected control.

Align Horizontal 
Center

Aligns the controls horizontally to the center of the last selected control.

Align Horizontal 
End

Aligns the controls horizontally to the right edge of the last selected control.

Equal Height Resets the height of the controls as that of the last selected control. 

Equal Width Resets the width of the controls as that of the last selected control.

Same Size Resets the size of the controls as that of the last selected control.

Merge

Merges the text within the selected Rich Text controls. 

Ensure the selected Rich Text controls are either aligned vertically or horizontally on 
the same line. 

By default, the text is appended in the same line. 
However, in case, the left edges of the rich text controls are in the same line, 
then you get an option to merge the text as a paragraph. This means the 
text of merged controls starts from a new paragraph.

Related topic(s)

 

Linking template with a dataset●

Adding controls●

Managing templates and jobs●

Defining and managing rules ●

Creating an on-demand mail/archival job●
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Adding an X template

Use the X template to design X communications. You can send X messages to share 
business updates, notifications, or engaging content with your audience. An X message 
can include both text and images to enhance your communication strategy.

For example, a company can use X messages to share real-time updates, event 
promotions, or visual content with followers.

 

To add an X template, select Templates under the required communication group 
from the Categories pane. Click the New Template icon and then select X 
Template from the list.

The X template gets added. In this template, you can do the following:

Adding a text message

When you add an X template, a blank space appears prompting you to write your 
message with the placeholder "What's on your mind?" Simply type your message in the 
space provided.

Adding a text message●

Adding an image●
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1.
2.

3.

Adding an image

To add an image to the X template, follow the below steps:

On the design canvas, click +Add Image. The Add Image dialog appears.
Enter the following details into the corresponding fields:

Click Add to save the changes.

Related topic(s)

Image URL — Enter the image URL. The supported image formats are .jpeg 
and .jpg.

●

The image URL must be accessible to the application server.  ●

The image URL must end with a "." followed by its file extension. For example https://
example.com/image.jpg.

●

 

In case, a macro field contains a segment of the image URLs, then click 
Add Macro. In the Dataset Field dialog that appears, select the 
required table name and column from the respective dropdown lists. 
Then, click Add to save. In this way, you can generate images specific 
to users. By default, the Add Macro button is disabled.

o

To enable the Add Macro button, configure the dataset fields in the template 
properties.  

●

You cannot add captions to images, so the Caption field is disabled by default.●

Enable proxy — Use to enable or disable the proxy server. On enabling this 
option, the following fields appear:

●

Server IP — Enter the proxy server IP address.o

Server Port — Enter the port of the proxy server IP address.o

Linking template with a dataset●

Managing templates and jobs●

Creating an on-demand mail/archival job●
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Adding a Facebook template

Use the Facebook template to design Facebook communications. You can send 
Facebook messages to engage with your audience, share updates, and promote your 
brand. A Facebook message can consist of text and images to create compelling posts.

For example, a business can utilize Facebook messages to announce new products, 
share customer testimonials, or post visually appealing content.

 

To add a Facebook template, select Templates under the required communication 
group from the Categories pane. Click the New Template icon and then select 
Facebook Template from the list.

The Facebook template gets added. In this template, you can do the following:

Adding a text message●

Adding an image●
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1.
2.

3.

Adding a Text Message

When you add a Facebook template, a blank space appears prompting you to write 
your message with the placeholder "What's on your mind?" Simply type your message 
in the space provided.

Adding an Image

To add an image to the Facebook template, follow the below steps:

On the design canvas, click +Add Image. The Add Image dialog appears.
Enter the following details into the corresponding fields:

Click Add to save the changes.

Related topic(s)

Image URL — Enter the URL of the image. The supported image formats 
are .jpeg and .jpg.

●

In case, a macro field contains a segment of the image URLs, then click 
Add Macro. In the Dataset Field dialog that appears, select the 
required table name and column from the respective dropdown lists. 
Then, click Add to save. In this way, you can generate images specific 
to users. By default, the Add Macro button is disabled.

o The image URL must be accessible to the application server.  ●

The image URL must end with a "." followed by its file extension.    ●

To enable the Add Macro button, you need to configure the dataset fields in the 
template properties.  

●

You cannot add captions to images. So, in this case, the Caption field is disabled by 
default.

●

Enable proxy — Use to enable or disable the proxy server. On enabling this 
option, the following fields appear:

●

Server IP — Enter the proxy server IP address.o

Server Port — Enter the port of the proxy server IP address.o

Linking template with a dataset●

Managing templates and jobs●

Creating an on-demand mail/archival job●
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1.
2.

3.
4.

Linking template with a dataset
To add data to your communication template, you need to link it with a dataset.  

This is applicable only in the case of a mixed dataset communication group. This is 
because all the templates within this communication group are linked to different 
datasets.

To link the template with a dataset, follow the below steps:

From the Categories pane, select the required communication group.
On the right, select the Datasets Gallery. It lists all the datasets added in the 
selected cabinet. 
Select the required dataset from the list.
Click Link with Template.
The template gets now linked with the dataset.
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Adding controls
OmniOMS Communication Designer provides you with a wide range of controls for 
creating templates. The controls can be rich text, image, button, video, table, spacer, 
divider, barcode, shape, and many more.

Email template
The email template supports the following controls. You can simply drag and drop the 
control from the Controls toolbar to the section.

When you add controls to the template, you can configure its properties and perform 
various operations on it. The properties of each control vary.

Section●

Rich text●

Image●

Table●

Button●

Video●

Divider●

Spacer●

Icon●

List●

Component●
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Section

Sections work as basic building blocks for designing an email template. Each section 
acts as a placeholder to insert one or more controls. Within a section, there are multiple 
subsections for placing multiple controls. OmniOMS Communication Designer uses 
sections to make emails responsive across varied devices. The subsections within the 
section get stacked over each other if the defined width of the content area or device 
screen size is less than 700 pixels. 

When you add an email template, a section is already added to the design area by 
default. In Communication Designer, you can add sections of different layouts.

In order to add a section, go to the Insert tab. Click the Section control from the 
Controls toolbar and select the required layout, and then drag and drop it to the design 
area. This topic provides details about the properties and various operations you can 
apply to a Section control:

Configuring section properties●

Moving a section●

Adding another section●

Copying a section●

Deleting a section●
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Configuring section properties

Select the Section control to configure the section properties and then click Edit 
 from the pop-up toolbar. The Edit Section dialog appears. 

The upper left portion of the dialog displays the layout of the control. Use the add icon 

 to insert a new section into the component and click the cross icon   to remove a 
section. You can also adjust the size of the subsection using the resize arrow. The 
bottom left portion of the dialog shows the preview of the section based on the 
settings defined in the Settings tab.

You can add a maximum of six subsections. 

The different tabs in the Edit Section dialog are Structure and Section. In the Structure 
tab, you can set the appearance of the section. For example, you can specify the 
background color, border color, border type, border width, and others for the section. 
However, in the Sub-Section tab, you can set the appearance of the subsection in a 
section. For example, you can set the padding and border settings for the subsections 
in the Sub-Section tab. To set the settings for a specific subsection, select the required 
section from the upper left portion of the dialog. 

The following table describes the different properties available in the Structure tab of 
the Edit Section dialog:

Property Description

Section Area

Background Color
Specify the background color of the section using the color palette or 
enter the color names. For example, red.

Content Area

Background Color
Specify the background color of the content area in the section using 
the color palette or enter the color names. For example, red.
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Property Description

Border Setting

Specify the border setting for the section using any of the following 
options:

 

You can set the size of the border from 0 to 30 pixels.

All Border Radius/
Border Radius

Specify the section corner radius (in pixels) using any of the following 
options:

The padding value can be set in the range from 0 to 30 pixels.

The following table describes the different properties available in the Sub-Section tab of 
the Edit Section dialog.

Property Description

Background Color
Specify the background color of the sub-section in the section using the 
color palette or enter the color names. For example, red.

All Sides — Select this option to apply the border on all sides.
Specify the color in the All Border Color field using the color 
palette or enter the color names in the space provided. Also, 
specify the width (in pixels) and type of the border. The supported 
border types are solid, dotted, or dashed.

●

Individual Sides — Select this option to apply different borders on 
the sides. 
Specify the color for the left, right, top, and bottom borders using 
the color palette, or enter the color names in the space provided. 
Also, specify the width (in pixels) and type of the border. The 
supported border types are solid, dotted, or dashed.

●

All sides — Select this option to specify the corner radius for all 
borders. 
Enter the padding value in the All Radius field. 

●

Individual sides  — Select this option to specify the corner radius 
for different borders. 
Enter the corner radius for the left, right, top, and bottom borders.

●
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1.

2.

Property Description

Border Setting

Specify the border setting for the sub-section using any of the 
following options:

 

You can set the size of the border from 0 to 30 pixels.

Padding

Specify the padding (in pixels) using any of the following options:

The padding value can be set in the range from 0 to 30 pixels.

Moving a section

To move the control from one position to another within the template, follow the below 
steps:

On the design canvas, select the required control. A pop-up toolbar appears. 

Click and hold the Move icon  from the toolbar and drop it to the new location.

All Sides — Select this option to apply the border on all sides.
Specify the color in the All Border Color field using the color palette or 
enter the color names in the space provided. Also, specify the width (in 
pixels) and type of the border. The supported border types are solid, 
dotted, or dashed.

●

Individual Sides — Select this option to apply different borders on the 
sides. 
Specify the color for the left, right, top, and bottom borders using the 
color palette, or enter the color names in the space provided. Also, 
specify the width (in pixels) and type of the border. The supported 
border types are solid, dotted, or dashed.

●

All sides — Select this option to apply the same padding around all the 
section borders. 
Enter the padding value in the All Padding field. 

●

Individual sides  — Select this option to apply different padding on the 
section borders.
Enter the padding for the left, right, top, and bottom borders.

●
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1.
2.
3.

1.

2.

Adding another section

To add a new section below the selected section, follow the below steps:

Select the Section control. A pop-up toolbar appears. 
Click the Add Below icon . A pop-up dialog appears.
Select the required layout for the section.
A new section with the selected layout gets added below the section.

Copying a section

To copy a section, follow the below steps:

On the design canvas, select the required control. A pop-up toolbar appears. 

Click the Copy icon  from the toolbar. 
The control gets copied.

Deleting a section

To remove a control from the template, select the required control on the design 

canvas and then click the Delete icon  from the pop-up toolbar. 
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Image

Use the Image control to embed an image into the Email template.

To add an image, go to the Insert tab. Drag the Image control from the Controls 
toolbar and then place it on the section. The supported image formats are .jpg, .jpeg, 
gif, and SVG. This topic provides details about the different image properties and 
various operations you can apply to an Image control:

Configuring image properties

There are two ways to set the image properties:

The following table describes the properties of the Image Properties dialog:

Property Description

Image Source 
URL

Enter the URL indicating the location of the image. The supported image 
formats are .png, .jpg, .jpeg, gif, and SVG.

Preview It displays the preview of the image.

Image Width

Specify the width of the image in percentage. You can adjust the image 
width using the slider or by directly entering the value in the space provided. 
The image width can vary from 20 to 100 percent. 
By default, the image width is set to 100 percent.

Alignment Specify the alignment of the image. It can be set to left, right, or center.

Configuring image properties●

Moving an image●

Copying an image●

Deleting an image●

Select the Image control and then click Edit  from the pop-up toolbar. The 
Image Properties dialog appears.

●

Double-click the Image control to open the Image Properties dialog.●

The image URL must be accessible to the application server.   ●

The image URL must end with a "." followed by its file extension. ●
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1.

2.

1.

2.

Property Description

Alt Text
Specify the alternative text of the image. This text appears when the image 
fails to load.

Target URL

Specify the target URL for the image, which is an anchor link to another web 
page.

On clicking the image during the preview, you get directed to the required 
link. 

Block Padding

Specify the padding (in pixels) using any of the following options:

You can set padding ranging from 0 to 30 pixels.

Click OK to save the changes.

Moving an image

To move an image from one position to another within the template, follow the below 
steps:

Select the Image control. A pop-up toolbar appears. 

Click and hold the Move icon  from the toolbar and drop it to the new location.

Copying an image

To copy an image, follow the below steps:

Select the Image control. A pop-up toolbar appears. 

Click the Copy icon  from the toolbar. 
The image gets copied.

Deleting an image

To remove an image from the template, select the required Image control on the 

template and then click the Delete icon  from the pop-up toolbar. 

All sides — Select this option to apply the same padding around all the 
control's borders. 
Enter the padding value in the All Block Padding field. You can also use 
the up or down arrow to increase or decrease the padding value. 

●

Individual sides  — Select this option to apply different padding on the 
control's borders.
Enter the padding for the left, right, top, and bottom sides.

●
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Rich text

Use the Rich Text control to display formatted text in an email template. You can apply 
text formatting to highlight or emphasize the text in an email by changing the text font 
and size, specifying the font color, applying letter and paragraph spacing, setting block 
padding, and others.

To add text, go to the Insert tab. Drag the Rich Text control from the Controls toolbar 
and then place it on the section. This topic provides details about the properties and 
various operations you can apply to a Rich Text control:

Configuring text properties

There are two ways to set the rich text properties:

The following table describes the properties of the Text Properties dialog:

Property Description

Font family Specify the text font. By default, it is set to basefont.

Font size Specify the text size in pixels. The default value is 12 pixels.

Bold Click to make the text bold.

Font color
Specify the text color using the color palette or enter the color names with 
hexadecimal values. For example, #ffffff.

Letter spacing
Specify the spacing between the characters within a text. By default, it is set 
to 0 pixels.

Configuring text properties●

Moving a text●

Copying a text●

Adding a macro field●

Inserting a hyperlink●

Deleting a text●

Select the Rich Text control and then click Edit  from the pop-up toolbar. The 
Text Properties dialog appears.

●

Double-click the Rich Text control to open the Text Properties dialog.●
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1.

2.

1.

2.

Property Description

Paragraph 
spacing

Specify the spacing between the paragraphs within the rich text control. By 
default, it is set to 16 pixels.

Line height
Specify the spacing between the lines within the rich text control. This value 
is represented in the percentage of the letter height. By default, it is set to 
120%.

Alignment Specify the alignment of the text. It can be set to left, right, or center.

Block padding

Specify the padding (in pixels) using any of the following options:

You can set padding ranging from 0 to 30 pixels.

Click OK to save the changes.

Moving a text

To move a rich text control from one position to another within the template, follow the 
below steps:

Select the Rich Text control. A pop-up toolbar appears. 

Click and hold the Move icon  from the toolbar and drop it to the new location.

Copying a text

To copy a rich text control, follow the below steps:

Select the Rich Text control. A pop-up toolbar appears. 

Click the Copy icon  from the toolbar. 
The control gets copied.

All sides — Select this option to apply the same padding around all the 
control's borders. 
Enter the padding value in the All Block Padding field. You can also 
use the up or down arrow to increase or decrease the padding value. 

●

Individual sides  — Select this option to apply different padding on the 
control's borders.
Enter the padding for the left, right, top, and bottom sides.

●
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1.
2.
3.
4.
5.

1.
2.

3.
4.
5.

Adding a macro field

A macro field is a field in the linked dataset. You can add macro fields in the rich text 
control to show dynamic content. For example, you can insert macro fields to display 
an employee’s name, address, phone, designation, and other details in the email.

To add a macro field, follow the below steps:

Right-click the Rich Text control.
Select Add Macro option from the list. The Dataset Field dialog appears.
Select the table name from the dropdown list.
Select the column name from the dropdown list.
Click OK. 

Adding a hyperlink

Insert hyperlinks to link the text with a web page. 

To add a hyperlink, follow the below steps:

Right-click text in the Rich Text control.
Select Add Hyperlink option from the list.
The Add Hyperlink dialog appears.
Enter the name of the hyperlink. By default, the selected text appears in this field.
Then, specify the target link.
Click Save to confirm. 

Deleting a text

To remove a rich text control from the template, select the required Rich Text control 

on the template and then click the Delete icon  from the pop-up toolbar. 

Table

Use the table control in your email template to display data in tabular format. A table is 
composed of rows and columns. You can add, remove, or resize rows and columns. 
Additionally, you can display dynamic content, merge cells, and add headers.
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1.

To add a table, go to the Insert tab. Drag the Table control from the Controls toolbar 
and then place it on the desired section. The Table Template dialog appears. Select the 
number of rows and columns by hovering over the grid until the desired number of 
boxes are highlighted. Click to create the table. The table appears in the selected 
section. This topic covers the following sections:

Configuring table properties

To configure the table properties, perform the following steps:

Select the Table and then click Edit   from the pop-up toolbar. The Table 
Properties dialog appears with the following options:

Option Description

Row 

Pin Header Row
This toggle button allows you to set a header for the table. It 
fix the first row of your table as a header.

Header Color
Allows you to choose a color for the header from the color 
palette.

Set Row Alternate Color This toggle button allows you to enable alternating row colors.

Odd Row Color
Allows you to choose the color for the odd-numbered rows 
from the color palette.

Even Row Color
Allows you to choose the color for the even-numbered rows 
from the color palette.

Column

Configuring table properties ●

Moving a table●

Copying a table●

Adding a macro field●

Adding a hyperlink●

Deleting a table●

Configuring table style●

Configuring cell style●

Inserting a row or column●

Deleting a row or column●

Merging table cells●
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Option Description

Equalise Width
This toggle button allows you to make all columns equal in 
width.

Set Column Alternate Color
This toggle button allows you to enable alternating column 
colors.

Odd Column Color
Allows you to choose the color for the odd-numbered 
columns from the color palette.

Even Column Colour
Allows you to choose the color for the odd-numbered 
columns from the color palette.

Click Save.

Moving a table

To move a table from one position to another within the template, follow the below 
steps:

Select the table. A pop-up toolbar appears. 

Click and hold the Move icon  from the toolbar and drop it to the new location.

Copying a table

To copy a table, follow the below steps:

Select the table. A pop-up toolbar appears. 

Click the Copy icon  from the toolbar. 
The table gets copied.

Adding a macro field

A macro field is a field in the linked dataset. You can add macro fields in the table to 
show dynamic content. For example, you can insert macro fields to display an 
employee’s name, address, phone, designation, and other details in the email.

To add a macro field, follow the below steps:

Right-click the table cell.
Select Add Macro option from the list. The Dataset Field dialog appears.
Select the table name from the dropdown list.
Select the column name from the dropdown list.
Click OK. 
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Adding a hyperlink

Insert hyperlinks to link the table with a web page. 

To add a hyperlink, follow the below steps:

Right-click text in the table.
Select Add Hyperlink option from the list.
The Add Hyperlink dialog appears.
Enter the name of the hyperlink. By default, the selected text appears in this field.
Then, specify the target link.
Click Save to confirm. 

Deleting a table

To remove a table from the template, select the required table on the template and 

then click the Delete icon  from the pop-up toolbar. 

Configuring table style

To configure the table style, perform the following steps:

On the design canvas, select the required table.
Go to the Table tab and then select Table Style.
The Table Style dialog appears with the following options:

Property Description

Background Color
Specify the background color using the color palette or enter the color 
name using a hexadecimal value.

Border Settings 

Allows you to select the border settings based on the following 
options:

All Border Color
Specify the table border color using the color palette or enter the color 
name using a hexadecimal value.

All Border Size Set the border size in pixels.

All Sides — Select this option to apply the border settings on all 
the table sides.

●

Individual Sides — Select this option to apply the different 
border settings on the sides.

●
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Property Description

All Border Type

Set the border type with the following available options: 

Block Padding

Allows you to apply the block padding based on the following options:

All Block Padding Specify the block padding for all sides in pixels.

Click Save.

Configuring cell style

To configure the cell style, perform the following steps:

On the design canvas, select the required table.
Go to the Table tab and then select Cell Style.
The Cell Style dialog appears with the following options:

Property Description

Background Color
Specify the background color using the color palette or enter the 
color name using a hexadecimal value.

Letter Spacing Specify the letter spacing in pixels.

Line Height Specify the line height as a percentage.

Align
Align the cell content to top left, top center, top right, center left, 
center, center right, bottom left, bottom center, and bottom right.

Border Settings 

Allows you to select the border settings based on the following 
options:

All Border Color
Specify the table border color using the color palette or enter the 
color name using a hexadecimal value.

solid●

dotted●

dashed●

All Sides — Select this option to apply the block padding on all 
the table sides.

●

Individual Sides — Select this option to apply the different block 
padding on the sides.

●

All Sides — Select this option to apply the border settings on all 
the table sides.

●

Individual Sides — Select this option to apply the different 
border settings on the sides.

●
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Property Description

All Border Size Set the border size in pixels.

All Border Type

Set the border type with the following available options: 

Cell Padding

Allows you to apply the cell padding based on the following options:

All Padding Specify the cell padding for all sides in pixels.

Click Save.

Inserting a row or column

To insert a row or column:

On the design canvas, place the cursor on the required table cell.
Press the Shift key and the left mouse button. 
The table cell gets selected.
Go to the Table tab, and select Insert dropdown. The following options appear to 
select:

Deleting a row or column

To delete a row or column:

On the design canvas, place the cursor on the required table cell.
Press the Shift key and the left mouse button. 
The table cell gets selected.

solid●

dotted●

dashed●

All Sides — Select this option to apply the cell padding on all 
the table sides.

●

Individual Sides — Select this option to apply the different cell 
padding on the sides.

●

Insert Row Above — Adds a new row directly above the selected row.●

Insert Row Below — Adds a new row directly below the selected row.●

Insert Col to Left — Adds a new column directly to the left of the selected 
column.

●

Insert Col to Right — Adds a new column directly to the right of the 
selected column.
The row or column is added to the position.

●
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Go to the Table tab, and select Delete dropdown. The following options appear to 
select:

Merging table cells

To merge the table cells, follow the below steps:

On the design canvas, select the required table cells by pressing the Shift key and 
left-mouse click.
Go to the Table tab and then select Merge Cell.
The cells are now merged.
To unmerge the cells, select the merged cell by pressing the Shift key and left-
mouse click. Then, go to the Table tab and select Unmerge Cell.

Delete Row — Removes the entire row where the selected cell is located.●

Delete Column — Removes the entire column where the selected cell is 
located.
The row or column is deleted from the selected position.

●
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Button

Add buttons to link to another web page in an email. For example, you can use a 
button in an email to send customers to your company website. With the help of 
buttons, you can effectively improve the customer interactivity rate. Apart from this, 
OmniOMS Communication Designer provides you with various options to customize 
the appearance of the button.

To add a button, go to the Insert tab. Drag the Button control from the Controls toolbar 
and then place it on the section. This topic provides details about the properties and 
various operations you can apply to a Button control:

Configuring button properties

There are two ways to set the button properties:

The following table describes the properties of the Button Properties dialog:

Property Description

Auto width

Select to automatically resize the width of the button based on the entered 
text. Otherwise, you can adjust the button width using the slider or by 
directly entering the value in the provided space.  The button width can vary 
from 20 to 100 percent relative to the width of the sub-section.

Background color
Specify the color of the button using the color palette or enter the color 
names with hexadecimal values. For example, #ffffff.

Font color
Specify the text color using the color palette or enter the color names with 
hexadecimal values. For example, #ffffff.

Font Specify the font style of the text. 

Configuring button properties●

Moving a button●

Copying a button●

Deleting a button●

Select the Button control and then click Edit  from the pop-up toolbar. The 
Button Properties dialog appears.

●

Double-click the Button control to open the Button Properties dialog.●
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Property Description

Font size
Specify the font size of the text in pixels. By, default the font size is set to 12 
pixels. 

Font weight
Specify the font weight of the text. It can be set to regular or bold. By default, 
the font weight is set to regular.

Button alignment
Specify the alignment of the button within the component. It can be set to 
left, right, or center.

Line height
Specify the spacing between the lines within the rich text control. This value 
is represented in the percentage of the letter height. By default, it is set to 
120%.

Letter spacing
Specify the spacing between the characters in a text. By default, it is set to 2 
pixels.

Border color
Specify the border color for the button using the color palette or enter the 
color names with hexadecimal values. For example, #ffffff..

Border width
Specify the border width for the button. By default, no border is applied to 
the Button control.

Border type
Specify the border type for the button. It can be set to solid, dotted, and 
dashed. By default, the border type is set to solid.

Radius Specify the corner radius for the button.

Text padding

Specify the text padding (in pixels) using any of the following options:

You can set padding ranging from 0 to 30 pixels.

All sides — Select this option to apply the same padding within the 
control content and border. 
Enter the padding value in the All Block Padding field. You can also 
use the up or down arrow to increase or decrease the padding value. 

●

Individual sides  — Select this option to apply different padding within 
the control content and border.
Enter the padding for the left, right, top, and bottom borders.

●
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2.

1.

2.

Property Description

Block padding

Specify the padding (in pixels) using any of the following options:

You can set padding ranging from 0 to 30 pixels.

Moving a button

To move a button from one position to another within the template, follow the below 
steps:

Select the Button control. A pop-up toolbar appears. 

Click and hold the Move icon  from the toolbar and drop it to the new location.

Copying a button

To copy a button, follow the below steps:

Select the Button control. A pop-up toolbar appears. 

Click the Copy icon  from the toolbar. 
The button gets copied.

Deleting a button 

To remove a button from the template, select the required Button control on the 

template and then click the Delete icon  from the pop-up toolbar. 

All sides — Select this option to apply the same padding around all the 
control's borders. 
Enter the padding value in the All Block Padding field. You can also 
use the up or down arrow to increase or decrease the padding value. 

●

Individual sides  — Select this option to apply different padding on the 
control's borders.
Enter the padding for the left, right, top, and bottom sides.

●
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Divider

Use Divider to insert a horizontal line for separating content within an email. You can 
add a divider to distinguish different sections or break lengthy sections in an email 
message. 

To add a divider, go to the Insert tab. Drag the Divider control from the Controls toolbar 
and then place it on the section. This topic provides details about the properties and 
various operations you can apply to a Divider control:

Configuring divider properties

There are two ways to set the divider properties:

The following table describes the properties of the Divider Properties dialog:

Property Description

Color
Specify the color of the divider using the color palette or enter the color 
names with hexadecimal values. For example, #ffffff.

Width
Specify the width of the divider in pixels. By default, the width is set to 100 
pixels. 

Line height 
Specify the height of the divider in pixels. By default, the line height is set to 1 
pixel. 

Line type
Specify the line type for the divider. It can be set to solid, dotted, and 
dashed.  

Alignment
Specify the alignment of the divider within the component. It can be set to 
left, center, or right.

Configuring divider properties●

Moving a divider●

Copying a divider●

Deleting a divider●

Select the Divider control and then click Edit  from the pop-up toolbar. The 
Divider Properties dialog appears.

●

Double-click the Divider control to open the Text Properties dialog.●



     Adding controls

Version: 12.0 NewgenONE OmniOMS Communication Designer User Guide 79            

1.

2.

1.
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Property Description

Block padding

Specify the padding (in pixels) using any of the following options:

You can set padding ranging from 0 to 30 pixels.

Moving a divider

To move a divider from one position to another within the template, follow the below 
steps:

Select the Divider control. A pop-up toolbar appears. 

Click and hold the Move icon  from the toolbar and drop it to the new location.

Copying a divider

To copy a divider, follow the below steps:

Select the Divider control. A pop-up toolbar appears. 

Click the Copy icon  from the toolbar. 
The divider gets copied.

Deleting a divider

To remove a divider from the template, select the required Divider control on the 

template and then click the Delete icon  from the pop-up toolbar. 

Spacer

Use Spacer to insert spaces between the controls. To add spacing, go to the Insert tab. 
Drag the Spacer control from the Controls toolbar and then place it on the section. 

This topic provides information about the spacer properties and different operations 
you can apply to a Spacer control:

All sides — Select this option to apply the same padding around all the 
control's borders. 
Enter the padding value in the All Block Padding field. You can also 
use the up or down arrow to increase or decrease the padding value. 

●

Individual sides  — Select this option to apply different padding on the 
control's borders.
Enter the padding for the left, right, top, and bottom sides.

●
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Configuring spacer properties

There are two ways to set the spacer properties:

Property Description

 Height Specify the height for the Spacer control.

Moving a spacer

To move a spacer from one position to another within the template, follow the below 
steps:

Select the Spacer control. A pop-up toolbar appears. 

Click and hold the Move icon  from the toolbar and drop it to the new location.

Copying a spacer

To copy a spacer, follow the below steps:

Select the Spacer control. A pop-up toolbar appears. 

Click the Copy icon  from the toolbar. 
The spacer gets copied.

Deleting a spacer

To remove a spacer from the template, select the required Spacer control on the 

template and then click the Delete icon  from the pop-up toolbar. 

Configuring spacer properties●

Moving a spacer●

Copying a spacer●

Deleting a spacer●

Select the Spacer control and then click Edit  from the pop-up toolbar. The 
Spacer Properties dialog appears.

●

Double-click the Spacer control to open the Spacer Properties dialog.●
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Video

OmniOMS Communication Designer allows you to insert videos in your email template 
to increase the customer interactivity rate. For example, you can add a video to give 
quick product demos to the customers. 

To add a video, go to the Insert tab. Drag the Video control from the Controls toolbar 
and then place it on the section. This topic provides details about the properties and 
various operations you can apply to a Video control:

Configuring video properties

There are two ways to set the video properties:

The following table describes the properties of the Video Properties dialog:

Property Description

 Video title Specify the title of the video.

 Video URL Specify the URL of the video. 

Preview Image URL

Specify the URL of the image poster to use in the video. This poster appears 
until the user hits the play button. The supported image formats 
are .png, .jpg, .jpeg, and gif.

Configuring video properties●

Moving a video control●

Copying a video control●

Deleting a video control●

Select the Video control and then click Edit  from the pop-up toolbar. The 
Video Properties dialog appears.

●

Double-click the Video control to open the Video Properties dialog.●

The image URL must be accessible to the application server.   ●

The image URL must end with a "." followed by its file extension.●

Ensure to host the image poster on the client’s CDN server. For more 
information, see NewgenONE OmniOMS Developer Guide. 

●
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Property Description

Play Button URL

Specify the URL of the play button image to use in the video. The supported 
image formats are .png, .jpg, .jpeg, and gif.

Preview It shows the preview of the video.

Block Padding

Specify the padding (in pixels) using any of the following options:

You can set padding ranging from 0 to 30 pixels.

Moving a video control

To move the Video control from one position to another within the template, follow the 
below steps:

Select the Video control. A pop-up toolbar appears. 

Click and hold the Move icon  from the toolbar and drop it to the new location.

Copying a video control

To copy the video control, follow the below steps:

Select the Video control. A pop-up toolbar appears. 

Click the Copy icon  from the toolbar. 
The video gets copied.

Deleting a video control

To remove a video from the template, select the required Video control on the 

template and then click the Delete icon  from the pop-up toolbar. 

The image URL must be accessible to the application server.   ●

The image URL must end with a "." followed by its file extension.●

Ensure to host the image poster on the client’s CDN server. For more 
information, see NewgenONE OmniOMS Developer Guide. 

●

All sides — Select this option to apply the same padding around all 
the control's borders. 
Enter the padding value in the All Block Padding field. You can also 
use the up or down arrow to increase or decrease the padding value. 

●

Individual sides  — Select this option to apply different padding on 
the control's borders.
Enter the left, right, top, and bottom sides padding.

●
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Icon

Use icons to display small-dimension images within the email template. For example, 
you can use icons for Facebook, WhatsApp, Outlook, and others in the template.

To add an icon, go to the Insert tab. Drag the Icons control from the Controls toolbar 
and then place it on the section. This topic provides details about the properties and 
various operations you can apply to the Icons control:

Configuring icon properties

Select the Icons control and then click Edit  from the pop-up toolbar. 
Alternatively, double-click the Icons control. 
The Icons Properties dialog appears.
Select the type of menu type for the icon. It can be any of the following:

Configuring icon properties●

Moving an icon●

Copying an icon●

Deleting an icon●

Icon — Select this option to only insert an image. 

Property Description

Icon properties

Image Source 
URL

Enter the URL indicating the location of the image. The supported 
image formats are .png, .jpg, .jpeg, and gif.

Preview It displays the preview of the image.

Title
Specify the title for the image.
It appears when you hover the mouse cursor over the image during 
template preview.

Alt Text
Specify the alternative text for the image. This text appears when 
the image fails to load.

●

The image URL must be accessible to the application server.   ●

The image URL must end with a "." followed by its file extension. ●
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Property Description

Target URL

Specify the target URL for the image, which is an anchor link to 
another web page.

On clicking the image during the preview, you get directed to the 
required link. 

Common properties

Alignment
Specify the alignment of the image. It can be set to left, right, or 
center.

Icon Size Specify the size of the icon. By default, it is set to 16 pixels.

Icon Spacing Specify the spacing between the two icons in pixels.

Icon Padding

Specify the icon padding (in pixels) using any of the following 
options:

You can set padding ranging from 0 to 30 pixels.

Block Padding

Specify the padding (in pixels) using any of the following options:

You can set padding ranging from 0 to 30 pixels.

Click the Add New Icon to insert another icon. Additionally, you can use the 
up and down arrows to arrange icons within the control.

All sides — Select this option to apply the same padding 
around all the icon's borders. 
Enter the padding value in the All Padding field. You can also 
use the up or down arrow to increase or decrease the padding 
value. 

●

Individual sides  — Select this option to apply different 
padding on the icon's borders.
Enter the padding for the left, right, top, and bottom sides.

●

All sides — Select this option to apply the same padding 
around all the control's borders. 
Enter the padding value in the All Block Padding field. You 
can also use the up or down arrow to increase or decrease the 
padding value. 

●

Individual sides  — Select this option to apply different 
padding on the control's borders.
Enter the padding for the left, right, top, and bottom sides.

●
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Icon + Text — Select this option to insert an image with a short text.

Property Description

Icon + Text properties

Image Source URL

Enter the URL indicating the location of the image. The 
supported image formats are .png, .jpg, .jpeg, and gif.

Preview It displays the preview of the image.

Icon + Text Specify the text to display with the image. 

Title
Specify the title for the image.
It appears when you hover the mouse cursor over the image 
during template preview.

Alt Text
Specify the alternative text of the image. This text appears 
when the image fails to load.

Target URL

Specify the target URL for the image, which is an anchor link to 
another web page.

On clicking the image during the preview, you get directed to 
the required link. 

Common Properties

Font Specify the text font. By default, it is set to basefont. 

Font size Specify the text size in pixels. The default size is 12 pixels.

Font color
Specify the text color using the color palette or enter the color 
names with hexadecimal values. For example, #ffffff.

Letter spacing  
Specify the spacing between the characters within a text. By 
default, it is set to 0 pixels.

Alignment
Specify the alignment of the image. It can be set to left, right, or 
center.

Icon Size Specify the size of the icon. By default, it is set to 16 pixels.

Separator
Specify the separator you want to use for separating the icons.

This property is disabled in case of vertical layout. 

Icon Spacing Specify the spacing between the two icons in pixels.

●

The image URL must be accessible to the application server.   ●

The image URL must end with a "." followed by its file extension.●
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Property Description

Icon Padding

Specify the icon padding (in pixels) using any of the following 
options:

You can set padding ranging from 0 to 30 pixels.

Block Padding

Specify the padding (in pixels) using any of the following 
options:

You can set padding ranging from 0 to 30 pixels.

Click the Add New Icon to insert another icon. Additionally, you can use the 
up and down arrows to arrange icons within the control.

All sides — Select this option to apply the same padding 
around all the icon's borders. 
Enter the padding value in the All Block Padding field. 
You can also use the up or down arrow to increase or 
decrease the padding value. 

●

Individual sides  — Select this option to apply different 
padding on the icon's borders.
Enter the padding for the left, right, top, and bottom 
sides.

●

All sides — Select this option to apply the same padding 
around all the control's borders. 
Enter the padding value in the All Block Padding field. 
You can also use the up or down arrow to increase or 
decrease the padding value. 

●

Individual sides  — Select this option to apply different 
padding on the control's borders.
Enter the padding for the left, right, top, and bottom 
sides.

●
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Text — Select this option to only insert text.

Property Description

Text Properties

Text Specify the text to display with the image. 

Title
Specify the title for the image.
It appears when you hover the mouse cursor over the image during 
template preview.

Target URL
Specify the target URL for the image. The target URL provides 
additional information apart from the image.

Common properties

Layout
Specify whether to arrange the text horizontally or vertically. 

This property is available only in the case of multiple texts.   

Separator
Specify the separator you want to use for separating the icons.

This property is disabled in case of vertical layout. 

Alignment
Specify the alignment of the image. It can be set to left, right, or 
center.

Icon Size Specify the size of the icon. By default, it is set to 16 pixels.

Icon Spacing Specify the spacing between the two icons in pixels.

Icon Padding

Specify the icon padding (in pixels) using any of the following 
options:

You can set padding ranging from 0 to 30 pixels.

●

All sides — Select this option to apply the same padding 
around all the icon's borders. 
Enter the padding value in the All Block Padding field. You 
can also use the up or down arrow to increase or decrease the 
padding value. 

●

Individual sides  — Select this option to apply different 
padding on the icon's borders.
Enter the padding for the left, right, top, and bottom sides.

●
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1.

2.
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Click Save.

Moving an icon

To move an icon from one position to another within the template, follow the below 
steps:

Select the Icons control. A pop-up toolbar appears. 

Click and hold the Move icon  from the toolbar and drop it to the new location.

Copying an icon

To copy an icon, follow the below steps:

Select the Icons control. A pop-up toolbar appears. 

Click the Copy icon  from the toolbar. 
The icon gets copied.

Deleting an icon

To remove an icon from the template, select the required Icons control on the template 

and then click the Delete icon  from the pop-up toolbar. 

Property Description

Block Padding

Specify the padding (in pixels) using any of the following options:

You can set padding ranging from 0 to 30 pixels.

Click the Add New Item to insert another text. Additionally, you can use the 
up and down arrows to arrange items within the control.

All sides — Select this option to apply the same padding 
around all the control's borders. 
Enter the padding value in the All Block Padding field. You 
can also use the up or down arrow to increase or decrease the 
padding value. 

●

Individual sides  — Select this option to apply different 
padding on the control's borders.
Enter the padding for the left, right, top, and bottom sides.

●
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List

The List feature allows you to organize and display content in a structured, itemized 
format within your email templates. This is particularly useful for presenting 
information in a clear, easy-to-read manner.

A company is launching a new product and wants to send out a promotional email to 
its customers. To highlight the key features of the product, they use the List feature in 
the email template. This allows them to organize the product's top features, such as 
high performance, affordable pricing, eco-friendly design, and advanced technology, in 
a clear and structured format. The use of bullet points makes the information easy to 
read, ensuring that customers quickly grasp the product's benefits.

To add a list, follow the below steps:

Go to the Insert tab.
Drag the list control from the Controls toolbar and then place it on the desired 
section. The Table Properties dialog appears. 
Enter the following details in the corresponding fields:

Property Description

List Type
Allows you to choose between two list types: Bullet or 
Numbering.

Bullet Options For the bullet type, choose from a Disc, Circle, or Square.

Numbering Options
For the numbering type, choose from 123, abc, ABC, i ii iii, 
or I II III.

Font Name Select the font style to apply to the list items.

Font Color Allows you to choose the text color for the list items.

Alignment
Allows you to set the alignment of the list items: Left, 
Center, or Right.

List Item Spacing
Allows you to adjust the vertical spacing between each list 
item.

List Item Indent
Allows you to control the indentation level of the list items, 
determining how far the items are indented from the left 
margin.
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Property Description

Line Height
Allows you to adjust the space between lines within each 
list item.

Letter Spacing
Allows you to control the spacing between characters in 
the list items.

Block Padding

Allows you to adjust the padding around the entire list 
block. You can apply uniform padding using All Padding 
or specify individual values for Left, Right, Top, and 
Bottom padding.

Click Save to confirm.

Moving a list

To move a list control from one position to another within the template, follow the 
below steps:

Select the list control. A pop-up toolbar appears. 

Click and hold the Move icon  from the toolbar and drop it to the new location.

Copying a list

To copy a list control, follow the below steps:

Select the list control. A pop-up toolbar appears. 

Click the Copy icon  from the toolbar. 
The control gets copied.
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Component

A component is a reusable piece of content that you can use across multiple templates. 
This saves you both time and effort and ensures a consistent look over templates. For 
more information, see Working with components.

To add a component, select the required section on the design canvas. Go to the Insert
tab and click the Make Components control from the Controls toolbar. A Select 
Components dialog appears. Here, you can select the type of component you want to 
create. It can either be a Local Component or an Enterprise Component. Then, click 
Save to confirm. The component gets created. It includes all the controls in the 
selected section. For more information about the component types, see Types of 
component.

You cannot add a pre-existing component to the template.  

A component supports all the formatting options and controls you apply to an email 
template. For more information, see Adding an email template.

You can then click Save to confirm the changes. 

This topic provides details about the different operations you can apply to a 
Component control: 

Formatting options — The File menu consists of a formatting toolbar that 
provides various formatting options to modify the font size, color, alignment, and 
style.

●

Controls — The Insert menu consists of a Controls toolbar that allows you to 
insert text, images, links, buttons, and other controls to the component. 

●

Moving a component●

Unlinking a component●

Deleting a component●
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Moving a component

To move a component from one position to another within the template, follow the 
below steps:

Select the Component control. A pop-up toolbar appears. 

Click and hold the Move icon  from the toolbar and drop it to the new location.

Unlinking a component

You can delink the component to reuse the same component design on the canvas. 

To unlink a component, follow the below steps:

Select the Component control. A pop-up toolbar appears. 

Click the Unlink Component icon  from the toolbar. 
The image gets copied.

Deleting a component

To remove a component from the template, select the required Component control on 
the template and then click the Delete icon  from the pop-up toolbar. 

 

Related topic(s)
Working with components●

Working with component gallery●
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Letter template
The letter template supports the following controls.  

When you add controls to the template, you can perform various operations on it. 
Although the list of operations for each control varies. 

Rich text●

Table●

Image●

Charts●

Shape●

Arithmetic expression●

Barcode●

Password●

Annexure configuration●

Watermark configuration●

Digital signature●

Paragraph●

Page break●

Component●
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Rich text

Use the Rich Text control to display formatted text in a template. You can apply text 
formatting to highlight or emphasize the text by changing the text font and size, 
specifying the font color, applying letter and paragraph spacing, setting block padding, 
and more.

To add text, go to the Insert tab. Select the Rich Text control from the Controls toolbar 
and click anywhere in the design canvas. The rich text gets added. This topic provides 
details about the  properties and various operations you can apply to a Rich Text 
control:

Configuring text properties

To configure text properties, follow the below steps:

On the design canvas, right-click the rich text control.
Select Properties from the context menu.
The Textbox Properties dialog appears.
Specify the following properties: 

Property Description

Border Width
Specify the border width for the Rich Text control. The entered value 
must be in the range of 1 to 6.

Border Color
Specify the border color for the Rich Text control using the color palette 
or enter the color name with a hexadecimal value. For example, #ffffff.

Apply 
Indentation

Select to enable indentation for the text within the Rich Text control.

Click Save to confirm.  

Configuring text properties●

Setting padding●

Adding a system field●

Adding a macro field●

Adding a hyperlink●
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Setting padding

To set padding for the control, follow the below steps:

On the design canvas, right-click the required control.
Select Set Padding from the context menu.
The Set Padding dialog appears.
Specify the top padding for the control's top border in pixels. 
Specify the left padding for the control left border in pixels.
Click Set to save.

Adding a system field

There are eight system fields in OmniOMS Communication Designer that are 
statement date, current date and time, current date, current time, current time new, 
current page, total pages, and total pages in words.

To add a system field within control, follow the below steps:

On the design canvas, right-click the required control.
Select Add System Fields from the context menu. A list of supported system fields 
appears.
Select the required system fields from the list.

System field Description

Statement Date Returns the template generation date.

Current Date Time
Returns the current system date and time in dd-MM-yyyy hh:mm:ss 
format.

Current Date Returns the current system date in dd-MM-yy format.

Current Time Returns the current system time in hh:mm:ss format.

Current Time New Returns the current system time in hh:mm:ss a zzz format.

Current Page Returns the current page of the letter template.

Total Pages Return the total number of pages in the letter template.

Total Pages in 
words

Return the total number of pages in the letter template in words.

The system field gets added.
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Adding a macro field

A macro field is a field in the linked dataset. You can add macro fields in the rich text 
control to show dynamic content. For example, you can insert macro fields to display 
an employee’s name, address, phone, designation, and other details in the email.

To add a macro field, follow the below steps:

On the design canvas, right-click the required control.
Select Add Macro option from the list.
The Dataset Field dialog appears.
Select the table name from the dropdown list.
Select the column name from the dropdown list.
Click OK. 

Adding a hyperlink

Insert hyperlinks to link the text with a web page. 

To add a hyperlink, follow the below steps:

Select the required text within the control.
Right-click the selected text and then select Add Hyperlink option from the 
context menu.
The Add Hyperlink dialog appears.
Enter the name of the hyperlink. By default, the selected text appears in this field.
Then, specify the target link.
Click Save to confirm. 

Related topic(s)
Defining and managing rules●

Adding arithmetic expression ●
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Table

Use the table control in your letter template to display data in tabular format. A table is 
composed of rows and columns. You can add or remove the rows and columns from 
the table. You can also adjust the column size. Apart from this, you can also display 
dynamic content, merge the table cells, add table headers, and others.

To add a table, go to the Insert tab. Select the Table control from the Controls toolbar 
and click anywhere in the design canvas to open the Table Properties dialog. This topic 
covers the following sections:

Configuring table properties

You can configure the table settings in the Structure tab of the Table Properties dialog.

Property Description

Table Name
Specify the name of the table. The table must have a unique 
name within a template. 

Column Information

Equalize Width
Enable the toggle to allow the auto-distribution of column 
width within the table. The sum of all the column widths 
must be 100 percent.

Configuring table properties ●

Configuring advanced table properties●

Setting table border●

Setting table dimension●

Setting a cell border●

Specify table padding●

Adjusting cell text rotation●

Merging table cells●

Adding a system field●

Adding a macro field●

Adding a hyperlink●

Adding table elements●
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Property Description

+New Column

By default, there are two columns in the table. You can add 
more columns by clicking the + New Column. 

Additionally, you can modify the column width and apply 
rules to the columns. For more information, see Defining and 
managing rules.

Rows Information

Insert After Selected Row 

Choose this option to add a new row below the selected row 
in the Row Information section, and then click + Add New 
Row.
Additionally, you can apply rules to the added rows.

Insert Before Selected Row

Choose this option to add a new row before the selected row 
in the Row Information section, and then click + Add New 
Row.
Additionally, you can apply rules to the added rows.

Allow Header
Enable this toggle switch to set the table header properties. 
You cannot select a row as a dynamic row that is enabled 
with the Allow Header option.

Starting Row Select a suitable row to use as the starting row for the header.

Ending Row  Select a suitable row to use as the ending row for the header.

Attributes

It consists of the following attributes:

Configuring advanced table properties

You can configure the advanced table settings in the Advanced Options tab of the 
Table Properties dialog. There are three categories available:

Create table header on each page — In the case of an 
overflowing table, use this option to repeat the table 
headers on each page. 

●

Suppress table header for blank rows — Use this 
option to suppress the header rows with no data.

●

Dynamic properties●

Auto adjust property●

Table transpose●
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Dyanmic properties

Configure settings to display dynamic content in your table, such as enabling dynamic 
rows and setting numbering formats.

Property Description

Dynamic Table
Enable the toggle to display dynamic content in the table. The 
rows within a table are dynamic in nature as they depend on the 
data in the linked dataset. 

Detail Row
Select a suitable row from the dropdown list to show dynamic 
content in the table.

Table Name
Select a suitable dataset field from the dropdown list. New rows 
are added dynamically to the table based on the data in the linked 
dataset. 

Numbering

Select a suitable numbering format for the dynamic table row. It 
can be any of the following:

Multi Color Rows

Turn on the toggle to add background colors to alternate rows for 
improved readability. When the toggle is on, choose a color from 
the palette or enter a hexadecimal color code, then click the Add 
button to apply the color. Alternate rows reflect the selected 
colors.

Auto adjust property

Adjust the table's row and column properties automatically based on content, page 
space, and custom conditions to ensure optimal layout.

Rows tab

Property Description

Start From New Page
Select this checkbox to ensure the table row starts from a 
new page.

1, 2, 3..●

A, B, C..●

a, b, c..●

I, II, III..●

i, ii, iii..●
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1.

Property Description

Always adjust row height 
automatically

Select this button to automatically adjust the row height.

If space on the page is less than
Select this button and enter the value for adjusting the row 
height if space is limited.

If space left on the page
Select this button and enter the value for adjusting the row 
height based on the remaining space.

Reduce Table Size
Select this checkbox and enter the percentage. If the space 
occupied on the last page is less than the specified 
percentage, reduce the font size by the specified points.

Spill Row on Page Split
Select this checkbox to allow rows to spill over onto the next 
page.

Columns tab

Property Description

Auto Adjust by Content
Select this checkbox to automatically adjust columns based 
on content. Enter the columns to be suppressed in the 
provided text box.

Auto Adjust by Width
Select this checkbox to automatically adjust columns based 
on width.

Table transpose

Transpose your table, turning existing rows into columns. Customize the width of the 
transposed rows for better presentation.

Property Description

Enable Transpose Toggle the button to enable table transpose.

Equalize Width
When the transpose is enabled, existing rows become 
columns in the transposed table. Enable this toggle to 
equalize the width for the transposed rows.

Setting table border

To set the table borders, follow the below steps:

Click anywhere in the table.
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Go to the Table tab, and click Table Border.
The Table Border dialog appears.
Enter the following details in the dialog:

Property Description

Line Width Specify the width of the table border.

Line Color 
Specify the cell border color using the color palette or enter the color 
name using a hexadecimal value.

Border Color 
 Specify the table border color using the color palette or enter the color 
name using a hexadecimal value.

Round Corner Select this option for rounded table borders.

Click Save.

Setting table dimension

To set the dimensions of the table, follow the below steps:

On the design canvas, right-click anywhere in the table and then select Set 
Element Dimension from the list. 
The Set Dimensions dialog appears.
Specify the height and width of the table dimensions (in pixels).
Click Save. 

Setting a cell border

To set the table cell border, follow the below steps:

On the design canvas, place the cursor on the required table cell.
Press the Shift key and the left mouse button. 
The table cell gets selected.
Go to the Table tab, and select Cell Border.
The Cell Border dialog appears.
Enter the following information in the dialog:

Property Description

 Border Width Specify the border width for the table cell.
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Property Description

 Border Color
Specify the table border color using the color palette or 
enter the color name using a hexadecimal value.

Border Style
Select the table side on which you want to apply the 
border. It can be a left border, right border, top border, 
and bottom border.

Click Save.

Specify table padding

To set table padding, follow the below steps:

On the design canvas, place the cursor on the required table.
Go to the Table tab and then select Padding.
The Set Padding dialog appears.
Select the padding type. It can be any of the following:

The padding value must lie in the range of 1 to 100 pixels.  

Click Save.

Adjusting cell text rotation

To set the text rotation in the table cell, follow the below steps:

On the design canvas, place the cursor on the required table.
Go to the Table tab and then select the Cell Text Rotation dropdown.
Select any of the following options from the dropdown:

The cell text now appears based on the chosen value during the preview.

All — Select this option to apply the padding on all the table sides. Then, 
enter the padding value in pixels.

●

Individual — Select this option to apply the different padding on the sides. 
Then enter the padding value for each side in pixels.

●

0° — Select this option to rotate the text in the table to 0 degrees.●

90° — Select this option to rotate the text in the table to 90 degrees.●

180° — Select this option to rotate the text in the table to 180 degrees.●

270° — Select this option to rotate the text in the table to 270 degrees.●



     Adding controls

Version: 12.0 NewgenONE OmniOMS Communication Designer User Guide 103            

1.

2.

1.
2.

3.

Merging table cells

To merge the table cells, follow the below steps:

On the design canvas, select the required table cells by pressing the Shift key and 
left-mouse click.
Go to the Table tab and then select Merge Cells.
The cells are now merged.
To unmerge the cells, select the merged cell by pressing the Shift key and left-
mouse click. Then, go to the Table tab and select Unmerge Cells.

Adding a system field

To add a system field within control, follow the below steps:

On the design canvas, right-click the required control.
Select Add System Fields from the context menu. A list of supported system fields 
appears.
Select the required system fields from the list.

System field Description

Statement Date Returns the template generation date.

Current Date 
Time

Returns the current system date and time in dd-MM-yyyy hh:mm:ss 
format.

Current Date Returns the current system date in dd-MM-yy format.

Current Time Returns the current system time in hh:mm:ss format.

Current Time 
New

Returns the current system time in hh:mm:ss a zzz format.

Detail Row 
Number

Returns the row number of the current detail row in the table.

The system field gets added.

Adding a macro field

A macro field is a field in the linked dataset. You can add macro fields in the rich text 
control to show dynamic content. For example, you can insert macro fields to display 
an employee’s name, address, phone, designation, and other details in the email.
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To add a macro field, follow the below steps:

On the design canvas, right-click the required control.
Select Add Macro option from the list.
The Dataset Field dialog appears.
Select the table name from the dropdown list.
Select the column name from the dropdown list.
Click OK. 

Adding a hyperlink

Insert hyperlinks to link the text with a web page. 

To add a hyperlink, follow the below steps:

Select the required text within the control.
Right-click the selected text and then select Add Hyperlink option from the 
context menu.
The Add Hyperlink dialog appears.
Enter the name of the hyperlink. By default, the selected text appears in this field.
Then, specify the target link.
Click Save to confirm.

Adding table elements

You can enhance your table by adding various elements such as text, images, barcodes, 
data fields, aggregate data, and external content. Each element can be added by 
selecting the appropriate option from the dropdown menu in the table header bar.

Text

Add formatted text to your table cells for better presentation.

To add text to the table, follow these steps:

On the design canvas, place the cursor on the required table cell.
Go to the Table tab, and from the More Options dropdown, select Text.
Click the required cell. The Text Properties dialog appears with the following 
options:
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Property Description

Content

White space to write the text with the following options to 
edit the text:

Text Rotation 
Select the text rotation angle from the dropdown (0, 90, 
180, 270).

Attributes

Apply Indentation —  Checkbox to apply indentation.
Running Direction —  Checkbox to set text running 
direction from right to left.
 

Click Save.

Image

Add images to your table cells to visually represent data or enhance the appearance of 
your table.

To add an image to the table, follow these steps:

On the design canvas, place the cursor on the required table cell.
Go to the Table tab, and from the More Options dropdown, select Image.
Click the required cell. The Image Properties dialog appears with options to 
configure the image settings:
 

Font — Select the font type.●

Font Size — Select the font size.●

Bold — Make the text bold.●

Italics — Italicize the text.●

Underline — Underline the text.●

Font Color — Choose the font color.●

Background Color — Choose the background color.●
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Property Description

Image Source

Add an image using any of the following options: 

Preview It displays the preview of the added image.

Click Add.

Barcode

Insert barcodes into your table cells to include scannable information.

To add a barcode to the table, follow these steps:

On the design canvas, place the cursor on the required table cell.
Go to the Table tab, and from the More Options dropdown, select Barcode.
Click the required cell. The Barcode Properties dialog appears with options to 
configure the barcode settings. To configure the Barcode, see Barcode

Data field

Add data fields to your table cells to dynamically display data from your dataset.

To add a data field to the table, follow these steps:

On the design canvas, place the cursor on the required table cell.
Go to the Table tab, and from the More Options dropdown, select Data Field.
Click the required cell. The Data Field Properties dialog appears with the following 
options:

Property Description

Table Select the dataset table from the dropdown menu.

Column Select the dataset column from the dropdown menu.

Browse File — Select this option to add an image 
from your local system. 

●

Input URL — Select this option to add an image 
using a valid URL. The supported image formats 
are .jpeg, and .jpg.

●

The image URL must be accessible to the 
application server. 

●

The image URL must end with a "." followed by its 
file extension.  

●
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Property Description

Attributes

Click Add.

Aggregate data

Include aggregate data such as sums or averages in your table cells.

To add aggregate data to the table, follow these steps:

On the design canvas, place the cursor on the required table cell.
Go to the Table tab, and from the More Options dropdown, select Aggregate 
Data.
Click the required cell. The Aggregate Data Properties dialog appears with the 
following options:

Property Description

Aggregate Function
Select an aggregate function from the dropdown (Sum, 
Average, Minimum, Maximum, Count, First Entry, Last 
Entry)

DB Fields Select the database fields from the dropdown menu.

Decimal Enter the number of decimal places

Attributes

Comma Separator
Toggle to enable comma separation. When enabled, the 
following option appears

Number Format
Select the number format (International or Indian) using 
the radio button.

Click Add.

Running Direction — Checkbox to set text running 
direction from right to left.

●

Regional Language —  Checkbox to enable regional 
language support.

●

Enable HTML Content — Checkbox to enable HTML 
content

●

Convert to Words — Checkbox to convert numbers 
to words.

●

Use() for Negative —  Checkbox to use parentheses 
for negative values.

●
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External content

Embed external content into your table cells to enhance the information provided.

To add external content to the table, follow these steps:

On the design canvas, place the cursor on the required table cell.
Go to the Table tab, and from the More Options dropdown, select External 
Content.
Click the required cell. The External Content Properties dialog appears with the 
following options:

Property Description

Content Type Shows external content.

Type Select the content type from the dropdown (RTF, HTML).

Label Name Select the label name for the external content.

Click Add.

Related topic(s)
Defining and managing rules ●

Arithmetic expression●
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Image

Use the Image control to embed an image into the Letter template.

To add image, go to the Insert tab. Select the Image control from the Controls toolbar 
and click anywhere in the design canvas. An Add Image dialog appears where you can 
configure its related properties. This topic provides details about the  properties and 
various operations you can apply to an Image control:

Configuring image properties

You can configure the image properties in the Add Image dialog.

Property Description

Image Source

Add an image using any of the following options: 

Preview It displays the preview of the added image.

Proxy Setting 
(Optional)

It allows you to enable or disable the proxy settings for the server. Turn the 
toggle on to enable the proxy settings and then enter a valid server IP 
address and port describing the image location.

Configuring image properties●

Setting dimensions●

Adding a hyperlink●

Adding a dynamic content●

Enabling image tracking●

Browse File — Select this option to add an image from your local 
system. 

●

Image URL — Select this option to add an image using a valid URL. 
The supported image formats are .jpeg, and .jpg.

●

The image URL must be accessible to the application server. ●

The image URL must end with a "." followed by its file extension.  ●
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Setting dimensions

To set image dimensions, follow the below steps:

On the design canvas, right-click the required image.
Select Set Element Dimension from the context menu.
The Set Dimensions dialog appears.
Enable the Lock Aspect Ratio toggle to maintain the aspect ratio of the image.
Specify the height and width of the image in pixels.

The width and height of the image must be in the range of 20 to 1009 pixels. 

Click Save. 

Adding a hyperlink

Add links to an image to provide additional information.

To add a hyperlink to an image, follow the below steps:

On the design canvas, right-click the image.
Select Add Hyperlink from the context menu.
The Add Hyperlink dialog appears.
Select the Use Hyperlink in HTML Output checkbox to activate the link specified 
in the Target field.
Enter the target URL for the image, which is an anchor link to another web page. 
On clicking the image during the preview, you get directed to the required link. 
Click Save.
The hyperlink is added to the image. You can modify the added hyperlink by right-
clicking the image and selecting Edit Hyperlink from the context menu. 

Adding dynamic content

OmniOMS Communication Designer allows you to define dynamic content images. 
These images are useful while defining conditional logic within a decision table. For 
more information, see Defining a decision table.

To use the image name as dynamic content in the template, follow the below steps:

On the design canvas, right-click the Image control.
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Select Add Dynamic content from the context menu.
The Add Dynamic content dialog appears.
In the Display Name field, enter the image name.
Click Add.
The dynamic content gets added.

Once the image name gets added, you can use it as dynamic content. If you want to 
remove the dynamic content from the Image control, right-click the Image control and 
select Remove Dynamic Content from the context menu. 

Enabling image tracking

Enable the image tracking feature to keep track of users who accessed the image. To 
enable the feature, right-click the Image control on the design canvas and then select 
Enable tracking from the context menu. The image tracking gets enabled.

You can also disable the image tracking by right-clicking the Image control and 
selecting Disable Tracking from the context menu.

Related topic(s)

Charts

You can enhance your templates by adding various types of charts to visualize data 
effectively. This feature allows you to insert and configure charts directly within the 
design canvas.

To add a chart, go to the Insert tab. Select the Charts control from the Controls toolbar 
and click anywhere in the design canvas. A Charts Properties dialog appears where you 
can configure its related properties. The Charts Properties dialog consists of the 
following sections:

Selecting Chart Type

On the left pane, you can select the chart type from the following options:

Defining and managing rules●

Defining decision table ●

Column●
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Previewing the Chart

The Preview section shows how your chart looks with the current settings. This helps 
you adjust configurations in real time to meet your design needs. After selecting your 
chart type and configuring its properties in the Sourcing, Basic, and Advanced tabs, 
navigate to the Preview section to see the chart based on the current configurations.

Configuring chart properties

On the right pane, there are following tabs:

Data source tab

Configure the data sources for the chart axes. The tab consists of the following options:

Field Description
 X-axis source Allows you to select the data source for the X-axis of the chart.

 Y-axis source Allows you to select the data source for the Y-axis of the chart. For adding 
Y-axis, see Adding Series.

Adding series

To add series in the chart, perform the following steps:

On the source tab, click +Add Series. The Add Series dialog appears with the 
following options:

Column Range●

Bar●

Area●

Line●

Line & Column●

Donut●

Semi Donut●

Pie●

Scatter●

Cylinder●

Data Source●

Basic●

Advanced●
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2.

Field Description

Series Name Allows you to set the name of the series.

Source Name Allows you to select the data source for the series.

Min Value
Allows you to set the minimum value for the series. This option is available 
only in column range charts.

Max Value
Allows you to set the maximum value for the series. This option is available 
only in column range charts.

X-Axis Value
Allows you to set the X-axis value for the series. This option is available only 
in scatter charts.

Y-Axis Value
Allows you to set the Y-axis value for the series. This option is available only 
in scatter charts.

Color Allows you to set the color of the series.

Enable Marker
Allows you to enable markers for the series. This toggle button, when 
turned on, reveals four additional options. It is available in line charts and 
line & column charts. In scatter charts, it is enabled by default.

Symbol Type Allows you to select the symbol type for the markers.

Line Width Allows you to set the width of the line in the series.

Line Color Allows you to set the color of the line in the series.

Fill Color Allows you to set the fill color of the markers.

Click Add to add the series to the chart.
 

Basic tab

Set the fundamental properties and appearance of the chart. The tab consist of the 
following options:

Field Description

Title Allows you to set the main title of the chart.

Subtitle Allows you to set a subtitle for the chart.

X-axis title
Allows you to set a title for the X-axis. This option is not available for donut, semi 
donut, and pie charts.
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Field Description

Y-axis title
Allows you to set a title for the Y-axis. This option is not available for donut, semi 
donut, and pie charts.

Primary Title
This option is only available for the line & column chart, allowing you to set a title 
for the primary Y-axis.

Sec. Title
This option is only available for the line & column chart, allowing you to set a title 
for the secondary Y-axis.

Show Legend

Allows you to display the legend on the chart. The following are the options 
available:

Data Labels Allows you to enable or disable data labels on the chart.

3D Options
Allows you to enable or disable 3D effects for the chart. This option is available 
only for column, donut, pie, and cylinder charts.

Stacking
Allows you to enable or disable data stacking in the chart. This option is available 
for column, bar, and cylinder charts.

Zones
Allows you to configure specific zones in the chart. This option is not available for 
column range, pie, donut, and semi donut charts.

Advanced tab

Customize detailed properties for text, axes, legend, chart area, and plot options. The 
advanced tab provides more granular control over the chart's appearance and 
behavior, categorized into:

Horizontal — Displays the legend horizontally.●

Vertical — Displays the legend vertically.●

Proximate — Displays the legend in close proximity to the data.●

Text Properties — Configure font style, size, and color for the chart text.●

Axis Properties — Configure the appearance and behavior of the X and Y axes.●

Legend Properties — Customize the appearance and position of the chart 
legend.

●

Chart Area — Configure the background color, border, and other properties of 
the chart area.

●

Plot Options — Customize the data plot area, including line styles, marker styles, 
and other plot-specific options.

●

Data Labels — Configure the appearance and position of data labels within the 
chart.

●
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Text properties

The Text properties consist of three sections: Title, Subtitle, and Base Font.

Title

Field Description

Font Name Allows you to select the font for the chart title.

Font Color Allows you to choose the color of the title text.

Font Style
Allows you to apply styles such as bold, italic, and underline to the title 
text.

X-position Allows you to set the horizontal position of the title.

Y-position Allows you to set the vertical position of the title.

Margin Allows you to set the margin around the title in pixels.

Use Floating Allows you to enable or disable the floating position of the title.

Subtitle

Field Description

Font Name Allows you to select the font for the chart subtitle.

Font Color Allows you to choose the color of the subtitle text.

Font Style
Allows you to apply styles such as bold, italic, and underline to the subtitle 
text.

X-position Allows you to set the horizontal position of the title.

Y-position Allows you to set the vertical position of the title.

Use Floating
Checkbox: Allows you to enable or disable the floating position of the 
subtitle.

3D options — Add depth and a three-dimensional perspective to the chart, 
available for specific chart types.

●
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Base font

Field Description

Use same font for Axis, 
Legends & Data Labels

Allows you to apply the same font settings for the axis labels, 
legends, and data labels.

Font Name
Allows you to select the base font for axis labels, legends, and 
data labels.

Font Color
Allows you to choose the base color for the text of axis labels, 
legends, and data labels.

Font Style
Allows you to apply styles such as bold, italic, and underline to 
the base text of axis labels, legends, and data labels.

Axis properties

The Axis Properties section allows you to customize the X-Axis and Y-Axis of your chart. 
This option is not available for Donut, Semi Donut, and Pie charts.

X-Axis

Field Description

Font Name Allows you to select the font for the X-Axis labels.

Font Color Allows you to choose the color of the X-Axis labels.

Font Style
Allows you to apply styles such as bold, italic, and underline to the X-Axis 
labels.

Lower Bound Allows you to set the lower bound value for the X-Axis.

Upper Bound Allows you to set the upper bound value for the X-Axis.

Tick Position Allows you to specify the position of the ticks on the X-Axis.

Tick Interval Allows you to set the interval between the ticks on the X-Axis.

Format Value Allows you to format the values displayed on the X-Axis.

Title Rotation Allows you to rotate the X-Axis title.

Title Margin Allows you to set the margin around the X-Axis title.

Label Rotation Allows you to rotate the labels on the X-Axis.

Label Color Allows you to choose the color of the X-Axis labels.
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Y-Axis

The Y-Axis properties have the same fields and descriptions as the X-Axis.

For Line and Column charts, additional features include Y-Axis (Primary) and Y-Axis (Secondary) with the same 
fields and descriptions as listed above.

Legend properties

The Legend Properties section allows you to customize the title, text, and symbol of 
your chart's legend. It consists of three sections: Title, Text, and Symbol.

Title

Field Description

Legend Title Allows you to specify a title for the legend.

Font Name Allows you to select the font for the legend title.

Font Color Allows you to choose the color of the legend title.

Font Style
Allows you to apply styles such as bold, italic, and underline to the legend 
title.

Horizontal Align 
Option

Allows you to align the legend title horizontally.

Vertical Align Option Allows you to align the legend title vertically.

X-position Allows you to set the horizontal position of the legend title.

Y-position Allows you to set the vertical position of the legend title.

Use floating
Enables the legend title to float over the chart, allowing for flexible 
placement.

Text

Field Description

Font Name Allows you to select the font for the legend text.

Font Color Allows you to choose the color of the legend text.

Font Style
Allows you to apply styles such as bold, italic, and underline to the legend 
text.

Padding Allows you to set the padding around the legend text.
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Field Description

Margin Top Allows you to set the top margin around the legend text.

Margin Bottom Allows you to set the bottom margin around the legend text.

Symbol

Field Description

Square Symbol
Allows you to enable or disable the use of square symbols in the legend. 
This option is not available for Line and Line & Column charts.

Height Allows you to set the height of the legend symbols.

Width Allows you to set the width of the legend symbols.

Radius
Allows you to set the corner radius of the legend symbols, making them 
rounded if needed.

Padding Allows you to set the padding around the legend symbols.

Chart area

The Chart area section allows you to customize the appearance and layout of the 
chart's plotting area and overall chart border.

Field Description

Plot Border Width
Allows you to set the width of the plot border. This option is not available 
for Donut, Semi Donut, and Pie charts.

Plot Border Color Allows you to choose the color of the plot border.

Area Color Allows you to set the color of the chart's plotting area.

Invert Axis
Allows you to invert the axis. This option is not available for Bar, Donut, 
Semi Donut, Pie, and Scatter charts.

Chart Border

Width Allows you to set the width of the chart border.

Radius
Allows you to set the corner radius of the chart border, making it rounded if 
needed.

Border Color Allows you to choose the color of the chart border.

Chart Padding
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Field Description

Enable Padding Enables padding around the chart.

Left Allows you to set the left padding of the chart.

Right Allows you to set the right padding of the chart.

Top Allows you to set the top padding of the chart.

Bottom Allows you to set the bottom padding of the chart.

Data labels

The Data Labels section allows you to customize the appearance and position of the 
labels displayed on the chart's data points.

Field Description

Font Name Allows you to set the font name for the data labels.

Font Color Allows you to choose the color of the data labels' text.

Font Style
Allows you to apply styles such as bold, italic, and underline for the data 
labels.

Horizontal Allows you to set the horizontal alignment of the data labels.

Vertical Allows you to set the vertical alignment of the data labels.

Border Width Allows you to set the width of the border around the data labels.

Border Radius
Allows you to set the radius of the border corners, making them rounded 
if needed.

Border Color Allows you to choose the color of the border around the data labels.

X-Position Allows you to set the X-axis position of the data labels.

Y-Position Allows you to set the Y-axis position of the data labels.

Distance
Allows you to set the distance of the data labels from the data points. This 
option is only available for Donut, Pie, and Semi Donut charts.

3D options

The 3D Options section allows you to add a three-dimensional effect to your charts. This 
option is available for Column Chart, Donut Chart, Pie Chart, and Cylinder Chart only.
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Field Description

Alpha Angle
Allows you to set the alpha angle for the 3D effect, which adjusts the tilt of 
the chart.

Beta Angle
Allows you to set the beta angle for the 3D effect, which adjusts the rotation 
of the chart.

Chart Depth
Allows you to set the depth of the chart, giving it a 3D appearance. This 
option is only available for Column Chart and Cylinder Chart.

View Distance
Allows you to set the distance from which the chart is viewed, affecting the 
perspective of the 3D effect. This option is only available for Column Chart 
and Cylinder Chart.

Plot option

The Plot Options section allows you to customize the appearance and behavior of your 
charts. This option is not available for the Area Chart.

Field Description

Bar Width
Allows you to set the width of the bars. Available in Column Chart, Bar Chart, 
Line & Column Chart, and Cylinder Chart.

Border Width Allows you to set the width of the border around the plot.

Border Color
Allows you to set the color of the border. This option is not available for Line 
Chart.

Line Width
Allows you to set the width of the lines. Available only for Line Chart and Line 
& Column Chart.

Center Start
Allows you to set the starting point of the center for Donut Chart, Semi Donut 
Chart, and Pie Chart.

Center End
Allows you to set the ending point of the center for Donut Chart, Semi Donut 
Chart, and Pie Chart.

Chart Size
Allows you to set the overall size of the chart. Available for Donut Chart, Semi 
Donut Chart, and Pie Chart.

Inner Size
Allows you to set the inner size of the chart. Available for Donut Chart and 
Semi Donut Chart.

Depth
Allows you to set the depth of the chart, giving it a 3D effect. This option is 
only available for Pie Chart.



     Adding controls

Version: 12.0 NewgenONE OmniOMS Communication Designer User Guide 121            

Shape

OmniOMS Communication Designer allows you to insert shapes in your email 
template, such as rectangles, lines, and circles. You can further configure the properties 
to enhance their appearance.

To add shape, go to the Insert tab. From the Controls toolbar, click the Shape control 
and then select the required shape type from the list. Click anywhere in the design 
canvas to insert the chosen shape. This topic provides details about the  properties and 
various operations you can apply to a Shape control:

Configuring rectangle properties

To set properties for a rectangle, right-click the rectangle and then select Properties 
from the context menu to open the Rectangle Properties dialog. 

Property Description

 Border width
Specify the border width of the rectangle.  

The border width must lie in the range of 1 to 6 pixels. 

 Border color 
(Optional)

Specify the border color of the rectangle using the color palette or enter the 
color name using a hexadecimal value. For example, #ffffff.

Configuring line properties

To set properties for a line, right-click the line on the design canvas and then select 
Properties from the context menu to open the Properties dialog.

Property Description

Left Start Enter the starting point of the line from the left of the page.

Top Start Enter the starting point of the line from the top of the page. 

Configuring rectangle properties●

Configuring line properties●

Configuring circle properties●

Setting padding●
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1.
2.

3.
4.
5.

Property Description

Left End Enter the ending point of the line from the left of the page.

Top End Enter the ending point of the line from the top of the page.

Border Width
Specify the border width of the line.

The border width must lie in the range of 1 to 6 pixels.  

Border Color 
(Optional)

Specify the border color of the rectangle using the color palette or enter the 
color name with a hexadecimal value. For example, #ffffff.

Configuring circle properties

To set properties for a circle, right-click the circle on the design canvas and then select 
Properties from the context menu to open the Properties dialog.

Property Description

 Top Specify the margin area on the top of the circle.

 Left Specify the margin area on the left of the circle.

Boder Width
Specify the border width of the circle.

The border width must lie in the range of 1 to 6 pixels. 

Border Color 
(Optional)

Specify the border color of the rectangle using the color palette or enter the 
color name with a hexadecimal value. For example, #ffffff.

Circle Radius
Specify the radius of the circle.

The circle radius cannot be greater than the design canvas. 

Setting padding

To set padding for a rectangle, follow the below steps:

On the design canvas, right-click the required rectangle.
Select Set Padding from the context menu.
The Set Padding dialog appears.
Specify the top padding for the rectangle's top border in pixels. 
Specify the left padding for the rectangle's left border in pixels.
Click Set to save.
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1.

2.

3.
4.
5.
6.

7.

Arithmetic expression

OmniOMS allows you to define and use arithmetic expressions within a letter template. 
An arithmetic expression is a combination of numbers, arithmetic operators, such as 
addition, subtraction, division, and multiplication, and parenthesis. You can use this 
feature to calculate numeric data in your template. For example, you can create a 
simple arithmetic expression to calculate the simple interest on a fixed deposit.

Simple Interest = (Principle*Rate *Time)/100 

To add text, go to the Insert tab. Select the Arithmetic Expression control from the 
Controls toolbar and click anywhere in the design canvas. This topic provides details 
about the properties and various operations you can apply to an Arithmetic Expression 
control:

Creating an arithmetic expression

In the Arithmetic Expression Library dialog, click New Arithmetic Expression.
A New Arithmetic Expression dialog appears consisting of two sections — Data 
Fields and Expressions. In the Data Fields section, you can view the linked dataset, 
and added expressions appear under the Expressions section. 
From the Data Fields section, select the required field. The dataset field gets 
added in the Expression area.
Select the operator you want to use in the expression.
(Optional) Repeat steps 2 to 3 to create an expression. 
Enter the name of the expression. 
Specify the number of decimal places for the expression resultant value. 
You can set up to six decimal points for the resultant value.
Specify the data format for the expression resultant value. It can be any of the 
following:

Creating an arithmetic expression●

Adding an arithmetic expression●

Setting padding●

Adding a system field●

Adding a macro field●

Adding a hyperlink●
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8.

1.

2.

3.

4.

Click Add.
The expression gets added to the Arithmetic Expression Library.

Adding an arithmetic expression

You can add arithmetic expressions by right-clicking the control and selecting Add 
Arithmetic Expression from the context menu. The Arithmetic Expression Library 
dialog appears.

You can add arithmetic expressions to rich text, paragraph, table, and arithmetic expression controls.  

To add an arithmetic expression, follow the below steps:

From the Expression List, select the required expression.
On selecting the expression, the expression details are automatically filled with 
values.
To specify an action or message to display when a calculation error occurs, click 
the edit icon next to the Error action for all expressions field.
The Error Action dialog appears.
Select a suitable action name from the dropdown list. It can be any of the 
following:

Click Save to confirm.

International — The resultant value is rendered in the 999, 999, 999, 999 
format.

●

Indian — The resultant value is rendered in the 99, 99, 99, 999 format.●

Convert to Words — The resultant value is rendered in words.●

Display Blank — Select this option to display blank space in case of a 
calculation error.

●

Do not generate template — Select this option to avoid template 
generation in case of a calculation error.

●

Custom Message — Select this option to display a custom message in case 
of a calculation error.
Enter the message in the Custom Message area. 

The Custom Message area is disabled in the case of Display Blank and Do not generate template 
options. 

●
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Setting padding  

To set padding for the control, follow the below steps:

On the design canvas, right-click the required control.
Select Set Padding from the context menu.
The Set Padding dialog appears.
Specify the top padding for the control's top border in pixels. 
Specify the left padding for the control left border in pixels.
Click Set to save.

Adding a system field

There are eight system fields in OmniOMS Communication Designer that are 
statement date, current date and time, current date, current time, current time new, 
current page, total pages, and total pages in words.

To add a system field within control, follow the below steps:

On the design canvas, right-click the required control.
Select Add System Fields from the context menu.
A list of supported system fields appears.
Select the required system fields from the list.

System field Description

Statement Date Returns the template generation date.

Current Date Time
Returns the current system date and time in dd-MM-yyyy 
hh:mm:ss format.

Current Date Returns the current system date in dd-MM-yy format.

Current Time Returns the current system time in hh:mm:ss format.

Current Time New Returns the current system time in hh:mm:ss a zzz format.

Current Page Returns the current page of the letter template.

Total Pages Return the total number of pages in the letter template.

Total Pages in words Return the total number of pages in the letter template in words.

The system field gets added.
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Adding a macro field

A macro field is a field in the linked dataset. You can add macro fields in the rich text 
control to show dynamic content. For example, you can insert macro fields to display 
an employee’s name, address, phone, designation, and other details in the email.

To add a macro field, follow the below steps:

On the design canvas, right-click the required control.
Select Add Macro option from the list.
The Dataset Field dialog appears.
Select the table name from the dropdown list.
Select the column name from the dropdown list.
Click OK. 

Adding a hyperlink

Insert hyperlinks to link the text with a web page. 

To add a hyperlink, follow the below steps:

Select the required text within the control.
Right-click the selected text and then select Add Hyperlink option from the 
context menu.
The Add Hyperlink dialog appears.
Enter the name of the hyperlink. By default, the selected text appears in this field.
Then, specify the target link.
Click Save to confirm. 

Related topic(s)
Defining and managing rules 
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Barcode

Add barcodes to your letter template for data tracking and storing purposes. OmniOMS 
Communication Designer offers various 1-D and 2-D barcode styles to use. You can 
store static text, system fields, dataset fields, or any combination of these three in the 
barcode.

To add a barcode, go to the Insert tab. From the Controls toolbar, click the Barcode 
control and then click anywhere in the design canvas to open the Barcode Properties 
dialog. This topic provides details about the properties and various operations you can 
apply to a Barcode control: 

Configuring 1-D barcode properties

To set properties for a 1-D barcode, right-click the barcode and then select Properties 
from the context menu to open the Barcode Properties dialog.

Property Description

Barcode Type Select the type of barcode. In this case, select 1 D barcode. 

Encoding

Select the barcode encoding type. It can be Codabar, Code128, EAN-13, 
EAN-8, Interleaved 2 of 5, UPC-A, UPC-E, and USS 39.  

Barcode does not generate in case you select incorrect symbology. 

Orientation
Select the orientation of the barcode. It can be set to portrait or 
landscape. 
By default, the orientation for the 1-D barcode type is set to Landscape. 

Max. Length

The maximum length indicates the length of the barcode.

This field is uneditable and picks the value based on the length defined for the 
added section types. 

Configuring 1-D barcode properties●

Configuring 2-D barcode properties●

Changing content sequence●
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Property Description

Attributes

Select the required barcode attributes:

Printing Type

Select the printing type. It can be either of the following:

Section Details

Select the data you want to store in the barcode. It can be any of the 
following:

Select the Display Text Label checkbox to display the text along 
with the barcode.

●

Select the Append Page Number to append the page number 
with the barcode text.

●

Simplex — Select this option to print data only on a single side of 
the page.

●

Duplex — Select this option to print data on both sides of the 
page.

●

Static Text — Select this option to store static text in the barcode. 

The Text Length field in case of the static text remains 0. 

●

Data Field — Select this option to store data field values in the 
barcode.
Select the required table and column name from the Table Name 
and Column Name dropdowns. Then, specify the starting digit 
and maximum length for the data field to use for the barcode.

●

System Field — Select the required system field to store in the 
barcode. It can be any of the following:

●

SYSTEM.STATEMENT_DATE — It indicates the template 
generation date.

o

SYSTEM.STATEMENT_SEP — It indicates the different values 
you want to store in the barcode depending on its position 
on the first page, last page, single page, or any page 
between the first and last ones. This is useful in case you 
have dynamic content to display in the PDFs, due to which 
barcode position may vary for each user in the PDF. By 
using this option, you can define the custom logic for the 
barcode. 

o

SYSTEM.PDFPAGENO — It indicates the current PDF page 
number. You can also specify the maximum digits for the 
PDF page number. For example, if the page number is 2 and 
the Digits field is set to 4, then 0002 gets displayed in the 
barcode.

o
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The new password appears under the Added Content Details displaying the content 
and characters of the password. The number of password characters is automatically 
fetched by the system.

Configuring 2-D barcode properties

To set properties for a 2-D barcode, right-click the barcode and then select Properties 
from the context menu to open the Barcode Properties dialog.

Property Description

Barcode Type Select the type of barcode. In this case, select 2 D barcode. 

Type
Select the barcode encoding type. It can be QR CODE and PDF417.
Barcode does not generate in case you selected incorrect symbology.

Orientation
Select the orientation of the barcode. It is set to Portrait, by default and 
the value cannot be changed.

Max. Length

The maximum length indicates the length of the barcode.

This field is uneditable and picks the value based on the length defined for the 
added section types. 

Printing Type

Select the printing type. It can be either of the following:

Append Hashcode
Select the Append Hashcode checkbox to enable encryption of the 
barcode. Enter the text to use for the Hashcode generation.

Simplex — Select this option to print data only on a single side of 
the page.

●

Duplex — Select this option to print data on both sides of the page.●
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Property Description

Section Details

Select the data you want to store in the barcode. It can be any of the 
following:

The new password appears under the Added Content Details displaying the content 
and characters of the password. The number of password characters is automatically 
fetched by the system.

Changing content sequence

OmniOMS Communication Designer enables you to change the sequence of the 
barcode contents. This can be achieved by hovering over the required content and 
then using the Up and Down arrows, respectively.

Static Text — Select this option to store static text in the barcode. 

This field is uneditable and picks the value based on the length defined for 
the added section types. 

●

Data Field — Select this option to store data field values in the 
barcode.
Select the required table and column name from the Table Name 
and Column Name dropdowns. Then, specify the starting digit and 
maximum length for the data field to use for the barcode.

●

System Field — Select the required system field to store in the 
barcode. It can be any of the following:

●

SYSTEM.STATEMENT_DATE — It indicates the template 
generation date.

o

SYSTEM.STATEMENT_SEPARATOR — It indicates the 
different values you want to store in the barcode depending 
on its position on the first page, last page, single page, or any 
page between the first and last ones. This is useful in case you 
have dynamic content to display in the PDFs, due to which 
barcode position may vary for each user in the PDF. By using 
this option, you can define the custom logic for the barcode. 

o

SYSTEM.PDFPAGENO — It indicates the current PDF page 
number. You can also specify the maximum digits for the PDF 
page number. For example, if the page number is 2 and the 
Digits field is set to 4, then 0002 gets displayed in the 
barcode.

o
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Password

OmniOMS provides you with a way to secure your PDFs with a password. This can be 
achieved by using the Password control. This control enables you to apply a master 
password as well as a user-specific password based on your requirements. The master 
password can be used by high-level authorities to access the PDFs, however, the user 
password is specific to users who access the PDF.

In the Communication Designer, you can create a password using static text, system 
field, dataset field, or a combination of all three. Apart from this, you can also restrict the 
users from printing, applying encryption, copying content, modifying PDF content, and 
others. 

To add a password, go to the Insert tab. From the Controls toolbar, click the Password 
control and click anywhere in the design canvas to open the Password Properties 
dialog. This topic provides details about the properties and various operations you can 
apply to Password control: 

Creating a master password

You can create a master password in the Master Password tab of the Password 
Properties dialog. 

To access a master password, you must create a user password. 

A default password with the value newgen123# is already added. You can see the default password 
under the Added Content Details. 

●

A password can have uppercase letters (A - Z), lowercase letters (a - z), numbers (1 - 9), spaces, and 
special characters.   

●

Creating a master password●

Creating a user password●

Changing content serial●
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Property Description

 Source Name

Select a suitable type for the source from the dropdown. It indicates the 
type of password you want to create.

 Content

Strength
Select the encryption algorithm for encrypting and decrypting 
passwords. It can be 40-Bits (RC4), 128-Bits (RC4), and 128-Bits (AES).

Padding Type

Select the padding type for the password. A padding character fills the 
empty spaces in the password with a space or special character like an 
asterisk or hash. 

 

This field is disabled in case you are creating a static password. 

Start Value

Specify the starting index for the report field. The starting value starts 
from 1.

This field is disabled in case you are creating a static password. 

No. of Characters
Specify the length of the password. 

This field is disabled in case you are creating a static password. 

Select Static Text to specify a static value for the password. ●

Select Report Field to create user-specific passwords. These 
passwords vary depending on the users. 

●

In case you selected static text as the source name. Then enter the 
static content for the password. 

●

In case you selected Report Field as the source name. Then, select 
the required report field you want to use for creating the password. 

The Content dropdown only shows the fields added to the template or 
configured in the Template Properties dialog. 

●

Post Padding with * — Select this option to fill the empty spaces in 
the password with an asterisk.  

●

Post Padding with # — Select this option to fill the empty spaces in 
the password with a hash.  

●

Post Padding with space — Select this option to fill the empty 
spaces in the password with space.

●

No padding — Select this option to avoid the use of padding 
characters in the password.

●
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The new password appears under the Added Content Details displaying the content 
and characters of the password. The number of password characters is automatically 
fetched by the system. 

Creating a user password

You can create a master password in the User Password tab of the Password Properties 
dialog. 

Property Description

Description
Specify the password policy description. This description is only 
available at the time of password creation.

 Source Name

Select a suitable type for the source from the dropdown. It indicates 
the type of password you want to create.

 Content

Function Select the data type of the report field. 

Padding Type

Select the padding type for the password. A padding character fills 
the empty spaces in the password with a space or special character 
like an asterisk or hash. 

This field is disabled in case you are creating a static password.

Select Static Text to specify a static value for the password. ●

Select Report Field to create user-specific passwords. These 
passwords vary depending on the users. 

●

In case you selected Static Text as the source name. Then enter 
the static content for the password. 

●

In case you selected Report Field as the source name. Then, 
select the required report field you want to use for creating the 
password. 

The Content dropdown only shows the fields added to the template 
or configured in the Template Properties dialog. 

●

Post Padding with * — Select this option to fill the empty 
spaces in the password with an asterisk.  

●

Post Padding with # — Select this option to fill the empty 
spaces in the password with a hash.  

●

Post Padding with space — Select this option to fill the empty 
spaces in the password with space.

●

No padding — Select this option to avoid the use of padding 
characters in the password.

●



     Adding controls

Version: 12.0 NewgenONE OmniOMS Communication Designer User Guide 134            

Property Description

Start Value

Specify the starting index for the report field. The starting value 
starts from 1.

This field is disabled in case you are creating a static password. 

No. of Characters
Specify the length of the password. 

This field is disabled in case you are creating a static password.

The new password appears under the Added Content Details displaying the content 
and characters of the password. The number of password characters is automatically 
fetched by the system. 

Changing content sequence

OmniOMS Communication Designer enables you to change the sequence of the 
password contents. This can be achieved by hovering over the required content and 
then using the Up and Down arrows, respectively.
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1.

2.

3.

Digital signature

With OmniOMS Communication Designer, you can insert a digital signature to ensure 
the integrity and authenticity of the document using the Personal Information 
Exchange (PFX) file or Hardware Security Module (HSM).

There can only be one digital signature for a PDF page.   

To add a digital signature, go to the Insert tab. Select the Digital Signature control 
from the Controls toolbar and click anywhere in the design canvas to open the Digital 
Signature dialog. In the Digital Signature dialog that appears, select the required digital 
signature from the list.

The Digital Signature dialog displays a list of digital signatures that are uploaded to the 
Admin Workspace. Here, you can sort the signatures in ascending or descending order 
by clicking the up/down arrow next to the Digital Signature Name.

For more information on how to add a digital signature in Admin Console, refer to the 
OmniOMS Admin Workspace User Guide.

Furthermore, this topic explains how to configure the properties of the digital 
signature:

Configure digital signature properties

Configure the property of digital signature control to replace the existing signature 
added to the template with a new one. To do so, follow the below steps:

Right-click the Digital Signature control on the design canvas and then select 
Properties from the context menu.
The Digital Signature dialog appears. By default, the already added signature is 
selected in the list.
Select the required digital signature from the list to replace the current one in the 
template. You can also click the up/down arrow next to the Digital Signature 
Name to sort the list in ascending or descending order.
Click Save to confirm. 

Configuring digital signature properties●



     Adding controls

Version: 12.0 NewgenONE OmniOMS Communication Designer User Guide 136            

1.

2.

3.

4.

5.

Annexure configuration

Use the Annexure Configuration control to append the supplementary documents to 
your PDF attachments. You can append the supplementary documents at the 
beginning or end of the PDF attachment. Additionally, you can also define rules and 
associate them with the annexures based on your requirements.

To add an annexure, go to the Insert tab. Select the Annexure Configuration control 
from the Controls toolbar and click anywhere in the design canvas to open the 
Annexure Configuration dialog. This topic explains how to configure the settings for an 
annexure:

Configuring annexure settings

You can set the annexure properties in the Annexure Configuration dialog.

Under the Select Rule section, select the rule you want to associate with the 
annexure. By default, there is a rule that is true for all the cases. 
You can also click + New to define a new rule. For more details, see Creating rule.
Under the Select Annexure Items, select the required annexure from the 
dropdown list.

These annexures are added from the Admin Workspace. For more information, see NewgenONE 
OmniOMS Admin Workspace User Guide. 

Click Add.
The selected annexure now appears in the list.
Enable the Append from Start toggle to add the annexure at the beginning of the 
PDF.
Click Apply.
The added annexure now appears under the Associated Annexure(s) section.

Configuring annexure settings●

Changing annexure sequence●
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Changing annexure sequence

In case of multiple annexures, OmniOMS Communication Designer enables you to 
change the sequence of the added annexures. This can be achieved by hovering over 
the required content and then using the Up and Down arrows, respectively.  

Related topic(s)
Creating rule 
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1.

2.

3.

Watermark configuration

OmniOMS Communication Designer gives you the capability to apply watermarks to 
your letter template. Watermarks can be used to secure confidential information from 
being altered or stolen. You can specify the image and text to display as watermarks, 
and later associate them with rules. 

Watermarks are visible when you preview the template. 

To add a watermark, go to the Insert tab and select the Watermark 
Configuration control from the Controls toolbar. 

Applying an image watermark

To add an image watermark, follow the below steps:

On the Image tab, select any one of the following options for the image source:

Click Add.
The added watermark appears under the Watermark Image List section, and you 
can see the preview appear in the middle section of the dialog. 
Additionally, you can associate rules with the watermark by clicking Apply Rule. 
For more information, see Defining and managing rules.

To insert the image multiple times in the template, click Add again. The same image gets added to the 
template.   

To adjust the style and appearance of the watermark, specify the following 
properties in the right section of the dialog:

Applying an image watermark●

Applying a text watermark●

Browse File — Click the Browse icon  to upload an image from your local 
system. 

●

Input URL — Enter a valid image URL. The supported image formats 
are .jpeg, and .jpg.

●

The image URL must be accessible to the application server. ●

The image URL must end with a "." followed by its file extension. ●
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4.

1.
2.

3.

4.

Property Description

Top Offset Specify the top margin area (in pixels) for the watermark.

Left Offset Specify the left margin area (in pixels) for the watermark.

 Width Select the width of the watermark (in pixels) for the watermark. 

 Height
Specify the height of the watermark (in pixels) for the 
watermark. 

Fill Opacity
Specify the fill opacity of the watermark using the slider.

The opacity value must be in the range of 0 to 100 pixels. 

Stroke Opacity
Specify the stroke opacity of the watermark using the slider.

The opacity value must be in the range of 0 to 100 pixels. 

Orientation Set the orientation of the watermark in degrees.

Lock Aspect Ratio Click the Lock Aspect Ratio icon  to lock the aspect ratio of 
the watermark. 

Click Apply to save.

Applying a text watermark

To add a text watermark, follow the below steps:

In the Watermark Configuration dialog, go to the Text tab.
Specify the text content to display as a watermark.
You can also insert a macro field as a watermark by clicking the Add Macro 
 icon. In the Dataset Field dialog that appears, select the required table and its 
column. Click OK to confirm. 
Click Add.
The added watermark appears under the Watermark Image List section, and you 
can see the preview appear in the middle section of the dialog. Additionally, you 
can associate rules with the watermark by clicking Apply Rule. For more 
information, see Defining and managing rules.

To insert the text multiple times in the template, click Add again. 
The same text gets added to the template.  

In the right section of the dialog, you can adjust the style and appearance of the 
watermark.
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5.

Property Description

Position

Top Offset Specify the top margin area (in pixels) for the watermark.

Left Offset Specify the left margin area (in pixels) for the watermark.

Text Properties

Font Style Select the font style of the watermark text content.

Font Size Select the font size of the watermark text content.

Fore Color
Select the font color for the watermark text content using the color 
palette or enter the color name with RGB or hexadecimal values.

Back Color
Select the background color for the watermark text content using the 
color palette or enter the color name with RGB or hexadecimal values.

Appearance

 Width Select the width of the watermark (in pixels) for the watermark. 

 Height Specify the height of the watermark (in pixels) for the watermark. 

Fill Opacity
Specify the fill opacity of the watermark using the slider.

The opacity value must be in the range of 0 to 100 pixels.  

Stroke Opacity
Specify the stroke opacity of the watermark using the slider.

The opacity value must be in the range of 0 to 100 pixels. 

Orientation Set the orientation of the watermark in degrees.

Click Apply to save.

Related topic(s)
Defining and managing rules 
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Paragraph

User paragraph control in a letter template to display textual control in a structured 
way. To add a paragraph, go to the Insert tab. Select the Paragraph control from the 
Controls toolbar and click anywhere in the design canvas. The paragraph gets added. 
This topic provides details about the  properties and various operations you can apply 
to a Paragraph control:

Configuring paragraph properties

To set properties for a paragraph, right-click the paragraph on the design canvas and 
then select Properties from the context menu to open the Paragraph Properties 
dialog. 

Property Description

Name Specify the name of the paragraph. The default value is 'Clause: 1'.

Inherit Property Select the base paragraph to inherit the properties. 

Level
Select the numbering level to apply to the paragraph. For more 
information, see Creating a multilevel numbering.

Attribute

Select to enable the following attributes for the paragraph:

Configuring paragraph controls●

Setting padding●

Adding a system field●

Adding a macro field●

Adding a hyperlink●

Creating a multilevel numbering●

Adding dynamic text●

Editable —  Select this checkbox to make the paragraph editable in 
the Interactive Editor.

●

Removable — Select this checkbox to grant access to delete the 
paragraph in the Interactive Editor.

●

Skip Numbering — Select this checkbox to skip the numbering for 
the paragraph.
 

●
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1.
2.

3.
4.
5.

1.
2.

3.

Setting padding

To set padding for the Paragraph control, follow the below steps:

On the design canvas, right-click the Paragraph control.
Select Set Padding from the context menu.
The Set Padding dialog appears.
Specify the top padding for the control's top border in pixels. 
Specify the left padding for the control left border in pixels.
Click Set to save.

Adding a system field

There are eight system fields in OmniOMS Communication Designer that are 
statement date, current date and time, current date, current time, current time new, 
current page, total pages, and total pages in words.

To add system fields in a Paragraph control, follow the below steps:

On the design canvas, right-click the Paragraph control.
Select Add System Fields from the context menu. A list of supported system fields 
appears.
Select the required system fields from the list.

System field Description

Statement Date Indicates the template generation date.

Current Date Time
Returns the current system date and time in dd-MM-yyyy hh:mm:ss 
format.

Current Date Returns the current system date in dd-MM-yy format.

Current Time Returns the current system time in hh:mm:ss format.

Current Time New Returns the current system time in hh:mm:ss a zzz format.

Current Page Returns the current page of the letter template.

Total Pages Return the total number of pages in the letter template.

Total Pages in words Return the total number of pages in the letter template in words.

The system field gets added.
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1.
2.

3.
4.
5.

1.
2.

3.
4.
5.

1.

Adding a macro field

A macro field is a field in the linked dataset. You can add macro fields in the paragraph 
control to show dynamic content. For example, you can insert macro fields to display 
an employee’s name, address, phone, designation, and other details in the email.

To add a macro field, follow the below steps:

On the design canvas, right-click the Paragraph control.
Select Add Macro option from the context menu.
The Dataset Field dialog appears.
Select the table name from the dropdown list.
Select the column name from the dropdown list.
Click OK. 

Adding a hyperlink

Insert hyperlinks to link the text with a web page. 

To add a hyperlink, follow the below steps:

In the Paragraph control, select the required text.
Right-click the selected text and then select Add Hyperlink option from the 
context menu.
The Add Hyperlink dialog appears.
Enter the name of the hyperlink. By default, the selected text appears in this field.
Then, specify the target link.
Click Save to confirm. 

Creating a multilevel numbering

OmniOMS Communication Designer allows you to apply multilevel numbering on the 
Paragraph controls.

To define a multilevel list, follow the below steps:

Go to the Home tab and click More Options  .

You can define listing levels up to four levels.  ●

These multilevel numberings created are shown at the cabinet levels.●

A default multilevel list is already applied to the Paragraph controls. ●
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2.

3.
4.

5.
6.

1.
2.

3.

4.
5.
6.
7.

Select Number Sequence Library from the list. 
The Number Sequencing dialog appears.
Click + New List to define a new list.
Under the List Details section, specify the style of the list. It can be any of the 
following:

Specify the indentation for the listing level (in inches).
Click Add List.
The new list appears under the Multilevel List section.
You can now select the required list from the dialog to apply to the Paragraph 
controls in the template. The chosen numbering gets applied on the basis of the 
top-to-bottom approach. To change the level of the numbering for a paragraph, 
set the Level property in the Properties dialog. For more information, see 
Configuring paragraph properties.

Adding dynamic text

OmniOMS Communication Designer allows you to create a section in an editable 
paragraph as non-editable that reflects in the Interactive Editor. 

To add a dynamic text, perform the following steps:

On the design canvas, right-click the Paragraph control. 
Select Dynamic Text from the context menu. 

This option is only available if the Editable attribute for the Paragraph control is enabled in the 
Paragraph Properties. For more information, see Configuring paragraph properties

The Dynamic Text dialog appears. Here, you can create multiple sections to make 
them non-editable in the Interactive Editor. 
In the Sections portion, click + New Section.
Then enter the details of the new section in the New Sections portion.
Enter the name of the section.
Enter the starting character of the section you want to make non-editable.
Enter the ending character of the section you want to make non-editable.
Select the Non-Editable checkbox to make the section non-editable.

1, 2, 3●

A, B, C●

a, b, c●

I, II, III●

i, ii, iii●
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8. Click Add Section.
The section gets added.

Related topic(s)
Defining and managing rules 
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Page break

Use the Page Break control in a letter template to end the current page and insert a 
new one. To add a page break, go to the Insert tab. Select the Page Break control from 
the Controls toolbar and click on the design area where you want to insert the page 
break. It shifts the content that comes below the page break to the top of the new 
page.

Component

A component is a reusable piece of content that you can use across multiple templates. 
This saves you both time and effort and ensures a consistent look over templates. For 
more information, see Working with components.

To add a component, go to the Insert tab. From the Controls toolbar, click the 
Components control. Then, click anywhere in the design canvas and capture the 
required region. A Select Components dialog appears. Here, you can select the type of 
component you want to create. It can either be a Local Component or an Enterprise 
Component. Then, click Save to confirm. The component gets created. It includes all 
the controls in the selected region.

For more information about the component types, see Types of components.

A component supports all the formatting options, controls, and alignment options you 
apply to a letter template. For more information, see Adding a letter template.

Ensure that the selected region does not contain any other component or arithmetic expression. ●

Controls must completely lie within the selected region. ●

There can only be one digital signature in the template including the component. ●

You cannot add a pre-existing component to the same letter page. ●

Formatting options — The File menu consists of a formatting toolbar that 
provides various formatting options to modify the font size, color, alignment, and 
style.

The formatting toolbar of the component does not support the following options as the letter 
template — Header and Footer, Increase/Decrease page, and Number Sequence Library.  

●
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You can then click Save to confirm the changes. 

 

Related topic(s)

Fillable PDF template
The fillable template supports the following controls. You can simply drag and drop the 
control from the Controls toolbar to the section.

 

When you add controls to the template, you can perform various operations on it. 
Although the list of operations for each control varies. 

Controls — The Insert menu consists of a Controls toolbar that allows you to 
insert text, images, links, buttons, and other controls to the component. 

The Controls toolbar of the component does not support the following options as the letter 
template — Password, Watermark configuration, Annexure configuration, and Add page break. 

●

Alignment options — The Align menu provides various options to align controls, 
set paragraph spacing, and reset the control size of the template. 

●

Working with components●

Working with component gallery●

Rich text●

Table●

Image●

Charts●

Shape●

Arithmetic expression●

Barcode●

Password●

Watermark configuration●

Annexure configuration●

Fillable form fields●
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Table

Use the table control in your letter template to display data in tabular format. A table is 
composed of rows and columns. You can add or remove the rows and columns from 
the table. You can also adjust the column size. Apart from this, you can also display 
dynamic content, merge the table cells, add table headers, and others.

To add a table, go to the Insert tab. Select the Table control from the Controls toolbar 
and click anywhere in the design canvas to open the Table Properties dialog. This topic 
covers the following sections:

Configuring table properties

You can configure the table settings in the Structure tab of the Table Properties dialog.

Property Description

Table Name
Specify the name of the table. The table must have a unique name 
within a template. 

Column Information

Equalize Width
Enable the toggle to allow the auto-distribution of column width within 
the table. The sum of all the column widths must be 100 percent.

+New Column

By default, there are two columns in the table. You can add more 
columns by clicking the + New Column. 

Additionally, you can modify the column width and apply rules to the 
columns. For more information, see Defining and managing rules.

Configuring table properties●

Setting table border●

Setting table dimension●

Setting a cell border●

Specify table padding●

Adjusting cell text rotation●

Merging table cells●

Adding a system field●

Adding a macro field●

Adding a hyperlink●

Adding table elements●
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1.
2.
3.

Property Description

Rows Information

Insert After Selected 
Row 

Choose this option to add a new row below the selected row in the Row 
Information section, and then click + Add New Row.
Additionally, you can apply rules to the added rows.

Insert Before Selected 
Row

Choose this option to add a new row before the selected row in the 
Row Information section, and then click + Add New Row.
Additionally, you can apply rules to the added rows.

Adding table elements

You can enhance your table by adding various elements such as text, images, barcodes, 
data fields, and interactive controls. Each element can be added by selecting the 
appropriate option from the dropdown menu in the table header bar.

Text

Add formatted text to your table cells for better presentation.

To add text to the table, follow these steps:

On the design canvas, place the cursor on the required table cell.
Go to the Table tab, and from the More Options dropdown, select Text.
Click the required cell. The Text Properties dialog appears with the following 
options:

Property Description

Content

White space to write the text with the following options to 
edit the text:

Text Rotation 
Select the text rotation angle from the dropdown (0, 90, 
180, 270).

Font — Select the font type.●

Font Size — Select the font size.●

Bold — Make the text bold.●

Italics — Italicize the text.●

Underline — Underline the text.●

Font Color — Choose the font color.●

Background Color — Choose the background color.●
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4.

1.
2.
3.

4.

Property Description

Attributes

Apply Indentation —  Checkbox to apply indentation.
Running Direction —  Checkbox to set text running 
direction from right to left.
 

Click Save.

Image

Add images to your table cells to visually represent data or enhance the appearance of 
your table.

To add an image to the table, follow these steps:

On the design canvas, place the cursor on the required table cell.
Go to the Table tab, and from the More Options dropdown, select Image.
Click the required cell. The Image Properties dialog appears with options to 
configure the image settings:
 

Property Description

Image Source

Add an image using any of the following options: 

Preview It displays the preview of the added image.

Click Add.

Barcode

Insert barcodes into your table cells to include scannable information.

Browse File — Select this option to add an image 
from your local system. 

●

Input URL — Select this option to add an image 
using a valid URL. The supported image formats 
are .jpeg, and .jpg.

●

The image URL must be accessible to the 
application server. 

●

The image URL must end with a "." followed by its 
file extension.  

●
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1.
2.
3.

1.
2.
3.

4.

1.
2.

To add a barcode to the table, follow these steps:

On the design canvas, place the cursor on the required table cell.
Go to the Table tab, and from the More Options dropdown, select Barcode.
Click the required cell. The Barcode Properties dialog appears with options to 
configure the barcode settings. To configure the Barcode, see Barcode

Data Field

Add data fields to your table cells to dynamically display data from your dataset.

To add a data field to the table, follow these steps:

On the design canvas, place the cursor on the required table cell.
Go to the Table tab, and from the More Options dropdown, select Data Field.
Click the required cell. The Data Field Properties dialog appears with the following 
options:

Property Description

Table Select the dataset table from the dropdown menu.

Column Select the dataset column from the dropdown menu.

Attributes

Click Add.

Interactive Controls
Insert interactive controls into your table cells, and utilize various interactive fields such 
as textboxes, checkboxes, date pickers, list boxes, and radio buttons. These controls 
allow you to gather specific input directly within the table, enhancing data collection 
and user interaction.

To add an interactive control to the table, follow these steps:

On the design canvas, place the cursor on the required table cell.
Go to the Table tab, then open the More Options dropdown.

Running Direction — Checkbox to set text running 
direction from right to left.

●

Regional Language —  Checkbox to enable regional 
language support.

●

Enable HTML Content — Checkbox to enable HTML 
content

●
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3.

4.

1.

Select Interactive Controls and choose the desired fillable form field from the 
available options.
Click the required cell. The selected fillable form field Properties dialog appears 
with options to configure. To configure the fillable form field, see Fillable form 
fields.

Related topic(s)

Fillable form fields

Form fields are interactive elements that allow you to input data within templates. 
These controls include textboxes, checkboxes, date pickers, list boxes, and radio 
buttons. They provide flexibility in capturing your information and enhancing the 
interactivity of the templates. You can also add form fields to table cells, further 
increasing the versatility of your templates.

Textbox
It allows the user to enter freeform text in the template.

To add a textbox, perform the following steps:

From the form field, choose Textbox and click the page. The Text Box Properties 
dialog appears with the following options:

Option Description

Name Enter a name for the textbox.

Type Select this checkbox to allow only numerical input. 

Enable Character Limit Toggle this button to enable the character limit for the textbox.  

Character Limit
Enter the maximum number of characters allowed in the 
textbox.    

Border Width Allows you to set the width of the textbox border.

Border Color Choose the color of the textbox border from a color palette

Height Allows you to set the height of the textbox.

Width Allows you to set the width of the textbox.

Defining and managing rules ●

Arithmetic expression●



     Adding controls

Version: 12.0 NewgenONE OmniOMS Communication Designer User Guide 153            

2.

1.

2.

Click Save. The text box appears on the page.

Modifying a textbox

To modify the textbox, right-click the textbox. The following options appear:

Option Description

Cut  Allows you to remove the textbox from its current position and place it 
on the clipboard.

Copy  Allows you to copy the textbox to the clipboard.

Paste Allows you to insert a previously cut or copied textbox from the 
clipboard to the current location.

Delete Allows you to remove the textbox from the page.

Move To Front Bring the textbox to the front, in front of other overlapping elements.   

Add Macro field Insert a macro field within the textbox for dynamic content.  

Properties Open the Text Box Properties dialog to edit the textbox settings.

Checkbox

It allows the user to select or deselect options in the template.

To add a checkbox, perform the following steps:

From the form field, choose Checkbox and click the page. The Checkbox 
Properties dialog appears with the following options:

Option Description

Name Enter a name for the checkbox.

Border Width Allows you to set the width of the checkbox border.

Border Color
Choose the color of the checkbox border from a color 
palette

Height Allows you to set the height of the checkbox.

Width Allows you to set the width of the checkbox.

Checked By Default Toggle this button to make the checkbox already checked.

Click Save. The checkbox appears on the page.
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1.

Modifying a checkbox

To modify the checkbox, right-click the checkbox. The following options appear:

Option Description

Cut  Allows you to remove the checkbox from its current position and place 
it on the clipboard.

Copy  Allows you to copy the checkbox to the clipboard.

Paste Allows you to insert a previously cut or copied checkbox from the 
clipboard to the current location.

Delete Allows you to remove the checkbox from the page.

Move To Front Bring the checkbox to the front, in front of other overlapping elements. 
  

Properties Open the Checkbox Properties dialog to edit the checkbox settings.

Date Picker
It allows the user to select a date from a calendar in the template.

To add a date picker, perform the following steps:

 
From the form field, choose Date Picker and click the page. The Date Picker 
Properties dialog appears with the following options:

Option Description

Name Enter a name for the date picker.

Day Format Choose the format for the day.

Month Format
Choose the format for the month. Options include MM, Mon, 
Month.

Year Format Choose the format for the year. Options include YYYY, YY.  

Separator Choose the separator character. Options include /, -, ,.

Day Position Choose the position for the day. Options include 1, 2, 3.

Month Position Choose the position for the month. Options include 1, 2, 3.

Year Position Choose the position for the year. Options include 1, 2, 3.

Border Width Allows you to set the width of the date picker border.
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1.

Option Description

Color Choose the color of the date picker border from a color palette.

Height Allows you to set the height of the date picker.

Width Allows you to set the width of the date picker.

Click Save. The date picker appears on the page.

Modifying a date picker

To modify the date picker, right-click the date picker. The following options appear:

Option Description

Cut  Allows you to remove the date picker from its current position and place it on 
the clipboard.

Copy  Allows you to copy the date picker to the clipboard.

Paste Allows you to insert a previously cut or copied date picker from the clipboard to 
the current location.

Delete Allows you to remove the date picker from the page.

Move To Front Bring the date picker to the front, in front of other overlapping elements.   

Properties Open the Date Picker Properties dialog to edit the date picker settings.

List Box
It allows the user to select one or more options from a list in the template.

To add a list box, perform the following steps:

 
From the form field, choose List Box and click the page. The List Box Properties 
dialog appears with the following options:

Option Description

Name Enter a name for the list box.

Default Item Select the chosen values or macro from the list

Border Width Allows you to set the width of the list box border.

Border Color Choose the color of the list box border from a color palette

Height Allows you to set the height of the list box.
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1.

Option Description

Width Allows you to set the width of the list box.

+ Add Macro Add a macro to the list box

+ Add Value Add a value to the list box.

Click Save. The list box appears on the page.

Modifying a list box

To modify the list box, right-click the list box. The following options appear:

Option Description

Cut 
Allows you to remove the list box from its current position and place it 
on the clipboard.

Copy  Allows you to copy the list box to the clipboard.

Paste
Allows you to insert a previously cut or copied list box from the clipboard 
to the current location.

Delete Allows you to remove the list box from the page.

Move To Front Bring the list box to the front, in front of other overlapping elements.   

Properties Open the List Box Properties dialog to edit the checkbox settings.

Radio Button
It allows the user to select one option from a group of choices in the template.

To add a radio button, perform the following steps:

 
From the form field, choose Radio and click the page. The Radio Properties dialog 
appears with the following options:

Option Description

Name Enter a name for the radio.

Border Width Allows you to set the width of the radio button border.

Border Color
Choose the color of the radio button border from a color 
palette
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Option Description

Height Allows you to set the height of the radio button.

Width Allows you to set the width of the radio button.

Checked By Default
Toggle this button to make the radio button already 
checked.

Click Save. The radio button appears on the page.

Modifying a radio button

To modify the radio button, right-click the radio button. The following options appear:

Option Description

Cut 
Allows you to remove the radio button from its current position and place 
it on the clipboard.

Copy  Allows you to copy the radio button to the clipboard.

Paste
Allows you to insert a previously cut or copied radio button from the 
clipboard to the current location.

Delete Allows you to remove the radio button from the page.

Move To Front
Bring the radio button to the front, in front of other overlapping elements. 
  

Radio Grouping
Allows you to group with another radio button so that only one can be 
chosen at a time (for example: gender selection). For more information, 
see Radio Grouping.

Properties Open the Radio Properties dialog to edit the checkbox settings.

Grouping radio button

To group radio button, perform the following steps:

Right-click the radio button and select Radio Grouping. The Radio Grouping 
dialog appears with the following options:

Option Description

 Type
Select whether to create a new group or add to an existing group of 
radio buttons. 
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2.

Option Description

 Group Name
 If New Group is selected, enter a name for the new group. If 
Existing Group is selected, choose from a dropdown list of available 
group names.

Click the Save button to group the radio buttons.
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Design on PDF template
The Design on PDF template helps you to add content on top of the existing PDF 
design. It provides support for the following controls.

The above controls have the same functionality as the controls in the letter template. 
After adding the controls to the template, you can configure their corresponding 
properties and apply operations to them.  

Rich Text●

Image●

Password●
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Defining and managing 
rules
Use rules to make logical comparisons between the actual and expected value, and 
determine the necessary action if the condition is true. By defining rules, you can 
generate conditional content in your templates. For example, a company can generate 
varied promotional offers in the template based on the privileged customer category, 
that is, gold, silver, or platinum.

In OmniOMS Communication Designer, rules can be applied to specific controls within 
letter and PDF templates, as well as to sections in email templates.
For letter and PDF templates, rules can be applied to:

For email templates, rules can be applied only to sections, allowing for dynamic 
content that responds to the conditions set for each section as a whole, rather than 
individual elements.

Creating a rule
The Rule library is a collection of rules you created for your template. It lists all the rules 
created for all the supported controls. 

To create a new rule, follow the below steps:

Rich Text●

Table●

Image●

Shapes including rectangles, lines, and circles●

Arithmetic Expression●

Paragraph●

Watermark configuration●

Component●
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1.

2.
3.

4.

Open the Rule Library.

Click + New Rule. The Create Rule dialog appears.
Enter the following details in the dialog:

Property Description

Name Specify the name of the rule.

Active
Enable this checkbox to use this rule for template 
generation.

Data Field
Select the required dataset field from the dropdown list. It 
indicates the field on which you want to apply the rule.

Operator

Select the conditional operator you want to use for the 
rule. It can be any of the following:

Value Type
Specify whether you want to compare the selected 
dataset field with a static or dynamic value.

Value

Specify the expected value for the selected dataset field.

If you chose static, then enter the static content in the 
space provided. If you chose static, then select the 
required dataset field from the dropdown list.

Operator
Select the required operator type for the rule. It can be 
AND or OR.

Click Add, and then click Create.
The rule gets added to the Rule Library.

In the case of letter template, go to the Home tab. Click More Options  , 
and then select Rule Library from the formatting toolbar.

●

In the case of design on PDF template, go to the Home tab, and select Rule 
Library from the formatting toolbar. The Rule Library dialog appears.

●

In the case of Email template, go to the Home tab, and select Rule Library
from the formatting toolbar. The Rule Library dialog appears.

●

Contains●

Equals●

Not Equal●

Is Null●

Is Not●

Null Like ●

Not Like●
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4.

5.

Associating rules with controls
In OmniOMS Communication Designer, you can apply rules to various controls within 
your templates, allowing you to generate dynamic content based on logical 
comparisons. Rules can be associated with several controls in letter, PDF, and email 
templates, ensuring that your templates react to specific conditions.

Associating rules with Email template sections
In email templates, rules can be applied only at the section level, not on individual 
elements. To associate a rule with a section in an email template, follow the below 
steps:

On the design canvas, click the desired section.
Select Rules Association from the context menu. The Rules Association dialog 
appears, listing all associated rules on the left side.
(Optional) Click View details in the rule library to see the defined rule.
Enter the required details in the dialog:

Property Description

Rule Name
Select the required rule from the dropdown list. You can also click the 
add icon to create a new rule. For procedural details, see Creating rule. 

Condition
It denotes the conditional logic defined for the selected rule. It is 
prefilled with default values and cannot be modified. 

Show Object Enable the toggle to display the control if the conditional logic is met.

Click Associate.
The rule is now associated with the selected section. By default, an Else condition 
for the rule is also added to the associated rules.

Associating rules with other controls

Rules can also be applied to various other controls in your templates, such as:

Rich Text●

Table●

Image●

Shapes (Rectangles, Lines, Circles)●

Arithmetic Expression●
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1.
2.

3.

4.

5.

1.

Associating rule with rich text control

To associate a rule with the rich text control, follow the below steps:

On the design canvas, right-click the Rich Text control.
Select Rules from the context menu. The Rules Association dialog appears. It lists 
all the associated rules on the left side of the dialog.
(Optional) Click View details in the rule library to see the defined rule in the Rule 
Library.
Enter the following details in the dialog:

Property Description

 Rule
Select the required rule from the dropdown list. You can also click the 
add icon to create a new rule. For procedural details, see Creating rule. 

 Condition
It denotes the conditional logic defined for the selected rule. It is 
prefilled with default values and cannot be modified. 

Show Object Turn on the toggle to display the control if the conditional logic is met.

Click Associate.
The rule is now associated with the Rich Text control. By default, an Else condition 
for the rule is also added to the Associated Rules.

Associating rule with table control

To associate a rule with the table control, follow the below steps:

You can apply a rule to an entire table or a specific table cell, row, or column. 

On the design canvas, 

Paragraph●

Watermark Configuration●

Component
 

●

To apply a rule on a specific cell — Place the cursor on the required cell, 
press the Shift key and the left-mouse click. Then, select Rules from the 
context menu.

●

To apply a rule on the entire table — Right-click anywhere in the table and 
then select Rules from the context menu.

●
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3.

4.

1.
2.

3.

4.

The Rules Association dialog appears. It lists all the associated rules on the left side 
of the dialog.
(Optional) Click View details in rule library to see the defined rule in the Rule 
Library.
Enter the following details in the dialog:

Property Description

 Rule
Select the required rule from the dropdown list. You can also click the 
add icon to create a new rule. For procedural details, see Creating rule. 

 Condition
It denotes the conditional logic defined for the selected rule. It is 
prefilled with default values and cannot be modified. 

Show Object Enable the toggle to display the control if the conditional logic is met.

Click Associate.
The rule is now associated with Table control. By default, an Else condition for the 
rule is also added to the Associated Rules.

Associating rule with image control

To associate a rule with the image control, follow the below steps:

On the design canvas, right-click the Image control.
Select Rules from the context menu.
The Rules Association dialog appears. It lists all the associated rules on the left side 
of the dialog.
(Optional) Click View details in rule library to see the defined rule in the Rule 
Library.
Enter the following details in the dialog:

Property Description

 Rule
Select the required rule from the dropdown list. You can also click the 
add icon to create a new rule. For procedural details, see Creating rule. 

 Condition
It denotes the conditional logic defined for the selected rule. It is 
prefilled with default values and cannot be modified. 

To apply a rule on a row or column — Right-click anywhere in the table, 
and select Properties from the context menu. In the Structure tab of the 
Table Properties dialog, click the Rules icon  next to the required row or 
column.

●
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4.

5.

Property Description

Show Object
Enable the toggle to display the specified image if the conditional 
logic is met.

Preview
Click Browse icon  to select the image from your local system. The 
image in the template gets replaced by the selected image if the 
conditional logic is met.

Click Associate.
The rule is now associated with Image control. 

Associating rule with shape control

To associate a rule with the shape control, follow the below steps:

On the design canvas, right-click the required Shape control.
Select Rules from the context menu.
The Rules Association dialog appears. It lists all the associated rules on the left side 
of the dialog.
(Optional) Click View details in rule library to see the defined rule in the Rule 
Library.
Enter the following details in the dialog:

Property Description

Rule
Select the required rule from the dropdown list. You can also click the 
add icon to create a new rule. For procedural details, see Creating rule. 

Condition
It denotes the conditional logic defined for the selected rule. It is 
prefilled with default values and cannot be modified. 

Show Object
Enable the toggle to display the specified image if the conditional logic 
is met.

Preview

Apply conditional formatting on the shape:

You can also view the formatted shape in the preview area.

Click Associate.
The rule is now associated with Shape control. 

In the case of a rectangle or circle, you can specify its border color, 
fill color, and line width.

●

In the case of a line, you can specify its border color and line width.●
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4.

Associating rule with arithmetic expression control

To associate a rule with the arithmetic expression control, follow the below steps:

On the design canvas, right-click the required Arithmetic Expression control.
Select Rules from the context menu.
The Rules Association dialog appears. It lists all the associated rules on the left side 
of the dialog.
(Optional) Click View details in rule library to see the defined rule in the Rule 
Library.
Enter the following details in the dialog:

Property Description

Rule
Select the required rule from the dropdown list. You can also click the 
add icon to create a new rule. For procedural details, see Creating rule. 

Condition
It denotes the conditional logic defined for the selected rule. It is 
prefilled with default values and cannot be modified. 

Show Object
Enable the toggle to display the specified content if the conditional logic 
is met.

Preview
Specify the content you want to display if the conditional logic is met.
You can also apply text formatting to the content.

Click Associate.
The rule is now associated with Arithmetic Expression control. By default, an Else 
condition for the rule is also added to the Associated Rules.

Associating rule with paragraph control

To associate a rule with the paragraph control, follow the below steps:

On the design canvas, right-click the required Paragraph control.
Select Rules from the context menu.
The Rules Association dialog appears. It lists all the associated rules on the left side 
of the dialog.
(Optional) Click View details in rule library to see the defined rule in the Rule 
Library.
Enter the following details in the dialog:
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6.

Property Description

Rule
Select the required rule from the dropdown list. You can also click the 
add icon to create a new rule. For procedural details, see Creating rule. 

Condition
It denotes the conditional logic defined for the selected rule. It is prefilled 
with default values and cannot be modified. 

Show Object Enable the toggle to display the control if the conditional logic is met.

Click Associate.
The rule is now associated with Paragraph control. By default, an Else condition for 
the rule is also added to the Associated Rules.

Associating rule with watermark configuration control

To associate a rule with the watermark configuration control, follow the below steps:

From the Controls toolbar, select Watermark Configuration. 
Here, you can see the added image or text watermarks.
Go to the Image tab in case you inserted an image watermark. Else, go to the Text 
tab.
Click Apply Rule.
The Rules Association dialog appears. It lists all the associated rules on the left side 
of the dialog.
(Optional) Click View details in the rule library to see the defined rule in the Rule 
Library.
Enter the following details in the dialog:

Property Description

Rule
Select the required rule from the dropdown list. You can also click the 
add icon to create a new rule. For procedural details, see Creating rule. 

Condition
It denotes the conditional logic defined for the selected rule. It is 
prefilled with default values and cannot be modified. 

Show Object Enable the toggle to display the control if the conditional logic is met.
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Property Description

Preview

Click Associate.
The rule is now associated with the Watermark Configuration control. 

Associating rule with component control

To associate a rule with the component control, follow the below steps:

On the design canvas, right-click the Component control.
Select Rules from the context menu.
The Rules Association dialog appears. It lists all the associated rules on the left side 
of the dialog.
(Optional) Click View details in the rule library to see the defined rule in the Rule 
Library.
Enter the following details in the dialog:

Property Description

 Rule
Select the required rule from the dropdown list. You can also click the 
add icon to create a new rule. For procedural details, see Creating rule. 

 Condition
It denotes the conditional logic defined for the selected rule. It is 
prefilled with default values and cannot be modified. 

Show Object Enable the toggle to display the control if the conditional logic is met.

Click Associate.
The rule is now associated with the Component control. By default, an Else 
condition for the rule is also added to the Associated Rules.

In the case of an image watermark, click Browse icon  to select 
the image from your local system. The image in the template gets 
replaced by the selected image if the conditional logic is met.

●

In the case of a text watermark, specify the content you want to 
display if the conditional logic is met.

●

You can also apply text formatting to the content.
 

●
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Managing rules
You can view all the created rules in the Rule Library dialog. It also displays the basic 
details of the rule and its associated controls. Apart from this, you can also edit the rule.

Modifying rule

To modify a rule, follow the below steps:

In the Rule Library dialog, select the required rule.
The basic detail of the selected rule appears on the right of the dialog.
Click the edit icon next to the rule.
The Modify Rule dialog appears.
Select the required conditional logic in the list

Click Save.

Viewing associated controls

To view associated control, follow the below steps:

In the Rule Library dialog, select the required page number from the dropdown 
list. It then shows the associated controls added to the selected page number in 
the template.
Select the type of control. It can be rich text, image, table, circle, line, or rectangle.
Based on the entered details, the controls are displayed in the list.
You can enable or disable the Show Object toggle to modify the rule properties.
Click Save to apply the changes.

Deleting rule

To delete a rule, follow the below steps:

In the Rule Library dialog, select the required rule.
The basic detail of the selected rule appears on the right of the dialog.

Modifying rule●

Viewing associated controls●

Click Update to edit the conditional logic.●

Click Clear to discard the content of the conditional logic.●

Click Delete to remove the conditional logic.●
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Click the delete icon  next to the rule.
The Delete Alert dialog appears.
Click Delete to delete the rule.
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Adding an asset
OmniOMS Communication Designer supports two types of assets that you can add to 
your templates. They help in enhancing the layout and design of your template. Master 
layout templates and components are the different assets you can use while designing 
a template.

To add an asset, navigate to the Assets tab on the Communication Designer home 
page. Here, you can add an enterprise master layout template or component based on 
your business requirements. The assets added using the Assets tab are available at the 
global level. It means you can use these assets in any template available in your 
currently signed-in cabinet.

For more information, see the following sections:

Working with master layouts●

Working with components●
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Working with master 
layouts
Master layout in a Communication Designer acts as a parent template for different 
pages in a letter. You can apply a master layout to specific letter pages or the entire 
letter template for consistent layout and design. For example, you can create a master 
layout for a bank statement with the company logo in the header and address in the 
footer and then apply it to the required pages in the letter template.

This way, there is no need to design the header or footer each time you work on a 
different letter page but focus on the content to add. Additionally, whenever you 
modify a master layout, you can select whether to implement the changes to a specific 
template or enforce updates to all the associated templates linked with the updated 
master layout at once. 

In Communication Designer, you can add a master layout either at the local or 
enterprise (or global) level. For more details, see Understanding master layout 
types. Within a master layout, you can add multiple controls and further design them 
according to your business needs. The controls supported in a master layout are similar 
to those in a letter template. 

The menu bar of the letter template contains the following menu options:

File menu

The File menu consists of a formatting toolbar that provides various formatting options 
to modify the font size, color, alignment, and style. 

The below table describes the different formatting options available in the formatting 
toolbar.

File menu●

Insert menu●

Align menu●
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Icon Icon Name Description

 Font style Change the font style of the selected text.

Font Size Change the font size of the selected text.

Bold Bold the selected text.

Italics Make the selected text italics.

Underline Underline the selected text.

Strikethrough Strikethrough the selected text.

Fore Color
Change the font color of the selected text using the color palette 
and color names with RGB or hexadecimal values.

Back Color
Change the background color of the selected text using the color 
palette and color names with RGB or hexadecimal values.

Fill Color
Fill tables, rectangles, and circles with colors using the color 
palette and color names with RGB or hexadecimal values.

Align Align the selected text to left, right, justify, or center.

Align vertically
Align the selected text at the top, middle, or bottom of the table 
cell.

Superscript/
Subscript

Align the selected text above or below the normal line.

Design 
background 
grid

Click to display gridlines on the design canvas.

Fit to canvas 
width

Reset the control dimensions to fit the design canvas width.

This option is only applicable to tables, rectangles, text, and images. 

Auto Relativity

Use this option to maintain spacing between the controls in the 
template.  

The auto relativity feature does not impact the controls if you 
resize a table control. 

●

The auto relativity does not have any impact on the line control. ●
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Icon Icon Name Description

Header and 
footer

Allow you to insert header and footer sections into the template. 
You can add text and images to the header and footer sections. 
You can also increase or reduce the size of these sections as per 
your requirements.

The header and footer sections are applicable to all the pages in the 
letter template.  

More options
Select Rule Library option to create and add rules. For more 
information, see Defining and managing rules.

Insert menu

The Insert menu provides a Controls toolbar that allows you to insert text, images, links, 
buttons, components, and others into the template.

The below table describes the different controls available in the toolbar.

Icon Icon Name Description

Rich Text It allows to insert text in the template.

Table It allows to insert tables in the template.

Image It allows to insert images in the template.

Shape
It allows to insert shapes in the template such as rectangles, 
lines, and circles.

Arithmetic 
Expression

It enables you to add arithmetic expressions in the template.

Barcode It allows to add 1-D and 2-D barcodes to the template. 

Align menu

The Align menu provides various options to align controls, set paragraph spacing, and 
reset the control size within a template.   

These alignment options are only applicable to rich text, images, rectangles, lines, and paragraphs. 



     Working with master layouts

Version: 12.0 NewgenONE OmniOMS Communication Designer User Guide 175            

Option Description

Align Vertical Start
Aligns the controls vertically to the top edge of the last selected 
control.

Align Vertical Center Aligns the controls vertically to the center of the last selected control.

Align Vertical End
Aligns the controls vertically to the bottom edge of the last selected 
control.

Align Horizontal Start
Aligns the controls horizontally to the left edge of the last selected 
control.

Align Horizontal Center
Aligns the controls horizontally to the center of the last selected 
control.

Align Horizontal End
Aligns the controls horizontally to the right edge of the last selected 
control.

Equal Height Resets the height of the controls as that of the last selected control. 

Equal Width Resets the width of the controls as that of the last selected control.

Same Size Resets the size of the controls as that of the last selected control.

Para spacing
Sets the spacing between the Paragraph controls (in pixels). The 
spacing value ranges from 4 to 50 pixels.

Merge

Merges the text within the selected Rich Text controls. 

Ensure the selected Rich Text controls are either aligned vertically or 
horizontally on the same line. 

By default, the text is appended in the same line. 
However, in case, the left edges of the rich text controls are in the 
same line, then you get an option to merge the text as a paragraph. 
This means the text of merged controls starts from a new paragraph.

 

Related topic(s)
Understanding master layout types●

Linking a master layout●

Viewing associated templates●

Importing a master layout●

Managing master layouts●

Working with master layout gallery●
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Understanding master layout types
Communication Designer supports two types of master layouts – local and enterprise 
(or global). 

Related topic(s)

A local master layout is accessible only within the communication group where 
the master layout is created. You can link the master layout to the required 
template within that communication group. However, this layout is unavailable 
to the templates of other communication groups.
In this type of master layout, you can use the data fields defined in the linked 
dataset. For example, the branch name field can be used to display the bank's 
branch name in the header. To add a local master layout, select Master Layout
under the required communication group from the Categories pane, and then 
click Add New  . 

Local master layouts are only applicable to common dataset communication groups. For more 
information, see Adding a communication group. 

●

An enterprise master layout is accessible globally by all the communication 
groups. You can link the master layout to any template irrespective of its 
communication group. An enterprise master layout is also referred to as a global 
master layout.
This type of master template mostly contains static text or images such as 
disclaimers, company logos, and others. In the global master template, there is 
no scope to add the data fields. To add an enterprise master layout, on the 
Assets tab, expand the Enterprise Master Layout section and then click Add 
New  .

●

Linking a master layout●

Viewing associated templates●

Importing a master layout●

Managing master layouts●

Working with master layout gallery●
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2.

Linking a master layout
With Communication Designer, you can apply the master layout at the template level 
or page level. By template level, it means the master layout gets applied to all the 
pages in the letter template. However, if you want to apply the master layout to specific 
pages in the letter template, you link it at the page level.

To link a master layout to a template or page, follow the below steps:

From the Categories pane, select the required letter template or letter page.
From the right, click Master Layout Gallery.
The Master Layout Gallery pane appears.
Select the required master layout from the list.
You can also use the search box to find the layout by its name. Additionally, you 
can filter the templates using the Filter icon  to view only the local, enterprise, or 
both types of master layouts. 
Click Link to apply the master layout.
The master layout gets applied to the background of the template. The 
background appears in gray and is uneditable.

Related topic(s)

Viewing associated templates
When you apply a master template to a letter template or its pages, the template gets 
linked to the layout.

To view the associated templates, follow the below steps:

On the Categories pane, select the required master layout from the list.
Click More Options  and then select Associated Templates.
The View Associated Templates dialog appears. Here, you can view all the 
associated templates where the master layout is applied with the layout version, 

Viewing associated templates●

Importing a master layout●

Managing master layouts●

Working with master layout gallery●
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4.

5.

1.
2.

3.

its category, and the communication group it belongs to. Apart from this, you can 
view the template name, status, and the applied master layout version.  

If the master layout is not associated with any letter template or pages, the list of associated templates 
appears blank.   

(Optional) To view only the templates where a master layout of a specific version is 
applied, click Filters  and then select the required layout version. 
The list gets filtered based on the chosen value from the dropdown. 
(Optional) Furthermore, you can perform the following operations on the 
associated templates list: 

Click Close.

Related topic(s)
Working with master layout gallery

Importing a master layout
You can import a master layout to use it as a template. You can then modify the 
template design based on your requirements. These template changes do not affect 
the original master layout. 

To import a master template, perform the following steps: 

From the Categories pane, select the required letter page. 
On the right, click Master Layout Gallery. 
The Master Layout Gallery pane appears. 
From the gallery, select the required layout and then click the Import icon  .  
The master layout gets imported. 

Go to template ― Select the required checkbox next to the template and 
then click Go to template to view the associated template.    

●

Enforce ― Select the required checkbox next to the template and then 
click the Enforce button or enforce icon  to apply the latest layout version 
on the letter template and its pages. You can also enforce the latest version 
of the layout on multiple templates using the Enforce button.  

You can enforce the master layout only on the checked-in templates. 

●
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1.

You can now modify and make changes to the layout without hampering the 
original master layout design. 

Related topic(s)
Working with master layout gallery

Managing master layouts
This topic explains how to manage master templates in Communication Designer. 
Select the required local or enterprise master layout from the Categories pane or Assets 
tab, respectively, and then perform any of the following operations:

The steps for the above operations are the same as the communication templates. For 
procedural details, see Managing templates and jobs.

Apart from this, you can perform the following operation on the master layout:

Modifying page properties

Communication Designer allows you to change the default settings of the master 
layout page. These settings include the page layout, orientation, and margin 
properties. 

To modify page properties, follow the below steps:

From the Categories pane, select the required master layout.

Checking in●

Checking out●

Copying

 You can only copy a local master layout to a different location. 

●

Renaming●

Deleting●

Modifying page properties●

Viewing version history●
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Click More Options  and then select Page Properties from the list. 
The Page Properties dialog appears.
Set the following page properties in the dialog:

Property Description

Orientation
Specify the page orientation type. It can be set to 
Landscape or Portrait.  

Page Layout
Specify the layout of the page. It can be set to Letter, 
Legal, Tabloid, A3, A4, A5, and B5. You can also specify 
custom height and width for the page in inches. 

Page Width
It indicates the width of the page in inches.

This property is disabled by default and shows value based on 
the chosen page layout. 

Page Height
It indicates the height of the page in inches.

This property is disabled by default and shows value based on 
the chosen page layout. 

Header Margin
Specify the margin area (in inches) for the header section 
on the page.

Footer Margin
Specify the margin area (in inches) for the footer section 
on the page.

Left Margin
Specify the margin area (in inches) for the left side of the 
page.

Right Margin
Specify the margin area (in inches) for the right side of the 
page.

Click Save to confirm the changes. 

Viewing version history

Communication Designer allows you to view the history of changes for the selected 
master layout. This is achieved by clicking the More Options  next to the required 
layout and selecting the Version History option from the list.  

A Version History pane appears on the right. Here, you can see a list of versions for the 
selected master layout. Furthermore, it only lists the checked-in changes. This is 
because a new version gets created each time you check in a master layout.  
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When you hover over the corresponding info icon  for any layout version, it provides 
the name of the user who checked in the template, the checked-in time details, and 
the comment. Additionally, hovering over the version gives you the option to checkout. 
Select this option to check out the layout version to make modifications. 

In the Version History pane, you can find a particular layout version in the search box. 
To arrange the versions in ascending or descending order, click the up/down arrow 
toggle next to the column header. 
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Working with components
A component is a subpart of a template. It provides a reusable piece of content that 
you can use across multiple letter and email templates. Whenever you modify a 
component, you can select whether to implement the changes to a specific 
template or enforce updates to all the associated templates containing the updated 
component at once. 
By using components, template designers can create a consistent and streamlined 
approach for template creation. It simplifies the maintenance process and reduces the 
time and effort required to manage multiple templates in your currently signed-in 
cabinet.

Communication Designer consists of local and enterprise (or global) components. For 
more information about the types of components, see Types of components. You can 
use components only in letter and email templates. 

Types of components

A local component is accessible only within the communication group where 
the component is created. You can add the component to the required template 
within that communication group. However, this component is unavailable to 
the templates of other communication groups. In this type of component, you 
can use the data fields defined in the linked dataset.
To add a local component, select Component under the required 
communication group from the Categories pane, and then click Add New  . 
Alternatively, you can use the Component control in the template by simply 
dragging and dropping it into the design canvas. For more information, 
see Adding controls.

Local components are only applicable to common dataset communication groups. For more 
information, see Adding a communication group.

●

An enterprise component is accessible globally by all the communication 
groups. You can add the component to any template irrespective of its 
communication group. An enterprise component is also referred to as a global 
component.

●
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You cannot add a pre-existing component to the same letter page or email template.  

Related topic(s)

Linking a component
Communication Designer allows you to add components to an email or letter template.

To add a component to a template, follow the below steps:

From the Categories pane, select the required email or letter template.
From the right, select Component Gallery.
The Component Gallery pane appears.
Drag and drop the required component from the list. This list contains all the local 
and enterprise components created in the currently signed-in cabinet.
You can also use the search box to find the component by its name. Additionally, 
you can filter the components using the Filter icon  to view only the local, 
enterprise, or both types of components.
The component is now added to the design canvas.

The email template allows you to use the added component as a section of the template. This can be 
achieved by selecting the required component in the template and using the Unlink Component
option from the list. 

Related topic(s)

This component mostly contains static text or images such as disclaimers, 
company logos, and others. In the global component, there is no scope to add 
the data fields. To add an enterprise component, on the Assets tab, expand the 
Enterprise Component section and then click Add New  .

Linking a component●

Viewing associated components ●

Managing components●

Viewing version history●

Working with component gallery●

Viewing associated components●

Managing components ●
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Viewing associated components
When you insert a component into an email or a letter template, the component gets 
linked to the template.

To view the associated templates, follow the below steps:

On the Categories pane, select the required component from the list.
Click More Options  and then select Associated Templates.
The View Associated Templates dialog appears. Here, you can view all the 
associated templates where the component is added with its version, category, 
and the communication group it belongs to. Apart from this, you can view the 
component name, status, and the added component version.  

If the component is not added to any template, the list of associated templates appears blank.   

(Optional) To view only the templates where a component of a specific version is 
applied, click Filters  and then select the required component version. 
The list gets filtered based on the chosen value from the dropdown. 
(Optional) Furthermore, you can perform the following operations on the 
associated templates: 

Click Close.

Related topic(s)

Viewing version history●

Working with component gallery●

Go to template ― Select the required checkbox next to the template and 
then click Go to template to view the associated template.    

●

Enforce ― Select the required checkbox next to the template and then 
click the Enforce button or enforce icon  to apply the latest component 
version on the template. You can also enforce the latest version of the 
component on multiple templates using the Enforce button.  

You can enforce the component only on the checked-in templates. 

●

Managing components●

Working with component gallery●
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Managing components
This topic explains how to manage components in Communication Designer. Select 
the required local or enterprise component from the Categories pane or Assets tab, 
respectively, and then perform any of the following operations:

The steps for the above operations are the same as the communication templates. For 
procedural details, see Managing templates and jobs.

Apart from this, you can view the version history of the component. For more 
information, see Viewing version history.

Related topic(s)

Viewing version history

Communication Designer allows you to view the history of changes for the selected 
component. This is achieved by clicking the More Options  next to the required 
component and selecting the Version History option from the list.  

A Version History pane appears on the right. Here, you can see a list of versions for the 
selected component. Furthermore, it only lists the checked-in changes. This is because 
a new version gets created each time you check in a component.  

Checking in●

Baselining

You can baseline only checked-in components. 

●

Checking out●

Copying

 You can only copy a local component to a different location. 

●

Renaming●

Deleting●

Viewing version history●

Working with component gallery●
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When you hover over the corresponding info icon  for any component version, it 
provides the username of who checked in the template, the checked-in time details, 
and the comment. Additionally, hovering over the version gives you the option to 
checkout. Select this option to check out the component version to make 
modifications. 

In the Version History pane, you can find a particular component version in the search 
box. To arrange the versions in ascending or descending order, click the up/down arrow 
toggle next to the column header.

 

Related topic(s)
Working with component gallery
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Working with jobs
A job is a set of configuration settings that instruct the production server for generation 
purposes. These are the settings that specify recipients for emails, SMS, WhatsApp, X, 
and Facebook messages where to archive communications, and details for the email 
body and attachments.

You can create the following on-demand jobs:

Creating an on-demand social job
The on-demand social job allows you to configure the settings for message, WhatsApp, 
X, and Facebook communications. 

To create an on-demand social job, follow the below steps:

Ensure to design the message, WhatsApp, X, or Facebook template before configuring the job, or else an error 
appears. 

On the Categories pane, select Jobs under the required communication group.
Click the New Job icon   next to Jobs.
Select On Demand Social from the list.
The New On Demand Social Job dialog appears.
Enter the name of the job.
Add a description of the job.
Select a suitable template from the dropdown list.

Only the baselined message, WhatsApp, X, and Facebook templates appear in the list. 

(Optional) To add multiple templates, click Associate Template. 
The Associate Templates dialog appears. Select the required template from the list 
and click Associate. You can also click Select All to select all the templates in the 

Creating on demand social job●

Creating on demand mail/archival job●
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list.
The template gets associated.
Navigate to the required tab and configure the properties. For more information, 
see Configuring properties.
Click Add to confirm.

Configuring properties

The on-demand social job provides the following configuration settings. 

The Message tab describes the configuration settings for message communication. 

Select the Message Required checkbox to specify the configuration settings for 
message communication.
Select a suitable dataset field from the dropdown list. This field must contain 
message recipient numbers.
Select the configuration type for interacting with web services. It can be Web 
Services Description Language (WSDL) or Representational State Transfer (REST) 
Service.
Click Go. 
If you chose WSDL, then enter the following details:

Specify an appropriate WSDL URL.
Click Go.
Select an appropriate service name from the list. 
Select an appropriate method name from the list.
Click Register.
Enter the field names manually. 

In case you select REST Service, then specify the following details:
Specify an appropriate REST URL.
Click Next.
Select a suitable media type from the dropdown list. 
Then, map the field with the dataset fields.
Click Add to confirm.
The added mapped fields appear in the list. 

The Archival tab describes the configuration settings for archiving conversations.

Select the Message Archived option to archive the conversations.
Select a suitable Document Management System (DMS) from the dropdown list.
Currently, OmniOMS Communication Designer supports NewgenONE OmniDocs.
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Select the Is Secured checkbox to secure the information using HTTPS. 
Select the attributes based on your requirements:

Specify the DMS server address.
Specify the DMS server port.
Specify the DMS server type. It can be JBoss, JBossEAP, Weblogic, and Websphere.
Enter the login ID for the DMS cabinet.
Enter the password for the DMS cabinet.
Select a suitable cabinet from the dropdown list.
Specify the suitable volume, folder, and data class from the corresponding 
dropdown lists.
Click Add.
The selected folder gets added.
Click Get Fields. 
The fields associated with the selected folder appear in the Map Fields section.
Map the required fields with the dataset fields to store the text of the Message 
Template.
A message box appears. 
Click Yes to save the changes.

The WhatsApp tab describes the configuration settings for WhatsApp 
communication. 

Select the Whatsapp Required checkbox to specify the configuration settings for 
WhatsApp communication.
Select a suitable dataset field from the dropdown list. This field must contain 
WhatsApp recipient numbers.

The X tab describes the configuration settings for X communication. 

Select the X Required checkbox to specify the configuration settings for 
X communication.
Select the Job Type as DM or Post based on the requirement.
Select a suitable dataset field from the dropdown list. This field must contain X 
recipient numbers.

Attachment — Select this checkbox to archive the attachment in DMS. 

For message communication, do not select the Attachment checkbox. 

●

Communication — Select this checkbox to archive the communication in 
DMS.

●
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The Facebook tab describes the configuration settings for Facebook communication. 

Select the Facebook Required checkbox to specify the configuration settings for 
Facebook communication.
Select the Job Type as DM or Post based on the requirement.
Select a suitable dataset field from the dropdown list. This field must contain 
Facebook recipient numbers.

The Settings tab describes the configuration settings for archiving conversations on 
the cloud. OmniOMS integration with Amazon S3 and MS Azure sites facilitates 
temporary storage of the generated communications in the respective sites. Storing 
the generated communications in a cloud environment helps OmniOMS with high 
availability.

Select the Cloud Storage checkbox to specify the configuration settings for cloud 
storage.
Select a suitable type of storage type from the dropdown list. You can either use 
Amazon S3 Site or MS Azure Site.
Select a suitable site name from the dropdown list. 

These site names are created in the OmniOMS Workspace. For more information, see NewgenONE 
OmniOMS Admin Workspace User Guide. 

If you chose the Amazon S3 Site as the storage type, click the Get Containers
button and then select a suitable cabinet from the dropdown list. 
If you chose MS Azure Site as the storage type, click the Get Buckets button and 
then select a suitable cabinet from the dropdown list. 
Click Add.  

Creating an on-demand mail/archival 
job
The on-demand mail/archival job allows you to configure the settings for 
mail communications, or archival purposes. 

To create an on-demand mail/archival job, follow the below steps:

Ensure to design the mail, letter, design on PDF, or Word template before configuring the job, or else an error 
appears.
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On the Categories pane, select Jobs under the required communication group.
Click the New Job icon   next to Jobs.
Select On Demand Mail/Archival from the list.
The New On Demand Mail/Archival Job dialog appears.
Enter the name of the job.
Add a description of the job.
Select a suitable template from the dropdown list.

Only the mail, letter, design on PDF, or Word templates appear in the list. 

(Optional) To add multiple temples, click Associate Template. 
The Associate Templates dialog appears. Select the required template from the list 
and click Associate. You can also click Select All to select all the templates in the 
list.
The template gets associated.
Navigate to the required tab and configure the properties. For more information, 
see Configuring properties.
Click Add to confirm.

Configuring properties

The on-demand mail/archival job provides the following configuration settings. 

The Mail tab describes the configuration settings for email communication. 

Select the Mail Required checkbox to specify the configuration settings for email 
communication.
To add an email attachment, set the Attachment to Yes and click the Add Macro 
icon  to select the required dataset field containing attachment details. Else, set 
to No.
Select a suitable dataset field for the sender's email address.
Select a suitable dataset field for the recipient's email address.
Select a suitable dataset field for the CC recipient's email address.
Select a suitable dataset field for the BCC recipient's email address.
Select a suitable dataset field for the sender's email address.
Enter the subject for the email. You can also click the Add Macro icon  to select 
a suitable dataset field.
To specify the email body, you can select any of the following options:

User Defined — Select this option to define your own custom email body. 
To achieve this, click the Design Mail Body and enter the required content. 

●
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The Mail Archival tab describes the configuration settings for archiving conversations.

Select the Message Archived option to archive the conversations. 
Select a suitable DMS from the dropdown.
Currently, OmniOMS Communication Designer supports only OmniDocs. 
Enable the Is Secured checkbox to secure the information using HTTPS. 
Select the attributes based on your requirements:

Specify the DMS server address.
Specify the DMS server port.
Specify the DMS server type. It can be JBoss, JBossEAP, Weblogic, and Websphere.
Enter the login ID for the DMS cabinet.
Enter the password for the DMS cabinet.
Select a suitable cabinet from the dropdown list.

If the selected cabinet is not registered, a Register button appears. Click the Register button to open 
the Second Immune User Details dialog. Enter the login ID and password to register the cabinet.

Specify the suitable volume, folder, and data class from the corresponding 
dropdown lists.
Click Add.
The selected folder gets added.
Click Get Fields. 
The fields associated with the selected folder appear in the Map Fields section.
Map the required fields with the dataset fields to store the text of the Message 
Template.
A message box appears. 

You can also add macro fields in the email content using the Add 
Macro icon .
HTML Template — Select this option to use an email template. Select the 
required template from the dropdown list and then click Associate 
Template. To add an attachment, click the Add Macro icon  and then 
select the required dataset field from the dropdown. 
You can also add the template as the email attachment by selecting the 
Add the same template as attachment option.

●

Attachment — Select this checkbox to archive the attachment in DMS. 

For message communication, do not select the Attachment checkbox. 

●

Communication — Select this checkbox to archive the communication in 
DMS.

●
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Click Yes to save the changes.

The Print Archival tab describes the configuration settings for archiving the prints. 
These configurations are the same as that of the Archival tab mentioned above.

The Settings tab describes the settings related to mail, print, and cloud storage.

Select the Mail Settings checkbox to configure the email settings.

Select the Print Settings checkbox to configure the print settings for archival 
purposes.

Select the Cloud Storage checkbox to specify the configuration settings for cloud 
storage.
Select a suitable type of storage type from the dropdown list. You can either use 
Amazon Azure Site or MS Azure Site.
Select a suitable site name from the dropdown list. 

Embed Font — Select this option to use the same font in the email 
attachment when any user accesses it. 

●

Apply Password — Select this option to apply the password in the email 
attachment.

This option appears disabled in case no password is applied in the template. 

●

Apply Digital Signature — Select this option to use the digital signature in 
the email attachment.

This option appears disabled in case no digital signature is used in the template. 

●

Embed Font — Select this option to use the same font for generating the 
email attachments, which are archived and later sent as an attachment in 
the email.

●

Apply Password — Select this option to apply the password for generating 
the email attachments, which are archived and later sent as an attachment 
in the email.

This option appears disabled in case no password is applied in the template. 

●

Apply Digital Signature — Select this option to use the digital signature for 
generating the email attachments, which are archived and later sent as an 
attachment in the email.

This option appears disabled in case no digital signature is used in the template. 

●
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These site names are created in the OmniOMS Workspace. For more information, see NewgenONE 
OmniOMS Installation and Configuration Guide.  

If you chose the Amazon S3 Site as the storage type, click the Get Containers
button and then select a suitable cabinet from the dropdown list. 
If you chose MS Azure Site as the storage type, click the Get Buckets button and 
then select a suitable cabinet from the dropdown list. 
Then, click Add. 
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Managing templates and 
jobs
This topic outlines the different ways to manage templates, components, and jobs in 
the OmniOMS Communication Designer:

Checking in a template
Check-in to save all the changes made to the template. A new version of the template 
gets created each time you check in. By checking in a template, you can allow other 
users in the cabinet to view and edit the template. 

To check in a template, follow the below steps:

From the Categories pane, select the required template.

Checking in template●

Checking out template●

Copying template●

Renaming template●

Renaming job●

Baselining template●

Configuring template properties●

Defining decision table●

Saving and previewing template●

Delinking a master layout●

Deleting template●

Deleting job●

Ensure to specify the Product Name in the template properties, else an error message appears.  ●

The process of saving a template is different from that of checking in a template. This is because saving 
stores the template temporarily. However, when you check in a template, it means it is ready for 
baselining.   

●
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Click More Options  and then select Check in from the list.
The Template Check in dialog appears.

If you are checking in the template for the first time, the Check in Version is set to 1. 

Enter the comment in the space provided.
Click Check in to confirm.

Checking out a template
Check out a template to make modifications to it. 

To check out a template, follow the below steps:

From the Categories pane, select the required template.
Click More Options  and then select Check Out from the list.
The template gets checked out. 

Copying a template
To copy a template from one location to another, follow the below steps:

From the Categories pane, select the required template.
Click More Options  and then select Copy to from the list.
The Copy to dialog appears.
Select the category from the list. The category gets expanded and displays the 
available templates in it. 
Select the required template from the category. 
Click Copy.
The template gets copied to the other communication group. 

Renaming a template
To rename a template, follow the below steps:

From the Categories pane, select the required template.
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Click More Options  and then select Rename from the list.
Input the new name for the template, and then hit the Enter key. 
The template gets renamed.

Renaming a job
To rename a job, follow the below steps:

From the Categories pane, select the required job.
Click More Options  and then select Rename from the list.
Input the new name for the job, and then hit the Enter key. 
The job gets renamed.

Baselining a template
Baseline a template to share the finalized template version with the production server. 

You can baseline only a checked-in template.   

To baseline a template, follow the below steps:

From the Categories pane, select the required template.
Click More Options  and then select Baseline from the list. The Baseline dialog 
appears. It shows the baseline version, the last checked-in comment, and the 
baseline version's effective date. 
These fields are non-editable. By default, the baseline version is effective till the 
next baseline. 
Select an effective date from the date picker dropdown for the baseline version. By 
default, it picks the current date.
Enter a comment in the space provided.
Click Baseline. 
The template gets baselined and is ready to be used for production purposes.

If the maker checker functionality is enabled, the baseline request is sent for approval. 
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Configuring template properties
Before using the template for production purposes, it is necessary to configure the 
properties of templates. These properties include the basic details of the templates, 
field configurations, and page setup settings.

The template properties are used at the time of production.

To configure the template properties, follow the below steps:

On the Categories pane, select the required category.
Expand the selected category and then select the required template.
Click More Options  and then select Properties from the list.
The Template Properties dialog appears. By default, the Details tab is opened. It 
displays information such as the template name, revision number, type of 
template, revision comments, and others.
On the Details tab, enter the following details:

Property Description

Product Name
Specify the name of the product.

The product name is unique for each template. 

Description Enter the description for the template. 

Output Format

Select a suitable type of output format from the 
dropdown list.

This option is only applicable to letter templates, Design on PDF 
templates, and Word templates.

Attributes

Select the attribute you want to apply on the template:

Go to the Configurations tab, and click the Template Fields icon  to configure 
the fields to use for the template and job creation.
In the case of an email template, you also need to select a suitable field for the 

Enable demand request — Select this option to 
enable the on-demand report generation. This 
toggle must be enabled since OmniOMS 
Communication Designer currently supports only 
on-demand jobs.

●

Enable tracking — Select this option to keep track of 
email (read, unread, and bounce) and message 
( delivered or undelivered) status. 

●
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sender name, sender email address, recipient email address, CC recipient email 
address, BCC recipient email address, and email subject.
On the Page Setup tab, specify the following details:

The Page Setup tab is only visible in the case of letter templates. 

Property Description

 Orientation
Specify the page orientation type. It can be set to 
Landscape or Portrait.  

 Page Layout
Specify the layout of the page. It can be set to Letter, 
Legal, Tabloid, A3, A4, A5, and B5. You can also specify 
custom height and width for the page. 

Page Width
It indicates the width of the page.

This property is disabled by default and shows value based on 
the chosen page layout. 

Page Height
It indicates the height of the page.

This property is disabled by default and shows value based on 
the chosen page layout. 

Header Margin
Specify the margin area for the header section on the 
page.

Footer Margin Specify the margin area for the footer section on the page.

Left Margin Specify the margin area for the left side of the page.

Right Margin Specify the margin area for the right side of the page.

Attributes

Select the required attributes you want to apply:

Click Save to apply the changes.

Show Header/Footer only on 1st page — Use this 
option to display the header or footer sections only 
on the first page of the template.

●

Show Header/Footer from 2nd page — Use this 
option to display the header or footer sections from 
the 2nd page onwards in the template.

●
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Defining a decision table
A decision table is a collection of conditional logic that determines which action needs 
to be performed when a certain condition is met. OmniOMS Communication Designer
allows you to define multiple decision tables, which are executed based on their 
sequential order.

The decision rules are only applicable to dynamic content images. 
You can create a decision table only in the case of a letter template or design on PDF 
template. This topics covers the following sections:

Defining a decision table

On the Categories pane, select the required category.
Expand the selected category and then select the required template.
Click More Options  and then select Decision Table from the list.
The Decision dialog appears.
Click + New Decision Table to create a new decision table.
Specify the name of the decision table. By default, the name of the decision table 
is set to New Decision Table 1.
Click + New Condition to specify a new conditional logic.
The New Conditional Dialog appears.
Specify the name of the conditional logic.
Select a suitable macro field from the dropdown. It displays the fields of the linked 
dataset.
Select the type of conditional operator. It can be set to Operator or Range. 
If you select Operator, then select a suitable comparison operator from the 
dropdown list.

The Range operator is only applicable to the integer dataset field. 

Click Add.
The conditional logic gets added and is visible under the Conditionals section.
Click + New Action to define the corresponding action for the conditional logic.
The New Action dialog appears.
Enter the following details in the dialog:

Defining a decision table●

Changing execution order●
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Property Description

Action Name Specify the name of the action.

Action Type
Specify the type of action. This property is uneditable and is set to Set 
Image, by default.

Image
Select a suitable image from the dropdown list. This list displays only those 
images that are used as dynamic content within the template.

Click + New Row.
Under the Conditions section, enter the value or the range of values that must be 
satisfied to perform its corresponding action.
Under the Actions section, select a suitable image from the dropdown list.
If the condition logic is met, the selected image replaces the dynamic content 
image in the template.

The list only shows the images uploaded on the OmniOMS Admin Workspace. 

(Optional) To add multiple conditional logics and actions, repeat steps 6 to 15. 

The list only shows the images uploaded on the OmniOMS Admin Workspace. 

Click Save to apply the changes.

Change execution order

OmniOMS Communication Designer allows you to change the execution order of the 
conditional logics. This can be achieved by clicking the up and down arrows next to the 
required action.  

Saving and previewing template
After designing the template, you can save and preview the template to view the final 
output.

Saving the template

To save a template, click Save on the Menu bar.

Previewing template

Preview a template to verify the changes or modifications made to it.
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To preview a template, follow the below steps:

On the Menu bar, click Preview.
Select the required preview option from the list:

An Open dialog appears.

The Open dialog does not appear if you choose to preview the template with sample values.  

Select a suitable dataset that matches your associated dataset schema, and then 
click Open.
You can now preview the template design and data.

Delinking a master layout
To delink a master template from the associated layout, perform the following steps: 

On the Categories pane, select the required template from the list.  
Click More Options  and then select De-Link Master Layout.  
The master layout is now removed from the template and its pages.  

Deleting a template
Delete a template you no longer require. 

You cannot roll back the delete operation. 

To delete a template, follow the below steps:

From the Categories pane, select the required template. 

Preview with File — Use this option to preview the template by uploading 
a data file.

●

Preview with Sample Values  — Use this option to preview the template 
with sample dataset values.

●

Preview with Password — Use this option to preview the template with 
the applied password. This option is only applicable if any password is set.

This option is only available for letter templates. 

●
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Click More Options  and then select Delete from the list.
The Delete Template dialog appears.
Click Delete to confirm.

Deleting a job
Delete a job you no longer require. 

You cannot roll back the delete operation. 

To delete a job, follow the below steps:

From the Categories pane, select the required job. 
Click More Options  and then select Delete from the list.
The Delete Job dialog appears.
Click Delete to confirm.
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Viewing version history
OmniOMS Communication Designer allows you to view the history of changes for the 
selected template. This is achieved using the View version history option on the right 
pane. 

In the Version History pane that appears, you can see a list of versions for the selected 
template. Furthermore, it only lists the checked-in changes. This is because a new 
version gets created each time you check in a template. 

When you hover over the corresponding info icon  for any template version, it 
provides the username of who checked in the template, the checked-in time details, 
and the comment. Additionally, on hovering over the version you also get the following 
options:

In the Version History pane, you can find a particular template version in the search 
box. To arrange the versions in ascending or descending order, click the up/down 
toggle next to the column header.

Related topic(s)
Baselining template 

Baseline — Select to baseline the template version. For more information, see 
Baselining template. 

●

Checkout — Select to check out the template version to make modifications. ●
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Working with object 
gallery
OmniOMS Communication Designer allows you to add images and texts in the Object 
Gallery. Object Gallery is a collection of texts and images, which you can use in your 
templates. 

Adding text to Object Gallery

To add text to Object Gallery, follow the below steps:

On the right pane of the Communication Designer, select Object Gallery.
The Object Gallery pane appears.
On the Texts tab, click + New Text.
The New Text dialog appears.
Enter the following information in the dialog:

Property Description

Label Name Enter the label name for the text.

Description Enter the description for the text.

Content

Enter the text content. You can also format the text by setting the font style 
and size, making the text bold, italics, or underlined, aligning the text (left, 
center, right), applying ordered or unordered listing, and specifying the 
foreground and background color for the text.

Click Add.
The new text now gets added. You can simply drag and drop the text on the 
design canvas.
Additionally, you can sort the text in alphabetical order or from new to oldest.

Adding image to Object Gallery

To add an image to Object Gallery, follow the below steps:
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On the left pane of Communication Designer, select Object Gallery.
The Object Gallery pane appears.
Go to the Images tab, and then click + New Image.
The New Image dialog appears.
Enter the following information in the dialog:

Property Description

Label Name Enter the label name for the image.

Target URL

Specify the target URL for the image, which is an anchor 
link to another web page.
On clicking the image during the preview, you get 
directed to the required link. 

Description Enter the description of the image.

Image Source

Add an image using any of the following options: 

Preview It displays the preview of the added image.

Proxy Setting

It allows you to enable or disable the proxy settings for the 
server. Turn the toggle on to enable the proxy settings 
and then enter a valid server IP address and port 
describing the image location.

Click Save.
The added image now appears in the list. You can simply drag and drop the text 
on the design canvas.
Additionally, you can sort the text in alphabetical order or from new to oldest.

Browse File — Select this option to add an image 
from your local system. 

●

Image URL — Select this option to add an image 
using a valid URL. The supported image formats 
are .jpeg, and .jpg.

●

The image URL must be accessible to the 
application server. 

●

The image URL must end with a "." followed by its 
file extension.  

●
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Working with master 
layout gallery
The master layout gallery is a collection of local and enterprise (or global) master 
layouts in the currently signed-in cabinet. The global layouts in the gallery are 
represented with a  icon and local layouts are represented with a  icon.

 The master layout gallery only displays the checked-in layouts.

The master layout gallery consists of two tabs ― All and Associated.

Here, using the component gallery you can link a master layout to a template or page 
and additionally import a master layout. For more information, see Linking a master 
layout and Importing a master layout.

All ― It displays the created local and enterprise master layouts. You can use the 
search box to find a master layout by its name. 
Additionally, you can apply a filter using the More options icon  to view only 
the local, enterprise, or both of the master layouts.

●

Associated ― It displays the master layout applied to the template and its page. 

If a new version of the master layout is available, a notification icon  appears 
next to it. You can select the required checkbox next to the layout and then click 
Enforce All. This way the latest version of the master template is now enforced 
on the associated templates. You can also enforce multiple master layouts at the 
same time.

●
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Working with component 
gallery
The component gallery is a collection of local and enterprise (or global) components in 
the currently signed-in cabinet. The global components in the gallery are represented 
with a  icon and local components are represented with a  icon.

 The component gallery only displays the baselined components.

The component gallery consists of two tabs ― All and Associated.

Here, using the component gallery you can link a component to a template or page 
and additionally import a component. Apart from this, you can delink a component to 
reuse the same component design on the canvas. For more information, see Linking a 
component.

All ― It displays the created local and enterprise components. You can use the 
search box to find a component by its name. 
Additionally, you can apply a filter using the More options icon  to view only 
the local, enterprise, or both of the components.

●

Associated ― It displays the component applied to the template and its page. 

If a new version of the component is available, a notification icon  appears next 
to it. You can select the required checkbox next to the component and then click 
Enforce All. This way the latest version of the component is now enforced on the 
associated templates. You can also enforce multiple components at the same 
time.

●
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Working with 
NewgenONE Marvin
Marvin is a generative AI assistant designed to enhance your communication 
designing experience providing various functionalities for generating and improving 
content. It offers a range of features to support different content needs, from crafting 
engaging messages to translating and summarizing text.  For example, designers can 
use NewgenONE Marvin to generate content for welcome letters, disclaimers, loan 
reminders, promotional emails, notifications, and others. Here’s an overview of the key 
features Marvin provides:

To integrate NewgenONE Marvin with Communication Designer, you must register and configure its engine 
settings in the Others and Marvin tab of Admin Workspace. 
For more information, refer to the NewgenONE OmniOMS Admin Workspace User Guide.

For more information about each feature, refer to the following pages:

Content generation — Automatically creates content for various templates and 
communication types based on user input and industry specifics.

●

Content improvement — Refines and enhances existing content to make it more 
effective and engaging.

●

Multilingual translation — Translates content into multiple languages to cater to 
a diverse audience.

●

Summarize SMS/WhatsApp — Condenses lengthy messages into concise 
summaries for SMS and WhatsApp communications.

●

Subject line generation — Generates compelling subject lines to increase the 
open rates of emails.

●

Content Generation●

Content Improvement●

Multilingual Translation●

Summarize SMS/WhatsApp●

Subject Line Generation●
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Generating content
Marvin can help you generate content for various communication needs, such as 
welcome letters, payment reminders, and promotional materials. You can customize 
the content based on industry, communication type, and other parameters.

NewgenONE Marvin provides the capability to generate content in different languages 
and for varied industry types such as banking, insurance, healthcare, and others. In 
addition, it also allows you to determine the content length and tone. This way, 
NewgenONE Marvin assists in drafting different textual sections of a communication 
template and saves your time. 

This topic covers the following sections:

Generating content

To use NewgenONE Marvin for generating content, perform the following steps:

From the Categories pane, select the required template.
Add a Text Control to the template canvas or select the Text Control in which you 
want to generate the content.
From the right, click Ask Marvin. The NewgenONE Marvin pane appears on the 
right.
From the Marvin pane, click Content Generation.
Enter the following information in the corresponding fields:

Field Description

Industry
It indicates the type of industry for which you want to generate the 
content. For example, finance and marketing. 

Communication Type

It indicates the type of communication content to generate. For 
example, welcome letters, payment reminders, loans, and others. In 
case, you select Others, a blank field appears where you can enter 
the communication type you require.  

Word Count
It indicates the word count for generating the content. The word 
count can range from 1 to 500.   

Generating content●

Viewing content version history●
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Field Description

Output Language
It indicates the language in which you want to generate the 
content. For example, English, Hindi, and French.

Uniqueness
It indicates the uniqueness of the generated content. You can use 
the slider to set the uniqueness of the content. It ranges from 0 to 1. 

Tone
It indicates the tone of language for content generation. For 
example, the tone of language can be crisp, warning, professional, 
optimistic, assertive, encouraging, and others. 

Additional inputs for 
GEN AI

It refers to additional instructions you provide to Marvin for 
generating accurate content. 

Click Generate. 
NewgenONE Marvin takes a few minutes to understand your requirements and 
then generates the content. To stop the content generation, click Stop Generate.
If you want to generate the content again, click Regenerate. The content gets 
generated again based on your defined requirements. 

Viewing content version history

Communication Designer saves the different versions of the content generated using 
NewgenONE Marvin. You can view the content history using the Prompt History icon 

 on the top-right corner of the NewgenONE Marvin pane. The Communication 
Designer can store up to 50 different versions of the content arranged in chronological 
order. You can select the required version to restore the desired content. 

To view the version history of the content generated using NewgenONE Marvin, follow 
the below steps:

On the NewgenONE Marvin pane, click the Prompt History icon . The blue dot 
that appears in the icon signifies there is unread content in the Prompt History list.

The Prompt History icon appears when you are re-generating content using NewgenONE Marvin. 

The Prompt History lists content generated using NewgenONE Marvin in 
chronological order with time details. 
You can click Show More to view the entire content. 
(Optional) To delete an unnecessary version of content from the list, hover over the 
required content and then select Delete  . 
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Select the required content version you want to use. On selecting, the control uses 
the selected content version. 

Improving content
NewgenONE Marvin provides advanced capabilities for refining and enhancing existing 
content within OmniOMS. This feature allows you to elevate your text based on specific 
prompts and improvements, ensuring your communication is tailored and effective.

This topic covers the following sections:

Improving  content

To use NewgenONE Marvin for improving content, perform the following steps:

From the Categories pane, select the required template.
Add a Text Control to the template canvas or select the Text Control in which you 
want to generate the content.
From the right, click Ask Marvin. The NewgenONE Marvin pane appears on the 
right.
From the Marvin pane, click Content Improvement. The Content Improvement 
screen appears with the following options:

Field Description

Fix Spelling and 
Grammar

Allows you to automatically correct spelling and grammar issues in 
the selected text.

Tone Adjustment
Allows you to adjust the text tone. You can choose from the 
following tone options: Crisp, Warning, Professional, Optimistic, 
Assertive, and Encouraging.

Simplify Language
Allows you to simplify complex language, making it more 
accessible and easier to understand.

Message Length 
Optimization

Allows you to optimize the message length according to your 
preferences.

Language Translation
Allows you to translate the content into the selected language from 
the following options: English, Hindi, and French.

Improving  content●

Viewing content version history●
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Field Description

Additional Inputs
It refers to additional instructions you provide to Marvin for 
generating accurate content.

Click Generate to apply the selected improvements to your text. The enhanced 
text replace the original content in the text box.

Viewing content version history

You can view the content history using the Prompt History icon  on the top-right 
corner of the NewgenONE Marvin pane. You can select the required version to restore 
the desired content. 

To view the version history of the content improved using NewgenONE Marvin, follow 
the below steps:

On the NewgenONE Marvin pane, click the Prompt History icon . The blue dot 
that appears in the icon signifies there is unread content in the Prompt History list.

The Prompt History icon appears when you are re-generating content using NewgenONE Marvin. 

The Prompt History lists content generated using NewgenONE Marvin in 
chronological order with time details. 
You can click Show More to view the entire content. 
(Optional) To delete an unnecessary version of content from the list, hover over the 
required content and then select Delete  . 
Select the required content version you want to use. On selecting, the control uses 
the selected content version. 

Translating multilingual content
NewgenONE Marvin allows you to translate content into multiple languages, helping 
you reach a broader audience with your communication templates. This feature 
supports various languages and provides an easy way to ensure your message is 
accurately conveyed in the target language.
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Assume a global insurance company needs to send policy renewal notifications to 
clients in India, France, and the U.S. Using NewgenONE Marvin’s Multilingual 
Translation feature, the company can translate the content of the email templates into 
Hindi, French, and English, ensuring the message is accurately conveyed to clients in 
their preferred language. This enables efficient communication across different regions 
without manual translation efforts.

This topic covers the following sections:

Translating content

To translate content with NewgenONE Marvin, follow these steps:

From the Categories pane, select the required template.
From the right, click Ask Marvin. The NewgenONE Marvin pane appears on the 
right.
From the Marvin pane, click Multilingual Translation. The Multilingual Translation 
screen appears with the target languages to choose for translating. The available 
options are:

Select the required language and click Generate. After generating, you get the 
translated template with following options:

Option Description

Add as template  Allows you to add a new template with the translated content and the 
navigation switches to the new template.

Preview 
Allows you to preview the translated template by providing the input 
file.

 

Translating content●

Viewing content version history●

English●

Hindi●

French●

The content in the components and master layouts is not translated.●

You can translate the content inside the text control using this option.●
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Viewing content version history

You can view the content history using the Prompt History icon  on the top-right 
corner of the NewgenONE Marvin pane. You can select the required version to restore 
the desired content. 

To view the version history of the content translated using NewgenONE Marvin, follow 
the below steps:

On the NewgenONE Marvin pane, click the Prompt History icon . The blue dot 
that appears in the icon signifies there is unread content in the Prompt History list.

The Prompt History icon appears when you are re-generating content using NewgenONE Marvin. 

The Prompt History lists content generated using NewgenONE Marvin in 
chronological order with time details.
You can click Show More to view the entire content.
Hover over the required revision history, the following option appears:

Option Description

Add as template Allows you to add the translated content as a new template. 

Preview Allows you to preview the translated content.

Re-generate Allows you to re-generate the translated content.

Delete  Allows you to delete the history. 

Select the required content version you want to use. On selecting, the control uses 
the selected content version. 

Summarizing SMS and WhatsApp 
Messages
Use the Summarizing feature of Gen AI Marvin to condense and refine your SMS and 
WhatsApp messages. This feature helps you streamline your communications by 
summarizing long messages into concise, clear formats.
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Assume a customer service team at a bank frequently sends follow-up messages via 
SMS and WhatsApp to clients regarding pending loan applications. By using 
NewgenONE Marvin’s Summarizing feature, the team can quickly condense lengthy 
status updates into concise, clear summaries tailored for SMS or WhatsApp, ensuring 
clients receive important updates in a more digestible format. This helps streamline 
communication while maintaining the intended tone, whether it’s a reminder, update, 
or response to a query.

This topic covers the following sections:

Summarizing SMS/Whatsapp messages

To summarize content with NewgenONE Marvin, follow these steps:

From the Categories pane, select the required template.
From the right, click Ask Marvin. The NewgenONE Marvin pane appears on the 
right.
Click Summarise SMS/WhatsApp. The Summarise SMS/WhatsApp screen 
appears with the following options:

Option Description

 Type
Select the type of message you want to summarize:

Summarizing SMS/Whatsapp messages●

Viewing content version history●

WhatsApp●

SMS●
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Option Description

 Customization

Click the Customization button to open the Customization dialog. The 
dialog includes the following settings

After setting your preferences, click the Generate button. After generating, you 
get the following options:

Option Description

Add as template  Allows you to add a new template with the generated content and the 
navigation switches to the new template.

Copy  Allows you to copy the content to the clipboard.

Viewing content version history

You can view the content history using the Prompt History icon  on the top-right 
corner of the NewgenONE Marvin pane. You can select the required version to restore 
the desired content. 

To view the version history of the content generated using NewgenONE Marvin, follow 
the below steps:

On the NewgenONE Marvin pane, click the Prompt History icon . The blue dot 
that appears in the icon signifies there is unread content in the Prompt History list.

The Prompt History icon appears when you are re-generating content using NewgenONE Marvin. 

The Prompt History lists content generated using NewgenONE Marvin in 

Tone — Select the desired tone for the summary:●

Optimistico

Assertiveo

Warningo

Encouragingo

Uniqueness — Use the slider to adjust the uniqueness of the 
summary, ranging from Popular to Creative.

●

Set Context — Specify the context for the summary.●

Updateo

Annoucemento

Follow-upo

Response to a queryo
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chronological order with time details. 
You can click Show More to view the entire content. 
(Optional) To delete an unnecessary version of content from the list, hover over the 
required content and then select Delete  . 
Select the required content version you want to use. On selecting, the control uses 
the selected content version. 

Generating subject lines
Enhance your email marketing efforts by generating compelling subject lines with 
NewgenONE Marvin. This feature helps create engaging and effective subject lines 
tailored to your campaign needs.

This topic covers the following sections:

Generating subject lines

To generate subject lines with NewgenONE Marvin, follow these steps:

From the Categories pane, select the required template.
From the right, click Ask Marvin. The NewgenONE Marvin pane appears on the 
right.
Click Subject line Generation. The Subject line Generation screen appears with 
the following options:

Option Description

 Tone

Tone: Select the desired tone for the summary:

 Uniqueness
Use the slider to adjust the uniqueness of the subject line, 
ranging from Popular to Creative.

Generating subject lines●

Viewing content version history●

Optimistic●

Assertive●

Warning●

Encouraging●
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Option Description

Language Translation

Choose the language for generating the subject line:

Set your preferences, and click the Generate button to create your subject line. 
After generation, click the Add subject line icon   to update the subject line of 
the template.

Viewing content version history

You can view the content history using the Prompt History icon  on the top-right 
corner of the NewgenONE Marvin pane. You can select the required version to restore 
the desired content. 

To view the version history of the subject generated using NewgenONE Marvin, follow 
the below steps:

On the NewgenONE Marvin pane, click the Prompt History icon . The blue dot 
that appears in the icon signifies there is unread content in the Prompt History list.

The Prompt History icon appears when you are re-generating content using NewgenONE Marvin. 

The Prompt History lists content generated using NewgenONE Marvin in 
chronological order with time details. 
You can click Show More to view the entire content. 
(Optional) To delete an unnecessary version of content from the list, hover over the 
required content and then select Delete  . 
Select the required content version you want to use. On selecting, the control uses 
the selected content version. 

English●

Hindi●

French●
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Managing user rights
The rights management feature in the Communication Designer allows you to assign 
access rights to users or user groups and then view those rights. These access rights 
include permissions to view, create, edit, and enable the maker checker for the 
categories, enterprise master layouts, and enterprise components.

To enable the Rights Management functionality in the Communication Designer, set the 
enableRightManagement parameter to Y in the OMSCommDesigner.ini file. For more information, refer to 
the NewgenONE Administration Guide. 

This topic covers the following sections:

Assigning access rights
OmniOMS Communication Designer allows you to set access rights that determine the 
type of permission a user or user group has on the categories, enterprise master 
templates, and enterprise components. By applying access rights, you restrict the users 
from unauthorized usage and ensure the confidentiality of sensitive data. 

For example, a supervisor can assign read-only rights on the enterprise master 
templates to prevent the user from modifying them. 

Only a supervisor user and owner can assign access rights to the other users. An owner is a non-supervisor 
user who is responsible for the creation of an object such as a category, communication group, template, 
master layout, or component. Also, owners can only assign rights to the objects they’ve created. 

The following are the different levels at which you can assign rights to the users:

Assigning access rights●

Viewing access rights●

Root Level (+ Categories) — It consists of categories created in the currently 
signed-in cabinet. Furthermore, there can be one or more communication 
groups within a category. A communication group is a collection of templates, 
master layouts, and components.  

●
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Before assigning rights at different sublevels, ensure to assign rights to the user at the 
root level first. This ensures a baseline level of access permissions within the 
system. These are the different types of access rights you can assign to a user on the 
categories, enterprise master templates, and enterprise components:

Enterprise Master Layout — It consists of master layouts created in the 
currently signed-in cabinet at the enterprise or global level.

●

Enterprise Component — It consists of components created in the currently 
signed-in cabinet at the enterprise or global level.

●

Create — Allows user(s) to create categories, enterprise master layouts, and 
enterprise components.
For example, if you assign Create right at the Root Level (+ Categories) level, the 
user can create one or multiple categories in the Category pane. In a category, 
you can further create a communication group that contains templates, master 
templates, and components.    

The Create checkbox is only enabled at the root level of category, enterprise master layout, and 
enterprise component. For the sublevels, it appears disabled.  

●

Edit — Allows user(s) to modify the existing categories, enterprise master 
templates, and enterprise components. With editing rights, users also get the 
right to create and view, respectively. 
For example, if you assign Edit right for a Banking category, the user can create 
communication groups within the category that contain templates, master 
templates, and components. Apart from this, the user can modify the existing 
category to update its templates or components.

 The Edit right is disabled at the root level of the category, enterprise master layout, and enterprise 
component.

●

View — Allows user(s) to view a category, enterprise master template, or 
enterprise component. 
For example, suppose you assign View right at the Enterprise Master Layout 
level. In that case, the user can view all the enterprise and global enterprise 
layouts created in the currently signed-in cabinet.

●

Maker Checker — Marks the user as a checker to approve or reject the changes 
made in a category, enterprise master template, or enterprise component. 
For example, if you assign Maker Checker right for a component namely 
EmbeddedReport, the user is now responsible for approving and rejecting the 
changes made by other users in the EmbeddedReport component. For more 
information, see Approving or rejecting requests.

●
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If access rights are assigned at sublevels, such as templates, then users are automatically granted view rights 
at the root level, that is the communication groups and categories templates belong to. 

To set access rights for the users, perform the following steps:

On the lower-right corner, click Rights Management.
The Assign Rights dialog appears.
Set the Assign To field to either User or Users Group.

From the Name dropdown, select the required user or user group from the list. 
The Name dropdown displays the list of users or user groups depending on the 
value chosen for the Assign To field. Here, you can view the existing access rights 
of the users and further modify them.
Expand the required section where you want to assign the rights — Root Level (+ 
Categories), Enterprise Master Template, and Enterprise Component. It also shows 
the count of master templates and components next to the Enterprise Master 
Template and Enterprise Component sections.

Assign the required permissions to the categories, enterprise master templates, 
and enterprise components. Edit, view, and maker checker are the different types 
of access rights you can apply. For more information, see Understanding access 
rights.
Click Assign and Close. The user gets assigned the required access rights. 
To assign another user with rights, click Assign and Next, and then repeat the 
above-mentioned steps.

The Maker Checker right for categories is available only at the communication group level, and not at 
the templates, master layouts, and components level. 

Select User to assign access rights to a user.●

Select Users Group to assign access to a user group. A user group is a 
collection of multiple users.

●

Expand the Root Level (+ Categories) section to view the list of available 
categories. You can further expand the category to view its corresponding 
communication groups containing templates, master layouts, and 
components. 
Here, you can assign rights directly to the communication group or 
separately at the template, master layout, and component level. 

●

Expand the Enterprise Master Template section to view the list of available 
enterprise or global master templates.

●

Expand the Enterprise Component section to view the list of available 
enterprise or global components.

●
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Viewing access rights
OmniOMS Communication Designer allows you to view your access rights available on 
different categories, enterprise master layouts, and enterprise components. These 
access rights include permissions to view, create, edit, and enable the maker checker 
for the categories, enterprise master layouts, and enterprise components. 

You can view the access rights only if you are a non-supervisor user. 

To view the access rights, perform the following steps:

On the lower-right corner, click Rights Management.
The Assign Rights dialog appears.
Navigate to the My Rights tab to view your assigned rights. 
You can expand the following sections to view your rights at the category, 
enterprise master layout, and enterprise component level.

Create — Right to create a category, enterprise master template, and enterprise 
component.
Within a category, you can create one or more communication groups in the 
Category pane. A communication group is a collection of templates, master 
templates, and components.   

●

Edit — Right to modify an existing category, enterprise master template, or 
enterprise component. Right to modify the existing categories, enterprise 
master templates, and enterprise components. With editing rights, users also 
get the right to create and view, respectively. 

●

View — Right to view the communication groups, templates, master templates, 
and components within a category, enterprise master template, or enterprise 
component.

●

Maker Checker — Right to approve or reject the changes made to a category, 
enterprise master template, or enterprise component. Here, the user acts as a 
checker for the changes made to the existing categories, enterprise master 
templates, or enterprise components. 

●

Expand the Root Level (+ Categories) section to view your rights on the 
categories. You can further expand the category to view the rights on its 
corresponding communication groups containing templates, master 
layouts, and components. 

●
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 The My Rights tab is only visible to non-supervisor users.

Click Close to exit the dialog. 

Expand the Enterprise Master Template section to view your rights on the 
enterprise or global master templates.

●

Expand the Enterprise Component section to view your rights on the 
enterprise or global components. 

●
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Managing approval 
requests
The maker checker functionality of the Communication Designer requires at least two 
users for baselining the communication templates and components (both enterprise 
and local). In this process, one of the users is the maker who baselines the templates 
and components. The other user is the checker who accepts or rejects the request to 
baseline the templates and components. 

To enable the maker checker functionality in the Communication Designer, set the enableMakerChecker
parameter to Y in the OMSCommDesigner.ini file. 

This functionality adds a layer of security, reducing the risk of errors and unauthorized 
actions. The maker checker functionality is only applicable for baselining templates and 
components. 

For more information, see Baselining templates and Managing components.

When a maker baselines a communication template or component, an approval 
request is sent to the checker, who further verifies, approves, or rejects it. Such requests 
are managed using the Maker Checker icon  available on the lower-right corner of 
the page.

This section covers the following topics:

Approving or rejecting approval 
requests
The Received tab of the Maker Checker dialog displays the approval requests for 
baselining a communication template or component. 

Approving or rejecting approval requests●

Viewing sent approval requests●
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To approve or reject a request, perform the following steps:

On the lower-right corner of the page, click Maker Checker.
The Approvals dialog appears.
Go to the Received tab. It lists all the received approval requests with the object 
type name, communication group name, category name, initialization date and 
time, requester name, baseline version, and baseline comment. 
Here, the object type name refers to the name of the baselined communication 
template or component. While, the approval status indicates the current status of 
your request, which can either be in pending approval or rejected state.
To check and verify the communication template or component, hover your 
mouse cursor over the required object type and then click Preview. 
An Open dialog appears.
Select the associated XML or JSON dataset to view the data in your 
communication template or component.
Click Approve or Reject to accept or decline the approval request.

Viewing sent approval requests
The Sent tab of the Maker Checker dialog displays the approval requests sent to the 
checker by the users. These requests are sent to baseline a communication template or 
component. 

To view the sent approval requests, follow the below steps:

On the lower-right corner of the page, click Maker Checker.
The Approvals dialog appears.
Navigate to the Sent tab. It lists all the sent approval requests with the object type 
name, communication group name, category name, initialization date and time, 
baseline version, baseline comment, and approval status with comments, if any. 
Here, the object type name refers to the name of the baselined communication 

If you click Approve, an Approve dialog appears. Enter the required 
comment in the comment box, and then click Approve. The request is now 
approved by the checker.

●

If you click Reject, a Reject dialog appears. Enter the required comment in 
the comment box, and then click Reject. The request is now declined by the 
checker.

●
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template or component. While, the approval status indicates the current status of 
your request, which can either be in pending approval or rejected state. 
Furthermore, you can use the search box to find the approval requests by the 
object type name. 
(Optional) Hover your mouse cursor over the comment icon to view the approval 
status comment. 
(Optional) To filter the approval requests based on the object type or status, click 
the Object Type or Status dropdown, respectively. The supported object type 
values are template and component. While the supported status values are 
pending approval or rejected.  
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Defining an output format
OmniOMS Communication Designer allows you to specify the output format for the 
email attachments. The supported output formats are PDF or DOC/DOCX. These 
output formats vary based on the template selection.

To define an output format, follow the below steps:

From the Categories pane, expand the required communication group.
Click the New Output Format icon  next to the Output Formats.
The New Output Format dialog appears.
Enter the name of the output format.
Enter the description for the output format.
Specify the output format. It can either be PDF or DOC/DOCX.
Specify the color mode for the output format. It can be color or greyscale.

The Color Mode field is enabled only in the case of PDF output type. 

Click Add.
The output format gets added.

Letter template supports only PDF format.●

Design on PDF template supports only PDF format.●

Word template supports both PDF and DOC/DOCX formats.●
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Tutorials
This topic gets you started with the basics of creating an email and WhatsApp 
template. This topic includes the following:

Creating an email template
This topic explains quick steps to create an email template. 

Sign in to the OmniOMS Communication Designer using the following URL:
http://<ip_address>:<port_number>/omniomscommdesigner/#/login
Go to the Category pane and create a new category. 
A new category gets added in the Category pane. For procedural details, see 
Adding category.
Within the category, create a new communication group. A communication 
group can be of two types — Common Dataset and Mixed Dataset 
Communication Group. For procedural details, see Adding communication group.
(Optional) In case, you created a common dataset communication group, then 
you need to link with the dataset. For procedural details, see Linking 
communication group with dataset.
Select Templates and then click the New Template icon .
A list of available templates appears. 
From the list, select Email Template. 
(Optional) In case, you created a mixed dataset communication group, then link 
your template with the dataset. For procedural details, see Linking template with 
dataset.
Design your email template based on your requirements. You can drag and drop 
the required controls from the Control toolbar to the sections. Additionally, you 
can also apply various formatting options to modify the text styles. For information 
on controls, see Adding controls.

Creating email template●

Creating WhatsApp template●



     Tutorials

Version: 12.0 NewgenONE OmniOMS Communication Designer User Guide 230            

9.
10.

11.

12.

13.
14.

1.

2.

3.

4.

5.

6.
7.

8.

Save the template.
 Check in your template to commit your template changes. For procedural details, 
see Checking in template.
Baseline your template to use for production purposes. For procedural details, 
see Baselining template.
On the Categories pane, select Jobs and then click the New Job icon .
A list of available jobs appears — On Demand Message/WhatsApp and On 
Demand Mail/Archival.
From the list, select On Demand Mail/Archival.
Configure the job properties based on your requirements. For procedural details, 
see Creating on demand mail/archival job.

Creating a WhatsApp template
This topic explains quick steps to create a WhatsApp template. 

Sign in to the OmniOMS Communication Designer using the following URL:
http://<ip_address>:<port_number>/omniomscommdesigner/#/login
Go to the Category pane and create a new category. 
A new category gets added in the Category pane. For procedural details, see 
Adding category.
Within the category, create a new communication group. A communication 
group can be of two types — Common Dataset and Mixed Dataset 
Communication Group. For procedural details, see Adding communication group.
(Optional) In case, you created a common dataset communication group, then 
you need to link with the dataset. For procedural details, see Linking 
communication group with dataset.
Select Templates and then click the New Template icon .
A list of available templates appears. 
From the list, select WhatsApp Template. 
(Optional) In case, you created a mixed dataset communication group, then link 
your template with the dataset. For procedural details, see Linking template with 
dataset.
Design your WhatsApp template based on your requirements. You can drag and 
drop the required controls from the Control toolbar to the design canvas. 
Additionally, you can also apply various formatting options to modify the text 
styles. For information on controls, see Adding controls.
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Save the template.
 Check in your template to commit your template changes. For procedural details, 
see Checking in template.
Baseline your template to use for production purposes. For procedural details, 
see Baselining template.
On the Categories pane, select Jobs and then click the New Job icon .
A list of available jobs appears — On Demand Message/WhatsApp and On 
Demand Mail/Archival.
From the list, select On Demand Message/WhatsApp.
Configure the job properties based on your requirements. For procedural details, 
see Creating on demand message/Whatsapp job.
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